TABLE OF CONTENTS

1 OVERVIEW................................................................................................................... 1
  1.1 OBJECTIVES OF THE RAPIDS 7.3 USER GUIDE ................................................... 1
  1.2 DEERS AND RAPIDS DEFINITIONS...................................................................... 1
  1.3 WHAT IS NEW IN RAPIDS 7.3? .............................................................................. 2
    1.3.1 Changes to the Supporting Technology, Site Hardware, and System Architecture from RAPIDS 6.5......................................................... 2

2 PERSONAL IDENTITY VERIFICATION................................................................ 3
  2.1 COMMON ID, SECURITY, AND PRIVACY REQUIREMENTS.................................. 3
  2.2 PIV CARD .............................................................................................................. 3

3 PERSONNEL IDENTITY PROTECTION PROGRAM .......................................... 5
  3.1 PROOF OF IDENTITY DOCUMENTATION ......................................................... 5
  3.2 DOCUMENT AUTHENTICITY VERIFICATION...................................................... 6

4 PRIVACY ACT AND PERSONALLY IDENTIFIABLE INFORMATION........... 8
  4.1 THE PRIVACY ACT: ............................................................................................... 8
  4.2 RESPONSIBILITIES OF THE RAPIDS OPERATOR .............................................. 8
  4.3 SAFEGUARDING PRIVACY ACT INFORMATION.................................................. 9
    4.3.1 Administrative Safeguards ............................................................................. 9
    4.3.2 Physical Safeguards ...................................................................................... 10
    4.3.3 Technical Safeguards .................................................................................. 10

5 DEERS/RAPIDS INFRASTRUCTURE.................................................................... 12
  5.1 PKI INFRASTRUCTURE—PKI, RAPIDS, AND THE CAC .................................... 12
    5.1.1 Public Key Infrastructure (PKI) .................................................................. 12
    5.1.2 Public Key Technology, RAPIDS, and the CAC ........................................ 12
  5.2 NIPRNET/DISN.................................................................................................... 13
  5.3 DMDC NETWORK............................................................................................... 13
    5.3.1 CAC User Portal ......................................................................................... 14
    5.3.2 CA Servers ................................................................................................ 14
    5.3.3 RAPIDS Server ......................................................................................... 14
    5.3.4 DEERS Database ...................................................................................... 15
  5.4 ID CARDS............................................................................................................. 15
    5.4.1 CAC Cardstock .......................................................................................... 15
    5.4.2 Teslin Cardstock ....................................................................................... 17
    5.4.3 Chipless Cardstock .................................................................................. 18

6 DEERS/RAPIDS ROLES............................................................................................ 19
  6.1 RESPONSIBILITY OF REGISTRATION OFFICIAL ............................................. 19
  6.2 USER ROLES ....................................................................................................... 19
    6.2.1 VO ............................................................................................................... 19
    6.2.2 SVO ............................................................................................................ 20
    6.2.3 SSM ........................................................................................................... 20
  6.3 SERVICE PROJECT OFFICER .......................................................................... 21
  6.4 RAPIDS WORKSTATION—ROLES OF THE RAPIDS WORKSTATION .......... 22
    6.4.1 Desktop Workstation .................................................................................. 22
6.4.2 Deployable Workstation ................................................................. 22
6.4.3 CAC Central Issuance Requesting Station (CACCIRS) ...................... 23

RAPIDS 7.3 HARDWARE ........................................................................... 24
6.5 Desktop Workstation ......................................................................... 24
  6.5.1 Components of the Desktop Workstation ....................................... 24
  6.5.2 Desktop Workstation Maintenance ................................................. 24
  6.5.3 Smart Card Printer ........................................................................... 25

6.6 Deployable Workstation ...................................................................... 25
  6.6.1 Components of the Deployable Workstation ................................. 26
  6.6.2 Deployable Workstation Assembly ................................................. 26
  6.6.3 Deployable Workstation Maintenance ............................................. 30
  6.6.4 Smart Card Printer ........................................................................... 30
  6.6.5 Taking ID Card Photos with the Digital Camera ............................... 31

7 RAPIDS TRAINING .................................................................................. 33
7.1 Policy Requirements ............................................................................ 33
7.2 Web-Based Training Matrix ................................................................. 33
7.3 Training User Guide ............................................................................ 34

8 GETTING FAMILIAR WITH THE RAPIDS WORKSTATION ............... 35
  8.1.1 Increased Security Functionality for RAPIDS 7.3 ............................ 35
  8.1.2 Enhancements .................................................................................. 35
  8.1.3 Additional Functionality Enhancements ........................................... 36
  8.1.4 New Card Types ............................................................................... 37
    8.1.4.1 DoD Civilian Retiree ................................................................. 37
    8.1.4.2 Civilian Retiree (NOAA) .......................................................... 38
  8.2 Using the RAPIDS Workstation .......................................................... 39
    8.2.1 Log on to the RAPIDS Workstation .............................................. 39
    8.2.2 Lock the RAPIDS Workstation .................................................... 40
    8.2.3 Unlock the RAPIDS Workstation .................................................. 40
    8.2.4 Exit the RAPIDS Application ....................................................... 40
    8.2.5 Log off the RAPIDS Workstation ................................................ 40
  8.3 Performing Basic Functions in RAPIDS ........................................... 41
    8.3.1 Launch RAPIDS ........................................................................... 41
    8.3.2 Open a Sponsor Record ............................................................... 41
    8.3.3 Save Changes to a Record ............................................................. 43
    8.3.4 Close a Sponsor Record ............................................................... 43
    8.3.5 Exit RAPIDS ................................................................................ 43
  8.4 Using the RAPIDS Interface ............................................................... 43
    8.4.1 Menu Bar ..................................................................................... 44
    8.4.2 Toolbar ....................................................................................... 45
    8.4.3 Icon Bar ...................................................................................... 46
    8.4.4 Family Tree ................................................................................ 47
    8.4.5 Person Viewer ............................................................................ 49
    8.4.6 Information Viewer .................................................................. 51
  8.5 Navigating to the Create ID Card Wizard Using RAPIDS .................. 52
    8.5.1 Navigate to the Create ID Card Wizard Using the Menu Bar .......... 52
8.5.2 Navigate to the Create ID Card Wizard Using the Toolbar ........................................ 52
8.5.3 Navigate to the Create ID Card Wizard Using the Family Tree ............................ 53
8.5.4 Navigate to the Create ID Card Wizard Using the Person Viewer ....................... 53
8.5.5 Navigate to the Create ID Card Wizard Using the Icon Bar ................................. 54

8.6 ID CARD OPERATIONS—CAC .................................................................................... 56
8.6.1 Unlock a CAC/Reset a PIN ................................................................................... 56
8.6.2 Issue a new CAC to an Active Duty service member ........................................... 58
8.6.3 Update a CAC ....................................................................................................... 64
8.6.4 Check whether a certificate is encoded on a CAC ................................................ 66
8.6.5 Manually terminate an ID card ............................................................................. 67

8.7 ID CARD OPERATIONS—TESLIN ................................................................................. 69
8.7.1 Issue a Teslin card to a Retired Sponsor ............................................................... 69
8.7.2 Issue a temporary ID card to a family member ..................................................... 75
8.7.3 Issue a Teslin Card to a Merchant Marine Academy Personnel .......................... 80
8.7.4 Issue A NOAA Civilian Retiree Card to the Family Member of a NOAA Wage Mariner Retiree ..................................................................................................................... 86
8.7.5 Issue An ID Card to a Disabled Veteran (DAV) .................................................. 91

8.8 RECORDS OPERATIONS—GENERAL ............................................................................ 92
8.8.1 Capture a Fingerprint ............................................................................................ 92
8.8.2 Skip the verification of an existing fingerprint ..................................................... 92
8.8.3 Skip the capture of a fingerprint ........................................................................... 93
8.8.4 Capture a Photograph ........................................................................................... 95
8.8.5 Capture a Proof of Identity .................................................................................... 95
8.8.6 Suspend privileges ................................................................................................ 97
8.8.7 Add Medicare to a record ..................................................................................... 98
8.8.8 Change a Foreign Identification Number (FIN) to a Social Security Number (SSN) 100
8.8.9 Update Address (Copy home address from Sponsor to Family Members) ......... 102

8.9 ID CARD OPERATIONS—SPONSOR ............................................................................ 103
8.9.1 Check a Sponsor’s verification status ....................................................................... 103
8.9.2 Add an overseas condition to a civilian who goes overseas for more than 1 year to accompany forces ........................................................................................................ 104
8.9.3 Update a Sponsor’s rank ...................................................................................... 105
8.9.4 Retire a Sponsor ................................................................................................... 106
8.9.5 Activate a Guard or Reserve Sponsor .................................................................... 108
8.9.6 Extend the Active Duty end date for a Guard or Reserve Sponsor ..................... 110
8.9.7 Deactivate a Guard or Reserve Sponsor ............................................................... 110
8.9.8 Separate Guard/Reserve Sponsor Involuntarily From the Selected Reserves .... 111
8.9.9 Update Individual Ready Reserve to Selected Reserves ..................................... 113
8.9.10 Separate Guard/Reserve Sponsor Qualifying for Transitional Assistance (TA) 113
8.9.11 Provide Limited Exchange Benefits to United States Coast Guard (USCG) Non- Appropriated Fund (NAF) Exchange Employees ........................................................................ 113
8.9.12 Recall a retiree to Active Duty service ............................................................... 113
8.9.13 Create a new Sponsor record .............................................................................. 116
8.9.14 Add a Foreign Military Affiliate to DEERS ....................................................... 120
8.9.15 Retire a DoD Civil Service member ................................................................... 125
8.9.16 Update Active Duty Sponsor to Temporary Disabled Retirement List (TDRL) 126
8.9.17 Update TDRL Sponsor to Permanently Disabled Retired List (PDRL)......... 127
8.9.18 Terminate Sponsor for End of Contract................................................ 128
8.9.19 Update a Military Sponsor’s Marriage Status to Reflect a Joint Service Marriage 129

8.10 ID CARD OPERATIONS—FAM ILY MEMBER .............................................. 130
8.10.1 Create a DD Form 1172.............................................................................. 130
8.10.2 Add a family member (newborn) with a Temporary Identification Number (TIN) to a Sponsor’s record in RAPIDS ........................................ 132
8.10.3 Update a newborn child’s record (e.g., TIN to SSN)............................... 134
8.10.4 Add a foreign national family member without A Social Security Number (SSN) 136
8.10.5 Change the status of a family member to a full-time student .................... 140
8.10.6 Update a child’s record to reflect permanent incapacitation .......................... 141
8.10.7 Update a Sponsor’s record for a child’s relationship after the parents are divorced 142
8.10.8 End a Sponsor’s relationship to a spouse due to divorce............................ 143
8.10.9 Change a Family Member (Child) from one Sponsor’s record to a Family Member (Spouse) in another Sponsor’s record.............................................. 147
8.10.10 Change entitlements/benefits eligibility from one Sponsor to another in a JSM 154
8.10.11 Update a JSM Sponsor to Become a Family Member Spouse Under the Other Sponsor’s Record .............................................................................. 155
8.10.12 Add an illegitimate child to a Sponsor’s record in RAPIDS ....................... 157
8.10.13 Terminate a Family Member Under a Sponsor........................................ 160
8.10.14 Update a Child Who Is Living with an Ex-Spouse.................................... 161
8.10.15 Reestablish Dependency ......................................................................... 162

8.11 OCONUS SCENARIOS................................................................................. 166
8.11.1 Issue an ID Card to a Foreign Military Personnel Member.......................... 166
8.11.2 Issue an ID Card to a DoD Civilian Hired Locally on Guam Not Residing on a Military Base................................................................. 167
8.11.3 Issue an ID Card to a Civil Service MSC Living on Guam not Assigned to a Ship 167
8.11.4 Issue an ID Card to a Civil Service MSC Living on Guam not Assigned to a Ship but on OCONUS Order.................................................... 168
8.11.5 Issue an ID Card to an MSC with Normal Residence in CONUS on an MSC Ship Serving the U.S. Only ................................................ 168
8.11.6 Issue an ID Card to an MSC with Normal Residence in CONUS on an MSC Ship Overseas 168
8.11.7 Issue an ID Card to an OCONUS Family Member Spouse Who is a Local Hire DoD Employee and a Member of the Reserves, Whose Sponsor is AD ......... 169
8.11.8 Issue an ID Card to a Spouse of a DoD Civilian Sponsor in an OCONUS Position Who is also Employed by DoD in an OCONUS Position.......................................................... 169
8.11.9 Issue an ID Card to a Family Member of a DoD AD, DoD Civilian, or Contractor in an OCONUS Position Who is Employed in a Part Time DoD Civilian Position....... 169
8.11.10 Issue an ID Card to a Sponsor Who Has No or One Form of Identity Proof. 170
12.1 Appendix A: Quick Reference Guide
12.2 Appendix B: Privacy Act Statement
12.3 Appendix C: Privacy Act Data Cover Sheet
12.4 Appendix D: Acceptable Proof of Identity Documentation
12.5 Appendix E: ID Card Error Codes
12.6 Appendix F: RAPIDS Transaction Audit Trail Events and Descriptions
12.7 Appendix G: RAPIDS User Guide Acronyms
12.8 Appendix H: Card Charts
1 OVERVIEW

The Defense Enrollment Eligibility Reporting System (DEERS) was established by the Department of Defense (DoD) in 1981 to improve the control and distribution of available military health care services. DEERS provides computerized information service for the enrollment of individuals eligible for Uniformed Services benefits. In 1997 the Real-time Automated Personnel Identification System (RAPIDS) introduced a more secure method for producing automated, machine-readable identification and privilege cards. In 2000 the Secretary of Defense announced the initial implementation of smartcard technology in the DoD, distributed as a Common Access Card (CAC) via the DEERS/RAPIDS infrastructure.

RAPIDS allows its users to create, modify, and use personnel information stored in DEERS. Additionally, it assists and guides users through the process of verifying the claimed identity of individuals seeking physical access to controlled government facilities and logical access to government information systems. RAPIDS runs on a rules-based architecture that determines the correct benefits and entitlements for each beneficiary based upon the information provided by DEERS and the RAPIDS user. RAPIDS can receive software updates through remote connection from DMDC to incorporate updates in security, legislation, and eligibility requirements for the system.

1.1 OBJECTIVES OF THE RAPIDS 7.3 USER GUIDE

The objectives of the RAPIDS 7.3 User Guide are as follows:

- Serve as a learning tool to provide users with a basic knowledge of the DEERS database, DoD Public Key Infrastructure (PKI), and role of RAPIDS in the infrastructure.
- Support day-to-day operations as an illustrated technical, procedural, and informational reference for RAPIDS users.
- Provide instructions for using RAPIDS, updating family records, printing DoD Forms (DD Forms), and issuing the various DoD identity credentials.
- Provide examples of using the CAC to authenticate users in the DoD PKI.

1.2 DEERS AND RAPIDS DEFINITIONS

![Figure 1.1. DEERS/RAPIDS Information Flow](image)

DEERS is the database that tracks the personnel and medical DoD benefits. DEERS has rules that determine benefits based on the beneficiary’s data and status in DEERS. Tracking and determining personnel and medical DoD benefits help reduce the fraud and abuse of DoD benefits. It also ensures all beneficiaries receive the benefits to which they are entitled.
RAPIDS is the application that allows users query, modify, and access the DEERS database. It is a rules-based system, which means it determines the correct benefits and entitlements for each beneficiary based on the information provided to it by DEERS and the RAPIDS user. DMDC addresses legislative changes and eligibility rules by issuing software updates to RAPIDS and DEERS.

RAPIDS users have the ability to issue machine-readable automated ID cards and print DD forms. These include the CAC, the DD Form 1172, *Application for Uniformed Services Identification Card and DEERS Enrollment*, and DD Form 1172-2, *Application for Department of Defense Common Access Card and DEERS Enrollment*. In addition, it provides a means to update Sponsor and family member information in the DEERS database.

DEERS and RAPIDS data is protected under the Privacy Act Statement (10 United States Code [U.S.C.] 133; Executive Order 9397, 22 November 1943 [Social Security Numbers]; and Title 5, U.S.C. Section 301). RAPIDS users can only confirm information on the Sponsor or family member. As required by the Privacy Act of 1974, the operator cannot volunteer personal information from the DEERS record.

### 1.3 What is New in RAPIDS 7.3?

**1.3.1 Changes to the Supporting Technology, Site Hardware, and System Architecture from RAPIDS 6.5**

- The personal identity verification (PIV) configuration option allows DMDC to configure a workstation to support production of the PIV compliant Common Access Card, via remote DMDC administration capabilities.
- Added hardware includes a new PIV-compliant biometric fingerprint scanner, document scanner, and contactless smart card reader/encoder.
- Site logs in using Virtual Private Network (VPN) communications connection.
- A new End Point applet that provides an alternate token for logon.
2 PERSONAL IDENTITY VERIFICATION

On February 25, 2005, the National Institute of Standards and Technology (NIST) released Federal Information Processing Standard (FIPS) Publication 201, *Personal Identity Verification of Federal Employees and Contractors*, in response to HSPD-12. FIPS-201 includes the architecture and technical requirements for a government-wide PIV system in which common ID credentials can be issued and verified. The underlying objective of FIPS-201 is to provide a secure and efficient method for verifying the identity of individuals seeking physical access to federally controlled government facilities and logical access to government information systems.

2.1 COMMON ID, SECURITY, AND PRIVACY REQUIREMENTS

When issuing identity credentials, departments and agencies must adopt an identity proofing and registration process. The process should meet the following requirements:

- The process shall begin by conducting a National Agency Check With Written Inquiries (NACI) or other Office of Personnel Management (OPM) or national security community investigation required for federal employment. This requirement may also be fulfilled by referencing a completed and successfully adjudicated NACI. At a minimum, the Federal Bureau of Investigation (FBI) National Criminal History Check must be completed before credential issuance.
- The applicant must appear in person at least once before PIV credential issuance.
- The applicant shall be required to provide two original forms of identity source documents. The identity source documents must come from the list of acceptable documents found in Form I-9, Office of Management and Budget (OMB) No. 1115-0136, *Employment Eligibility Verification*. One document must be a valid state or federal government-issued picture ID.
- The PIV identity proofing, registration, and issuance process shall adhere to the principle of separation of duties so that no single individual can issue a PIV credential without the cooperation of another authorized person.

All departments and agencies must implement the PIV system in accordance with the privacy controls specified in FIPS-201, as well as those specified in federal privacy laws and policies, including the E-Government Act of 2002 (E-Gov), the Privacy Act of 1974 (Privacy), and OMB Memorandum M-03-22, *Guidance for Implementing the Privacy Provisions of the E-Government Act of 2002*.

2.2 PIV CARD

To meet the security and interoperability objectives set forth in HSPD-12, PIV cards must use consistent technology and have a common look with consistent placement of printed components. For a complete look at the mandatory and optional physical components of a PIV card, refer to Section 4.1 of FIPS-201.

The PIV card contains several data elements that allow it to support a variety of authentication mechanisms. The different types of data elements are used for verifying identities at graduated assurance levels. At a minimum, the PIV card must contain a PIN, a Cardholder Unique ID
(CHUID), PIV authentication data (one asymmetric key pair and corresponding certificate), and two biometric fingerprints. Depending on department or agency requirements, a PIV card may also contain four additional logical credentials or keys for the purposes of digital signatures, key management, additional physical access applications, and card management.

PIV logical credentials fall into three categories:

1. Credentials used to prove the identity of the cardholder to the card (CTC authentication) (e.g., the PIN)
2. Credentials used to prove the identity of the card management system to the card (CMTC authentication) (e.g., card management keys)
3. Credentials used by the card to prove the identity of the cardholder to an external entity (CTE authentication), such as a host computer (e.g., the CHUID, biometrics, or asymmetric keys).

The PIV card includes a data object known as the CHUID. The CHUID is defined in Special Publication (SP) 800-78. The CHUID consists of a Federal Agency Smart Credential Number (FASC-N), an expiration date for the card, and an asymmetric signature field. The FASC-N is used to uniquely identify each PIV card and the digital signature for authentication purposes.

As stated above, the PIV card has one mandatory key type and four optional key types:

- The PIV Authentication Key shall be an asymmetric private key supporting card authentication for an interoperable environment, and it is mandatory for each PIV card (**RAPIDS 7.3 now encodes this key on the CAC**). The PIV card shall store a corresponding X.509 certificate to support validation of the public key. The X.509 certificate shall include the FASC-N in the subject alternative name extension using the PIV FASC-N attribute to support physical access procedures. The expiration date of the certificate must be no later than the expiration date of the PIV card. The PIV authentication certificate shall include a PIV NACI indicator extension. This non-critical private extension indicates the status of the subject’s background investigation at the time of card issuance.
- The Card Authentication Key may be either a symmetric (secret) key or an asymmetric private key for physical access, and it is optional.
- The Digital Signature Key is an asymmetric private key supporting document signing, and it is optional. The PIV card shall store a corresponding X.509 certificate to support validation of the digital signature key.
- The Key Management Key is an asymmetric private key supporting key establishment and transport, and it is optional. This can also be used as an encryption key. The PIV card shall import and store a corresponding X.509 certificate to support validation of the key management key.
- The Card Management Key is a symmetric key used for personalization and post-issuance activities, and it is optional. The PIV card may also import and store X.509 certificates for use in PKI path validation.
3 PERSONNEL IDENTITY PROTECTION PROGRAM

DoD’s current Personnel Identity Protection (PIP) Program is defined in DoD Directive (DoDD) 1000.25, DoD Personnel Identity Protection (PIP) Program. As stated in DoDD 1000.25, the PIP shall be the DoD’s program for addressing threats to the individual personal privacy of its members, employees, and beneficiaries; establishing a secure and authoritative process for the issuance and use of identity credentials in the DoD; and ensuring DoD benefits and access to DoD physical and logical assets are granted based on authenticated and secure identity information.

RAPIDS must be operated in accordance with PIP policy and procedures. As part of these procedures, RAPIDS shall perform the following functions:

- Authenticate individuals to ensure DoD ID credentials are provided only to those with a current and appropriate affiliation with the DoD
- Capture uniquely identifying characteristics that bind an individual to the identity information maintained on that individual in DEERS and to the ID credentials issued by RAPIDS. These characteristics shall include digital photographs and fingerprints. DEERS shall be the sole authoritative repository for storing these characteristics
- Provide a distinct ID credential for use as proof of identity and DoD affiliation and that may act as the Geneva Conventions (GC) card in accordance with DoD Instruction (DoDI) 1000.13 (reference (d)) and as an authorization card for uniformed services benefits and privileges.

3.1 PROOF OF IDENTITY DOCUMENTATION

Since the release of RAPIDS 7.2, both the Create ID Card and Add a Family Member wizards have required the capture of documentation using a document scanner. The Create ID Card wizard requires RAPIDS users to verify and capture the ID card recipient’s identity source documents before issuing them an ID card. Two Form I-9, OMB No. 1115-0136 documents must be captured during enrollment or card issuance; one must be a valid state or federal government-issued picture ID. The Add a Family Member wizard requires the capture of a proof of relationship document. A list of approved identity and relationship proofing documents can be found in Appendix H of this user guide and in Attachment 5 of the Interservice Joint Instruction Air Force Initiative (AFI) 36-3026(I), Cards For Members of the Uniformed Services, Their Family Members, and Other Eligible Personnel RAPIDS 7.3 allows the RAPIDS user to skip the primary and secondary proof of identity documentation steps when documentation is not available. This should only be used in extreme circumstances when all of the customer’s ID has been lost or stolen—not as a convenience if the customer did not bring appropriate documentation. Skipping a document capture requires an SSM and will be audited.

In addition to requiring documentation for ID card issuance and adding family members, RAPIDS 7.3 requires documentation for the processes of changing ID numbers (i.e., Temporary Identification Number [TIN] to SSN) and reestablishing dependency for family members.
3.2 **DOCUMENT AUTHENTICITY VERIFICATION**

Failure to check the documentation of every card recipient could allow access to an unauthorized individual and enable someone to harm his or her colleagues and the United States. All documents used to verify identity must be original or certified true copies. A secure document has four layers added to it to prevent fraud:

- **First Layer**—What goes IN the paper when it is made (security fibers, threads, watermarks, etc.)
- **Second Layer**—What goes ON the paper when it is pre-printed as a blank document by a security printer
- **Third Layer**—What goes ON the pre-printed paper as variable information (information from the issuer)
- **Fourth Layer**—What goes ON the paper of transaction (signature, handwritten or typewritten, etc.).

In verifying the authenticity of required documents before issuing a DoD ID card, you have an important responsibility to prevent fraud. During the card issuance process, you can accept or reject an applicant based on two important questions:

1. Did the applicant present the exact documents required?
2. Based on a thorough examination, do these materials appear genuine?

The following are guidelines and criteria for assessing the authenticity of any document following its removal from a wallet or any plastic covering (see Figure 3.1):

- Look at the document
- Touch and feel the document
- Examine the document.

![Figure 3.1. Genuine Versus Counterfeit Document Comparison](image-url)
Look at the Document

The basic security features are typically placed so they are visible to the naked eye. Check both sides of a document and look for the following:

- Unusual appearance of text (alignment, capitalization, spacing, etc.)
- Interwoven lines, rainbow background, or repeated patterns
- Optical variable images and holograms
- Pictures of an individual interwoven or overlapped with other objects
- Encoded magnetic stripes or barcodes
- Quality of the state or federal seals
- Watermarks
- Ghost images.

Check the issue or filing date of a birth certificate. If the issue or filing date is more than 1 year after the birth, ask why.

Touch and Feel the Document

- Rotate the card to look for optical variable devices (such as holograms) and images.
- Feel the surface of the document. Some paper documents are printed with raised ink you can feel; some documents have a distinctive laminate or surface that may feel smooth or glossy. Feel each interior page of a passport for consistency.
- Feel for separations in the laminate.
- Feel the border design on the document (e.g., intaglio printing, letter pressing).

Examine the Document

- Closely evaluate the document for details in both design and information.
- Ensure the photograph on each document matches the person presenting the document.
- Evaluate and compare each document to determine its authenticity.
- Closely examine each document for any sign of alteration. Look for peeling, stains, misspelling, creases, or other indicators of alteration.
4 PRIVACY ACT AND PERSONALLY IDENTIFIABLE INFORMATION

4.1 THE PRIVACY ACT:

Protecting Privacy Act and personally identifiable information is mandatory to maintain PIV compliance. No agency shall disclose any record which is contained in a system of records by any means of communication to any person, or to another agency, except pursuant to a written request by, or with the prior written consent of, the individual to whom the record pertains.

There are specific exceptions for releasing records to an individual or agency, these include:

- Release for statistical purposes by the Census Bureau and the Bureau of Labor Statistics
- Release for routine uses within a U.S. government agency
- Release for archival purposes "as a record which has sufficient historical or other value to warrant its continued preservation by the United States Government"
- Release for law enforcement purposes
- Release for congressional investigations.

For detailed information regarding the disclosure of Privacy Act and personally identifiable information, see the Federal Register System of Record Notice for DEERS and RAPIDS. DMDC 02, Defense Enrollment Eligibility Reporting System (DEERS) (June 5, 2008, 73 FR 31999). You can access this notice by navigating your web browser to:
http://www.defenselink.mil/privacy/notices/osd/DMDC02.html

4.2 RESPONSIBILITIES OF THE RAPIDS OPERATOR

As a RAPIDS operator, it is your responsibility to adhere to the privacy requirements for RAPIDS operators. The privacy requirements for RAPIDS operators are:

1. Do not collect any additional data other than what is required on the 1172s.

2. Collect as much of the data as possible directly from the subject individual.

3. Make every subject individual aware of the Privacy Act Statement that is on the 1172.

4. Collection of data from the subject individual should be done to ensure accuracy, relevance, timeliness, and completeness as is reasonably necessary to assure fairness to the subject individual.

5. If RAPIDS data is printed, always use a Privacy cover sheet to alleviate incidental data exposure. Shred or place in a burn bag when no longer needed.

6. Ensure that if a contractor is handling the data, they are aware of the Privacy Act Statement restrictions. Data will not be shared with offshore contractors. The data shall not be disclosed, released, revealed, shown, sold, rented, leased or loaned to anyone other than the RAPIDS operator.
7. Records will be processed in a manner so that unauthorized persons cannot retrieve any records by means of computer, remote terminal, or other means.

8. Data concerning the subject individuals will not be extracted for any purpose. These files will not be duplicated or disseminated without the written consent of the subject individual or DMDC.

9. In the event DMDC determines a RAPIDS site has made an unauthorized disclosure of the data, DMDC may:
   - Request a formal response to an allegation of an unauthorized disclosure
   - Require the submission of a corrective action plan formulated to alleviate the possibility of any future unauthorized disclosure
   - Require the removal of the data
   - Prohibit the further release of DMDC data to the requesting agency
   - Additionally, criminal penalties contained in the Federal Privacy Act may apply if it is determined that the RAPIDS site and/or operator, or any individual employed or affiliated therewith, knowingly and willfully obtained records under false pretenses. Criminal penalty of a maximum fine of $5,000 per record maybe rendered and charged with a misdemeanor.

4.3 SAFEGUARDING PRIVACY ACT INFORMATION

There are three basic levels of safeguards for Privacy Act and personally identifiable information.

- Administrative
- Physical
- Technical

4.3.1 Administrative Safeguards

The first level of safeguards for protecting Privacy Act and personally identifiable information is administrative.

Administrative safeguards include:

- Releasing personally identifiable information
- Informing an individual of the details of the personally identifiable information solicitation
- The statute or executive order that authorizes the agency to solicit the information
- The principal purposes for which the information is intended to be used
- The routine uses which may be made of the information as published in the system of records notice in the Federal Register
- Whether the collection of the information is mandatory or voluntary; and the effects, if any, on the individual for not providing the information.
4.3.2 Physical Safeguards
The second level of safeguards for protecting Privacy Act and personally identifiable information is physical.

Physical safeguards include the proper storage, handling, and disposition of tangible items containing Privacy Act and personally identifiable information.

- DD Forms
- Procedures for storing and destroying accountable forms are the same as CONFIDENTIAL material (AR 380-5, Department of the Army Information Security Program, 29 September 2000)
- Failed, rejected, or returned ID cards
- New and unused cardstock
- Consumables.

ID Card Security and Accountability

Ensure that unauthorized persons do not obtain ID cards at your site. Familiarize yourself with the controls for the processing and handling of ID cards.

As a RAPIDS operator, you are responsible for safeguarding all three of the cardstock media. All cardstock should be safeguarded by securing in a locked drawer, cabinet, or safe at your site to keep from unauthorized access or use.

Failed, rejected, or returned cards contains information regarded as Personally Identifiable Information (PII) protected by the Privacy Act and must be securely stored until returned or destroyed. Further information on proper safeguarding, return, and destruction of the three media types – CAC, Teslin, and Chipless – is outlined in Section 11 of this user guide.

4.3.3 Technical Safeguards
The third level of safeguards for protecting Privacy Act and personally identifiable information is technical.

- Ensure that all message traffic, faxes, and e-mails that contain personal information are properly marked
- Ensure that all e-mail traffic is ENCRYPTED
- Password protect personal data placed on shared drives or local Intranet
- Monitor your actions: "If I do this, will I increase the risk of unauthorized access?"
- Think PRIVACY before you seek to establish new data collection

For additional information on safeguarding Privacy Act and personally identifiable information at your site, please use the following resources:

- The Privacy Act of 1974 is codified at 5 U.S.C. § 552a
- DoD Directive 5400.11
• DoD Regulation 5400.11-R
• OSD Administrative Instruction 81
• DoD Privacy Program Rules, 32 C.F.R. Part 310
• VOIS
• AFI.
5 DEERS/RAPIDS INFRASTRUCTURE

5.1 PKI INFRASTRUCTURE—PKI, RAPIDS, AND THE CAC

5.1.1 Public Key Infrastructure (PKI)

The DoD PKI consists of Certificate Authorities (CA), Registration Authorities (RA), directories, servers, and client applications. The system provides the framework and services for the generation, production, distribution, control, and accounting of certificates. The certificates contain the user’s unique digital identity (private key) and a public key that are stored on a user’s CAC. Public and private keys help ensure that the information transmitted between computers is secure. Having user specific keys on a CAC is not enough. They must have a PKI-enabled application that can utilize the keys to provide the following advantages:

- **Confidentiality or Privacy**—Protecting data from anyone who is not authorized to view it
- **Data Integrity**—Protecting data from unauthorized modification during transmission, storage, and processing
- **ID**—Verifying the identity of the person
- **Authentication**—Verifying identity through something the person possesses, something they alone know, or some part of them (fingerprint)
- **Non-Repudiation**—Preventing the e-mail sender from denying he or she sent the message. This is also the case when any document is signed with the individual’s digital signature certificate. It is imperative that each individual secures his or her CAC and does not share or write down the PIN protecting use of the card.

**Note:** As long as a certificate is signed by the trusted CA and the trusted CA’s signature can be verified, any tampering with the certificate can be readily detected.

5.1.2 Public Key Technology, RAPIDS, and the CAC

Public key technology is a form of cryptography that uses separate electronic keys for digitally signing, encrypting, and decrypting information. For public key technology to be trusted, it requires a supporting infrastructure—the PKI. Public key technology is often referred to as an asymmetric or two-key system. Each user has a pair of keys, and the keys are not the same but match up in a unique way. One key is kept only by the user and is called the private key. The other key is widely distributed and is called the public key. These electronic key pairs provide users with two important capabilities:

- Digitally sign a document.
- Encrypt and decrypt messages.

When digitally signing a document, senders use their private key to sign it, and recipients use the sender’s public key to verify the signature. When sending an encrypted message, senders use the recipient’s public key to encrypt the message, and recipients use their private key to decrypt the message.
RAPIDS is the application and hardware system that produces the DoD ID card. The RAPIDS application is used to verify an individual’s identity, gather data to be entered into public key certificates, and forward requests for certificates to the CA.

The CAC is designated as the primary token carrier for the DoD-wide PKI. Through RAPIDS, up to four PKI certificates and their associated private keys are stored on the CAC. These certificates are as follows:

- Identity certificate.
- E-mail encryption certificate.
- E-mail digital signature certificates.
- PIV Authentication certificate.

These certificates contain user identity data, the validity period for the certificate, the digital signature, and the private key portion of the public/private key pair used in public key encryption. Managing keys and certificates through a PKI helps an organization establish and maintain a trustworthy network environment. PKI information encrypted by a public key can only be decrypted with a private key (and vice versa). As DoD implements applications that use these automated technologies on the CAC, data can be added, modified, or removed from the card as needed. These cards are used for visual ID, access to buildings and controlled spaces, and access to DoD computer networks and systems. Component-specific uses may also be added at a later date and time.

5.2 NIPRNET/DISN

The DISN is the DoD’s consolidated worldwide enterprise-level telecommunications infrastructure, which provides the end-to-end information transfer network for supporting military operations. The DISN provides the data transport path between the RAPIDS servers and the DEERS database. The DISN also provides the transport path between the RAPIDS workstations and servers connected via the DoD wide area networks (WAN).

5.3 DMDC NETWORK

DEERS/RAPIDS creates an infrastructure that can track, store, and update service members’ personnel information and beneficiary data for the purpose of assigning benefits and issuing Uniformed Services identification and privilege cards. The following components of the DMDC network are critical to the ongoing operations of the DEERS/RAPIDS information system (see Figure 4.1).
5.3.1 CAC User Portal

The RAPIDS workstations require a connection to the User Portal (UP) and Certificate Authority (CA) to produce the CAC, communicate with the CA, and perform all cryptographic operations. The User Portal writes all data to the Integrated Circuit Chip (ICC) on the card and is responsible for generating the card recipient’s e-mail encryption keys and updating the card recipient’s CAC with the private key and digital certificates (two identity and two e-mail).

5.3.2 CA Servers

The DoD CA servers are systems that issue and manage digital PKI certificates for DoD end users. A certificate is a computer-generated record that ties a user’s ID with the user’s public key in a trusted bond. This trust is based on a registration process that is automated by the CA. The SSL session initiated by VO logon encrypts all communications between the CAC, User Portal, and CA. Over time new CAs are integrated into the infrastructure. CAC customers must ensure the root certificates for the CAC they possess is installed on their workstation. If they do not, the customer may assume their CAC is not working. Their systems administrators can install the latest DISA root certificates if this occurs.

5.3.3 RAPIDS Server

RAPIDS servers store site-centric characteristics about each site. This data includes user information for all sites and users assigned to an ID card location. The server also stores auditing and report data, lookup tables, and site-specific remarks for the DD Form 1172.
5.3.4 DEERS Database

The DEERS database tracks personnel and medical DoD benefits. DEERS uses a knowledge base of rules that make the determination of eligibility based on data entered into the database by a certified RAPIDS user.

5.4 ID CARDS

There are three cardstock media types used by the RAPIDS application for ID card production:

- CAC cardstock (Plastic smartcard media with integrated circuit chip (ICC) used to print the various Common Access Cards)
- Teslin cardstock (Synthetic print media with a pre-printed DoD Seal background, blank area for a photograph. The media can be red, blue, tan, or green.)
- Chipless cardstock (Credit-card sized chipless media)

RAPIDS operators issue each type of card to a specific population for specific purposes. These ID cards are property of the Department of Defense and should be cared for by the card holder and the ID card issuing facility in accordance with DoD policies. For more information regarding ID card types and the populations that are eligible for issuance, please reference the ID card charts in Appendix H.

5.4.1 CAC Cardstock

The CAC is designed to provide a common ID standard that allows the DoD to regulate physical and logical access to their facilities and networks.

Each CAC contains a unique ICC that has read and write capabilities and contains ID information about the card recipient, as well as a security PIN created by the cardholder. The PIN supports DoD’s information security efforts and prevents others from using the card to fraudulently obtain access to cardholder benefits. Services provided by the PIN management applet include—

- Verifying the PIN
- Changing the PIN
- Unlocking the card
- Managing the number of unsuccessful PIN attempts (three) before locking the chip
- Managing minimum (six) and maximum (eight) PIN lengths.

Updates to the CAC’s color coding, which conveys employee affiliation, have been made with the next-generation CAC. The colors’ meaning, positioning, and orientation have changed. Instead of a solid bar positioned the entire length of the card to the right of both the photograph and the ICC, the Name area has a shaded background with the designated color banner. The non-U.S. citizen stripe (blue) is printed if the individual is a non-U.S. citizen and a contractor.

Please see Appendix H: Card Charts for more information on the various types of CACs.
Note: It is important for both the CAC recipient and the VO to understand the importance of updating RAPIDS with the correct work e-mail address. The correct work e-mail address is used to derive the e-mail certificate. If the address on the certificate does not match the address actually being used, the application may reject the certificate.

If you are interested in learning more about the architecture, design, and placement of data on the CAC, go to http://csrc.nist.gov/publications/fips/fips201-1/FIPS-201-1-chng1.pdf to read the FIPS 201-1.

The U.S. Government has mandated Personal Identity Verification (PIV) across Government agencies as a result of HSPD-12. One facet of this implementation is for the CAC to transition to the Next Generation CAC format. As a VO, you are responsible for aiding the transition from the current CAC to the Next Generation CAC.

Below are four techniques for both physical and logical personal identity authentication:

- Using PIV visual credentials
- Using the PIV CHUID
- Using PIV biometric (unattended or attended)
- Using the PKI and PIN.

Figure 4.2. PIV Identity Verification and Issuance Process
Note: Future RAPIDS releases will not print full personal identifiers on ID cards. Only Geneva Conventions ID cards will show the last 4 digits of the personal identifier. Family Member ID cards will no longer include the personal identifier.

### 5.4.2 Teslin Cardstock

The Teslin card refers to the media on which the cards are printed. The Teslin cardstock is a synthetic print media used by the DoD to issue the Uniformed Services Identification and Privilege cards to beneficiaries, allowing them physical access into facilities, but not logical access to DoD systems.

Teslin cardstock color changes and the form number prints on the cardstock according to which card type is printed.

Note: RAPIDS 7 allows DD Form 1173-1 to remain valid when the DD Form 1173 is issued. When a Guard or Reserve Sponsor is activated, they and their family members receive full medical, commissary, Exchange, and MWR benefits during the period of Active Duty. During this activation period, the family members of the Guard or Reserve Sponsor can receive the 1173 with full benefits because the Sponsor is on Active Duty and their 1173-1 will not be terminated.
5.4.3 Chipless Cardstock

Chipless cardstock is credit-card size plastic similar in look and feel to the CAC cardstock, but it does not contain an integrated circuit chip.

The cardholder information is printed on a chipless plastic card. Please remember to replace the CAC cardstock in your printer with the chipless cardstock. Failure to correctly replace the cardstock can lead to site inefficiencies, such as wasted cardstock and extended wait times for customers who need an ID card.

The following personnel categories may be eligible for a DoD Chipless identity cards:

**DoD Civilian Retirees**
- Retired Personnel
- All recipients must be verified by the civilian personnel pay system

**Retired National Oceanic and Atmospheric Administration (NOAA) Wage Mariners**
- Retired Personnel
- Retired Non-Commissioned Officers
- Retired Crew Members
- Family Members
6 DEERS/RAPIDS ROLES

6.1 RESPONSIBILITY OF REGISTRATION OFFICIAL

The Registration Official is anyone that has been assigned the Local Registration Authority (LRA) privilege through DMDC Security Online. A registration official can perform one of the following DEERS/RAPIDS roles: VO, SVO, or a SSM. Despite having different DEERS/RAPIDS roles, registration officials share the following responsibilities:

- Ensuring the right people receive the right benefits
- Protecting and securing a person’s individual identity information
- Ensuring all information subject to the provisions of the Privacy Act, including data displayed on the RAPIDS workstation monitor, ID documentation, and applicable forms, is properly secured according to guidelines outlined in the Privacy Act
- The Privacy Act statement must be displayed at each workstation
- The individual card recipient must read the statement with the automated DD Form 1172, DD Form 2842 (Department of Defense [DoD] Public Key Infrastructure [PKI] Subscriber Certificate of Acceptance and Acknowledgement of Responsibilities), and DD Form 1172-2 (if available)
- Issuing authorized credentials
- Safeguarding buildings, military bases, networks, and information systems from malice or terrorist attacks.

6.2 USER ROLES

The following roles are listed in order of increasing authority from the VO to the SSM. RAPIDS does not automatically update the user’s privileges with all of their required roles. It is the SSM’s responsibility to ensure the inherited roles are assigned properly through DMDC Security Online.

- **Verifying Official (VO)**—Verifies data, enters data, and issues ID cards
- VO without the LRA role assignment cannot create CACs.
- VO can also be assigned the privilege of Issuing Official (IO), which provides the VO with signature privileges for the issuance of ID cards.
- It is possible for a user to not have the VO privilege but to have the IO privilege. The IO can verify data and enter data into a customer’s record but does not have the ability to issue ID cards.
- **Super Verifying Official (SVO)**—Performs all roles of the VO and manages report data and site information
- **Site Security Manager (SSM)**—Performs all roles of the VO and SVO and manages users, security, cardstock, and consumables. The SSM also performs RAPIDS security overrides for document and fingerprint support.

6.2.1 VO

The main function of a RAPIDS Verifying Official (VO) is to ensure uniformed service members, their family members, and other eligible beneficiaries receive the DoD benefits to
which they are entitled. With the added responsibility of issuing ID cards, the VO is on the front lines of defending national security interests and plays an important role in keeping our country safe. The VO’s role is similar to a gatekeeper. As a gatekeeper, the VO issues credentials in the form of ID cards. No matter what type of Uniformed Services ID or Privilege card the VO issues, the card recipient may gain access to government facilities, information systems, and privileges throughout the world. A VO performs the following tasks:

- Protects the privacy and confidentiality of data on the RAPIDS terminal screen. The Privacy Act statement must be displayed at each workstation. The individual card recipient must be referred to read the statement with automated DD Form 1172, DD Form 1172-2, and DD Form 2842
- Verifies the identity of card recipients as required by AFI 36-3026(I) before entering applicant data in RAPIDS
- Completes the annual RAPIDS certification training
- Views and scans legal documents prior to entry into DEERS or issuance of ID cards
- Enters DoD Sponsor and family member information
- Issues DoD ID cards to military members, their family members, and other entitled persons with a DoD association
- Suspends an individual’s commissary, exchange, or MWR privileges as necessary
- Uses the RAPIDS workstation to issue the CAC and request certificates, and then downloads them to the CA before issuing the card
- Updates the CAC as necessary to reflect any change in the personnel category of the CAC recipient. This step automatically issues or revokes certificates as needed
- Terminates a CAC to execute revocation requests received from the LRA or other authorized sources
- Generates the DD Form 1172
- See the SSM/VO Tip Sheet located on the VOIS for more information.

6.2.2 SVO

The SVO usually is an experienced RAPIDS user who has been performing the role of a VO. Based on his or her proficiency in RAPIDS, the user has been assigned the role of SVO to assist the SSM with auditing RAPIDS updates and managing reports. The SVO performs all of the responsibilities of the VO and these additional tasks:

- Prints and reviews all information on the audit trail reports.
- Evaluates the audit trail report to monitor for fraud, waste, and abuse.

6.2.3 SSM

The SSM is critical to the success of daily operations at a RAPIDS site. As a result, it is required by the Service Project Office that there are two active SSMs at each site. The Service Project Office physically assigns a primary SSM and a secondary SSM to each site to ensure the site continues to function in the absence of one of the SSMs. Sites with only one SSM should identify and assign roles to a backup SSM. The SSM performs all responsibilities of a RAPIDS user (VO/SVO), as well as all SSM responsibilities, including managing users, cardstock, and consumables. Each SSM is responsible for supporting each of these RAPIDS functions:
• User administration and user security
• CAC cardstock and consumables: ordering, management, and accountability
• Policy and procedure compliance
• Site administration and security
• Documentation and training
• Validation of the identity of individuals whose fingerprints cannot be captured
• Use of the automated card management system.
• See the SSM/VO Tip Sheet located on the VOIS for more information.
• See Section 10 of this user guide for detailed information on reporting responsibilities of the SSM

6.3 **Service Project Officer**

Each uniformed service, its Guard and Reserve components, and some DoD agencies have an assigned SPO.

**The DEERS/RAPIDS Personnel Project Officers (PO) are responsible for approving—**

- Maintaining the DoD Instructions and governing guidance
- Ensuring all RAPIDS operators maintain system integrity by properly adhering to DoD and Service guidance
- Initial access for SSMs to DEERS/RAPIDS
- Initial site ID requests
- Equipment relocation requests
- Additional equipment requests
- Retiree days and open houses.

**Users should contact the Sponsor’s SPO if they—**

- Are unsure the documentation supplied by the Sponsor or family member is acceptable to perform the associated action in RAPIDS
- Need to have a new record created in DEERS, but do not have the ability to create it
- Have questions on how to correct or change information in a record
- Terminate a DEERS record for invalid entry with the assistance of the DSO Research and Analysis (R&A) team
- Need to lock or unlock a record in DEERS because of past, present, or future access issues
- Represent their service’s requirement to Personal Identity Protection Solutions (PIPS)
- Need SSM changeover requests.

**The SPO may—**

- Add the Dependent abuse personnel entitlement condition to the Sponsor record
- Approve requests for new DEERS site IDs, requests to combine site IDs, on-site RAPIDS training by Field Service Representatives (FSR), initial RAPIDS
workstations, additional RAPIDS workstations, and RAPIDS workstation
relocations for their service branch

• Add new personnel service records that are restricted at non-SPO RAPIDS sites, (e.g., Active Duty, civilian)
• Provide policy guidance to their RAPIDS users
• Answer service-specific policy questions
• Answer PKI policy questions.

Note: A complete listing of the DEERS/RAPIDS POs can be found on the VOIS under Contact Information.

6.4 RAPIDS WORKSTATION—ROLES OF THE RAPIDS WORKSTATION

The RAPIDS workstation serves as the tool to approve, revoke, and issue certificates on the CAC. The DoD PKI uses the RAPIDS workstation to—

• Register DoD CAC holders with the CA
• Create and print the CAC
• Download and encode the certificates onto the CAC.

The RAPIDS workstation resets a user’s CAC PIN and backup data from the CAC to DEERS. The CAC can be used for computer access, network access, e-mail encryption, building access, digital signature, and other PKI applications developed and deployed by the DoD.

Note: The RAPIDS software produces the CAC. Separate applications must be written or procured by organizations that desire to use the CAC for building access and e-mail use. These separate applications are not detailed in this user guide. Contact your local command for guidance.

6.4.1 Desktop Workstation

The RAPIDS desktop workstation is a stationary system located in an office environment. The VO, Super Verifying Official (SVO), or SSM uses it to perform DEERS updates and produce the various Uniformed Services identification and privilege cards. It is part of an extensive database and communication infrastructure developed to support RAPIDS functionality.

6.4.2 Deployable Workstation

The RAPIDS deployable workstation is a portable version of the desktop workstation. It is primarily purchased to support mobilized units and is not meant to replace the desktop units. For example, the deployable platform is onboard U.S. Navy (USN) ships and used by the Guard/Reserve communities to support travel and DEERS record update or ID card production for remote populations.

Note: For a complete listing of components needed to utilize the desktop and deployable workstations, please reference the RAPIDS 7.3 User Guide Hardware section.
6.4.3 CAC Central Issuance Requesting Station (CACCIIRS)

CAC Central Issuance Requesting Station (CACCIIRS) are located at uniformed services reception centers or uniformed service academies. This streamlined RAPIDS application allows identity and biometric data to be captured with CAC issuance completed at a DMDC centralized location. After all personnel information has been collected for each service member received during the reception process, a request is sent to the Central Issuance Facility to print and encode the ID cards. Simultaneously, an additional request is sent to a separate location that generates the PIN numbers for each CAC that was printed. Next, the CACs and PINs are independently mailed to individuals at the CACCIRS site for final distribution.

Note: Proper security procedures dictate that one SSM receives the CACs and a different Person In Charge (PIC) receives the PIN mailer shipments. SSMs should refer to the Inventory Logistics Portal (ILP) User Guide located on the VOIS for the most up-to-date information about CACCIRS sites. Failure to receive the CACs or PINs, as well as failure to accept the CACs in the ILP, prevents CAC recipients from accessing a DoD network.
RAPIDS 7.3 HARDWARE

6.5 DESKTOP WORKSTATION

The RAPIDS desktop workstation is a stationary system located in an office environment (see Figure 6.1). The VO, SVO, or SSM operates it to perform DEERS updates and to produce the various Uniformed Services ID and Privilege Cards.

![Figure 6.1. RAPIDS 7.3 Desktop Hardware](image)

6.5.1 Components of the Desktop Workstation

The desktop workstation consists of the following components:

- Color monitor
- Desktop computer
- Keyboard
- Mouse
- Fingerprint reader
- Digital camera
- Laminator
- Universal Serial Bus (USB) hub
- Surge suppressor
- Smart card printer
- Smart card reader/encoder
- Contactless smart card reader/encoder
- PIN pad
- Bar code scanner/decoder
- Document scanner
- Laser printer.

6.5.2 Desktop Workstation Maintenance

- To properly maintain the RAPIDS desktop workstation, you should—
- Dust the computer daily
• Clean the fingerprint scanner, barcode scanner, and digital camera viewfinder, lens, and LCD screen with a soft lint-free cloth
• Call the DMDC Support Center (DSC) if you have any hardware problems.

6.5.3 Smart Card Printer

Loading Consumables

Consumables are the smart card printer supplies that deplete over time. For the desktop workstation, the consumables consist of the color ribbon, transfer film, half laminate, ICC laminate, and cleaning supplies. With the exception of the cleaning supplies, the desktop consumables are matched evenly to last 200 cards. When consumables are completely depleted, the VO is responsible for loading new consumables. To ensure quality printing and avoid waste, properly install the printer consumables. When disposing consumables, dispose of them in accordance with local Privacy Act destruction policies. For detailed instructions on how to load consumables, please refer to the Consumables Loading Procedures document for your model printer under the Printer Maintenance section of the VOIS (https://www.dmdc.osd.mil/vois/owa/vois).

Preventative and Corrective Maintenance

Routine and preventative maintenance are very important in maintaining the best working condition and prolonging the life of the smart card printer. The VO is responsible for performing maintenance on the smart card printer using the cleaning supplies provided in the cleaning kit. Before conducting any maintenance on the printer, the VO needs to make sure he or she turns it off and disconnects any power cords. The printer can get very hot inside. The only time the printer power should be turned on during the maintenance process is when the VO is cleaning the rollers or running the cleaning cards through the printer. The VO must refrain from wearing jewelry during the cleaning process because it can damage the internal components of the printer. The VO must also wear a personal grounding device or make contact with the outside of the printer before touching any internal electrical components because this may also cause damage to the printer.

For detailed instructions on what components of the printer need to be cleaned and how often they need to be cleaned, please refer to the Cleaning Procedures document for your model printer under the Printer Maintenance section of the VOIS (https://www.dmdc.osd.mil/vois/owa/vois). For instructions on how to respond to errors on the printer’s LCD display, please refer to the Quick Reference Guide for your model printer under the Printer Maintenance section of the VOIS.

Note: Refer to the RAPIDS Desktop Hardware Guide maintained on the VOIS for further troubleshooting details for each component.

6.6 Deployable Workstation

The RAPIDS deployable workstation—a portable version of the desktop workstation—is used in mobilizations or onboard USN ships (see Figure 6.2). It is also used by the Guard and Reserve communities to support remote populations.
6.6.1 Components of the Deployable Workstation

The deployable workstation consists of the following components:

- Surge suppressors
- Deployable printer
- Deployable laminating machine
- Deployable laptop
- Seven-port deployable hub with USB cable
- Deployable fingerprint scanner with USB cable
- Deployable USB PIN pad
- Deployable smart card printer
- Deployable dual interface smart card reader
- Deployable USB smart card reader/encoder
- Camera tripod
- Deployable camera
- Video to USB adapter w/USB cable
- Deployable document scanner
- Deployable bar code scanner.

6.6.2 Deployable Workstation Assembly

1. Remove the RAPIDS documentation from the notebook soft-sided carrying case and place it on the table.
2. Remove the 110-volt (V) surge suppressors from the laser printer soft-sided carrying case and place them underneath the table.
3. Remove the deployable notebook from the notebook soft-sided carrying case and place it on the table.
4. Remove the notebook A/C adapter from the notebook soft-sided carrying case and place it on the table.
5. Plug the notebook A/C adapter into the DC-IN jack on the right side (as viewed from the front) of the deployable notebook.
6. Plug the A/C adapter end of the notebook A/C adapter into the 110-V surge
7. Remove the 14-foot (ft) RJ-45 network cable from the notebook soft-sided carrying case and plug one end of it into the active network jack on the wall closest to the deployable notebook.
8. Remove the 14-ft RJ-45 network cable from the notebook soft-sided carrying case and plug one end of it into the active network jack on the wall closest to the deployable notebook.
9. Remove the USB hub from the retransfer plastic card printer soft-sided carrying case and place it on the table.
10. Remove the USB hub power cord from the retransfer plastic card printer soft-sided carrying case and place it on the table.
11. Plug the power cord into the USB hub DC power supply jack.
12. Plug the A/C adapter end of the USB hub power cord into the 110-V surge suppressor.
13. Plug the USB hub cable into the rear USB port located on the left (as viewed from the rear) of the of the deployable notebook.
14. Remove the PIV fingerprint scanner from the retransfer plastic card printer soft-sided carrying case and place it on the table.
15. Plug the USB cable of the PIV fingerprint scanner into the rear USB port located on the right (as viewed from the rear) of the deployable notebook.
16. Remove the USB PIN pad from the retransfer plastic card printer soft-sided carrying case and place it on the table.
17. Plug the USB cable of the USB PIN pad into USB port 1 (bottom port labeled 1/2 of the USB hub.
18. Remove the cardstock case from the laser printer soft-sided carrying case and place it on the table.
19. Remove the laser printer from the laser printer soft-sided carrying case and place it on the table.
20. Remove the 6-ft USB cable for the laser printer from the laser printer soft-sided carrying case and place it on the table.
21. Remove the printer power cable from the laser printer soft-sided carrying case and place it on the table.
22. Plug the USB cable of the laser printer into port 2 (top port labeled 1/2) of the USB hub.
23. Plug the other end of the USB cable into the USB port in the back of the laser printer.
24. Plug the printer power cable into the printer power cable jack in the back of the laser printer.
25. Plug the A/C adapter end of the printer power cable into the 110-V surge suppressor.
26. Remove the plastic card printer from the retransfer plastic card printer soft-sided carrying case and place it on the table.
27. Remove the plastic card printer USB cable from the retransfer plastic card printer soft-sided carrying case and place it on the table.
28. Remove the switching power supply of the printer laminator cord for the plastic card printer from the retransfer plastic card printer soft-sided carrying case and
28. Place it on the table.

29. Remove the A/C adapter of the power laminator cord for the plastic card printer from the retransfer plastic card printer soft-sided carrying case and place it on the table.

30. Remove the switching power supply of the power printer cord for the plastic card printer from the retransfer plastic card printer soft-sided carrying case and place it on the table.

31. Remove the A/C adapter of the power printer cord for the plastic card printer from the retransfer plastic card printer soft-sided carrying case and place it on the table.

32. Plug the female end of the A/C adapter for the power laminator cord into the switching power supply.

33. Plug the HDP600 USB smart card printer power laminator cord into the power laminator jack on the right side of the back of the plastic card printer (as viewed from the back).

34. Plug the A/C adapter end of the power laminator cord into the 110-V surge suppressor.

35. Plug the female end of the A/C adapter for the power printer cord into the switching power supply for the plastic card printer.

36. Plug the female end of the A/C adapter for the power printer cord into the switching power supply for the deployable USB smart card printer.

37. Plug the A/C adapter end of the power printer cord into the 110-V surge suppressor.

38. Plug the plastic card printer USB cable into the USB port in the back of the printer.

39. Plug the other end of the USB cable of the plastic card printer into port 3 (bottom port labeled 3/4) of the USB hub.

40. Remove the camera tripod from the document scanner soft-sided carrying case and place it on the table.

41. Remove the digital camera from the retransfer plastic card printer carrying case and place it on the table.

42. Attach the digital camera to the mounting plate of the tripod by placing the screw fitting into the threaded opening in the bottom of the camera.

43. Plug the mounting plate back into the tripod by pulling back on the lever and sliding the mounting plate into the groove.

44. Remove the camera A/C adapter from the retransfer plastic card printer soft-sided carrying case and place it on the table.

45. Plug the jack end of the digital camera A/C adapter into the power supply jack located on the bottom of the camera.

46. Plug the A/C adapter of the digital camera into the 110-V surge suppressor.

47. Remove the video extension cable from the retransfer plastic card printer soft-sided carrying case and place it on the table.

48. Remove the video to USB adapter cable from the retransfer plastic card printer soft-sided carrying case and place it on the table.

49. Remove the video to USB adapter from the retransfer plastic card printer soft-sided carrying case and place it on the table.
50. Plug the single end of the video to USB adapter cable into the video out port of the digital camera located on the left side of the camera (as viewed from the front).
51. Plug the yellow end of the video to USB adapter cable into the female end of the video extension cable.
52. Plug the male end of the video extension cable into the composite video port of the video to USB Adapter.
53. Plug the USB cable from the video to USB Adapter into port 4 (top port labeled 3/4) of the USB hub.
54. Remove the document scanner from the document scanner soft-sided carrying case and place it on the table.
55. Remove the 10-ft USB cable from the notebook soft-sided carrying case and place it on the table.
56. Remove the document scanner A/C adapter from the document scanner soft-sided carrying case and place it on the table.
57. Plug the Automatic Document Feeder (ADF) cable which is hardwired to the ADF into the ADF port on the side of the scanner.
58. Plug the 10-ft USB cable into the USB port on the side of the scanner.
59. Plug the other end of the USB cable into port 5 of the USB hub.
60. Plug the document scanner A/C adapter into the A/C adapter port on the side of the scanner.
61. Plug the scanner A/C adapter into the 110-V surge suppressor.
62. Remove the USB contactless smart card reader from the retransfer plastic card printer soft-sided carrying case and place it on the table.
63. Plug the USB contactless smart card reader USB cable into port 6 (bottom port labeled 6/7) of the USB hub.
64. Remove the USB smart card reader/encoder from the retransfer plastic card printer soft-sided carrying case and place it on the table.
65. Plug the USB smart card reader/encoder USB cable into port 7 (top port labeled 6/7) of the USB hub.
66. Remove the code 39 barcode scanner from the document scanner soft-sided carrying case and place it on the table.
67. Remove the barcode scanner power adapter from the document scanner soft-sided carrying case and place it on the table.
68. Plug the barcode scanner data cable into the COM1 port located on the right side in the back (as viewed from the back) of the deployable notebook.
69. Plug the barcode scanner power adapter into the A/C jack on the barcode scanner cable.
70. Plug the A/C adapter end of the barcode scanner power adapter into the 110-V surge suppressor.
71. Remove the laminator from the laser printer soft-sided carrying case and place it on the table.
72. Plug the power cord of the laminator into the 110-V surge suppressor.
73. Plug one of the two 110-V surge suppressors into the A/C wall outlet closest to the equipment.
74. Plug the second 110-V surge suppressor into another A/C wall outlet closest to the equipment.
the equipment.

75. Press the On button on one of the 110-V surge suppressors to provide power to the equipment.

76. Press the On button on the second 110-V surge suppressor to provide power to the remaining equipment.

### 6.6.3 Deployable Workstation Maintenance

Like the desktop workstation, the deployable workstation requires you to—

- Dust the laptop and peripherals daily with a soft cloth
- Clean the fingerprint scanner, barcode scanner, and digital camera viewfinder, lens, and LCD screen with a soft lint-free cloth
- Call the DSC User Help Desk if you have any hardware problems
- Refer to the RAPIDS Hardware Guide and the VOIS Website at https://www.dmdc.osd.mil/vois/owa/vois for additional information.

### 6.6.4 Smart Card Printer

**Loading Consumables**

Consumables are the smart card printer supplies that deplete over time. For the deployable workstation, the consumables consist of the color ribbon, transfer film, laminate, and cleaning supplies. The color ribbon can print 400 two-sided cards, the transfer film can print 625 two-sided cards, and the laminate can laminate 75 two-sided cards. When consumables are completely depleted, the VO is responsible for loading new consumables. To ensure quality printing and avoid waste, properly install the printer consumables. When disposing consumables, dispose of them in accordance with local Privacy Act destruction policies. For detailed instructions on how to load consumables, please refer to the Consumables Loading Procedures document for your model printer under the Printer Maintenance section of the VOIS (https://www.dmdc.osd.mil/vois/owa/vois).

**Preventative and Corrective Maintenance**

Routine and preventative maintenance are very important in maintaining the best working condition and prolonging the life of the smart card printer. The VO is responsible for performing maintenance on the smart card printer using the cleaning supplies provided in the cleaning kit. Before conducting any maintenance on the printer, the VO needs to make sure he or she turns it off and disconnects any power cords. The printer can get very hot inside. The only time the printer power should be turned on during the maintenance process is when the VO is cleaning the rollers or running the cleaning cards through the printer. The VO must refrain from wearing jewelry during the cleaning process because this can damage the internal components of the printer. The VO must also wear a personal grounding device or make contact with the outside of the printer before touching any internal electrical components because this may also cause damage to the printer.

For detailed instructions on what components of the printer need to be cleaned and how often they need to be cleaned, please refer to the Cleaning Procedures document for your model printer under the Printer Maintenance section of the VOIS (https://www.dmdc.osd.mil/vois/owa/vois).
For instructions on how to respond to errors on the printer’s LCD display, please refer to the Quick Reference Guide for your model printer under the Printer Maintenance section of the VOIS.

When you need additional assistance with your RAPIDS workstation, contact the DSC User Help Desk. Contact Information for the DSC User Help Desk:

1-800-372-7437 (CONUS)
DSN: 698-5000 (CONUS)
DSN: 312-698-5000 (OCONUS)

### 6.6.5 Taking ID Card Photos with the Digital Camera

RAPIDS 7 does not control the zoom and alignment of the ID card photos taken with the RAPIDS deployable workstation digital camera. You must manually focus and position the digital camera view to properly frame the customer’s photo, capture the customer’s photo using the digital camera first, then import the photo into RAPIDS. The RAPIDS – Capture Photo wizard will automatically import the captured photo when the digital camera is properly connected and in Play mode. Once the photo is imported into RAPIDS, you must click Capture Picture in the RAPIDS – Capture Photo wizard.

1. Ensure the digital camera is properly connected to the RAPIDS deployable workstation. See section 7.2.2 of this user guide for detailed instructions.

2. Navigate to the RAPIDS – Capture Photo wizard.

3. Click the Capture button on the digital camera.

4. Once the photo is captured on the camera, set the camera to Play mode and review the photo. If the photo is properly framed, continue to step 5. If the camera is not properly framed, repeat steps 2-4.

5. Click Capture Picture in the RAPIDS – Capture Photo wizard. Review the photo to ensure that it is properly framed in the RAPIDS – Capture Photo wizard. If the photo is properly framed, continue the ID card issuance process. If the camera is not properly framed, discard the photo and repeat steps 2-5.
7 RAPIDS TRAINING

7.1 POLICY REQUIREMENTS

All RAPIDS users are required to take Web-based training before performing CAC operations or updating customer information using RAPIDS. If a RAPIDS user needs to access the DMDC Learning Site for RAPIDS Web-based training, please visit http://learning.dmdc.osd.mil. Users are required to take the training 1 year from the completion date listed on their RAPIDS Training Course Completion Notice. If users do not complete the training in the specified timeframe, RAPIDS will not authorize access of un-certified users. The VO is not authorized to access the RAPIDS system and therefore cannot assist their customers until RAPIDS training certification renewal is complete.

Note: The SSM has the capability to utilize the DMDC Security Online to verify that all SSMs and VOs associated with the SSM’s site have completed the RAPIDS training. If you are unaware of the status of your RAPIDS training, please contact your SSM to verify this information by viewing your certification status through DMDC Security Online.

SSMs and VOs must be aware of the following scenarios that affect their ability to meet the needs of their customers:

- If a VO is assigned to become an SSM, the VO must take all Web-based training courses included in the SSM training curriculum.
- If the site migrates from a RAPIDS 6.5 workstation to a RAPIDS 7.x workstation, SSMs and VOs must complete the RAPIDS 7 certification courses.
- If you possess an active RAPIDS certification, RAPIDS 7 will not lock you out, but you will need to take the courses.
- If you do not have an active certification, RAPIDS 7 will lock you out until you take the RAPIDS 7.x courses.

7.2 WEB-BASED TRAINING MATRIX

Training courses are assigned to users based on their roles in DMDC Security Online and the version of RAPIDS associated with their site ID. Users can reference the Web-Based Training Matrix on the VOIS to identify which courses they are required to take to earn their RAPIDS 7 certification. Users are required to complete their certification annually. The completion date is the date the user completes the last class in his or her certificate program. For example, if a user finishes his or her last class on November 5, 2007, the certification expires November 5, 2008. The user should begin to look for courses about 2 weeks before the expiration date of the training certification.

Note: The following roles are assigned to the RAPIDS 7.3 VOs, SVOs, and SSMs:

- VO 02 03 14
- SVO 02 03 04 14
- SSM 02 03 04 06 14.
The SSM can assign roles to the VO and SVO through DMDC Security Online. Only the PO can assign roles to the SSM. Please reference Section 10 of the RAPIDS 7.3 User Guide to learn more about the roles assigned to each user through DMDC Security Online.

### 7.3 Training User Guide

The Web-Based Training User Guide can be found on the VOIS (https://www.dmdc.osd.mil/vois/owa/vois). After logging on to the VOIS, click **Tools/Training Resources** and the user guide will be available on the resulting page. Please navigate to the Web-Based Training User Guide to receive instructions on how to—

- Access the Web training
- Log on to the learning Website
- Launch a course
- Navigate the training interface
- Obtain a copy of your Course Completion Notice.

**Note:** RAPIDS 7.3 workstations are equipped with Internet Explorer (IE) version 7 to increase the efficiency of the RAPIDS training. In IE 7, the pop-up blocker is turned on by default. Therefore, it is important to disable the pop-up blocker while taking the RAPIDS training.
8 GETTING FAMILIAR WITH THE RAPIDS WORKSTATION

8.1.1 Increased Security Functionality for RAPIDS 7.3

- RAPIDS 7.3 utilizes true cryptographic application login. All RAPIDS users need an e-mail digital signature certificate for PKI logon.
- RAPIDS 7.3 was enhanced to produce the PIV-compliant CAC in compliance with HSPD-12.
- RAPIDS 7.3 allows VOs to view Contractor Verification System (CVS) sponsorship information. CVS sponsorship is viewable from the Personnel Category screen and should be reviewed for a confirmation.
- RAPIDS 7.3 workstations lock upon CAC removal. RAPIDS must complete the logoff process before the CAC is removed; otherwise, the user will not be able to successfully log off.
- RAPIDS 7.3 workstations are configured to stay connected to VPN so the workstation can receive automated software updates.
- To comply with the new PIV biometric formats, all fingerprints captured with older versions of the RAPIDS software must be replaced in 7.3.
- RAPIDS 7.3 requires verification of two fingers upon CAC issuance. RAPIDS 7.3 prompts the VO to match both the primary and secondary fingerprint when issuing an ID card.

8.1.2 Enhancements

- Ability to issue the PIV End Point CAC used for cross-agency logical access.
- Support for the issuance of the DoD Civilian Retiree card.
- SSMs/VOs can now choose to retrieve a family member photo from DEERS to verify identity.
- RAPIDS no longer terminates the DD Form 1173-1, *DoD Guard and Reserve Dependent ID card*, when issuing the DD Form 1173, *Uniformed Services Identification and Privilege card*.
- RAPIDS now includes additional personnel categories for foreign affiliates. Foreign military, foreign civilian, and foreign contractor each fall under the main personnel category of Foreign Affiliate. A Foreign Affiliate is a non-U.S. citizen working with the U.S. government that is not paid by the U.S. government.
- Per legislation, National Oceanic and Atmospheric Administration (NOAA) wage mariner DoD civilians now receive CACs.
- RAPIDS 7.3 allows eligible retired wage mariners and their family members to receive ID cards. Legislation was changed to extend commissary privileges to all retired NOAA wage mariner personnel, including retired non-commissioned officers (NCO) and crew members. Sponsors receive CACs, but family members receive chipless plastic cards.
- RAPIDS 7.3 no longer allows SSMs/VOs to use emergency essential conditions for personnel categories other than DoD civilians. SSMs/VOs are now instructed to use the essential contractor services OCONUS (outside the continental United States) and essential contractor services CONUS (continental United States) conditions for DoD and uniformed services contractors.
RAPIDS 7.3 allows ID cards to be printed with an indefinite end date for permanently incapacitated descendents of retirees, including child, foster child, stepchild, ward, and pre-adoptive child. INDEF (i.e., indefinitely) appears as the expiration date for these cards per recent legislation.

Recent legislation changes allow benefits in DEERS for newly commissioned Reserve component officers awaiting Initial Active Duty (IAD). RAPIDS 7.3 displays benefits for newly commissioned Reserve component officers awaiting IAD. These Sponsors are not entitled to an ID card until they go on Active Duty or if they already have an ID card as a member of the Selected Reserve.

United States Coast Guard (USCG) Non-Appropriated Fund (NAF) exchange employees are entitled to exchange benefits. RAPIDS 7.3 allows USCG NAF exchange employees to receive a CAC showing the limited exchange privilege.

RAPIDS 7.3 allows NAF employees/DoD civilians who reside on a military installation to have conditions for living in quarters.

In prior versions of RAPIDS, Intergovernmental Personnel Act (IPA) members were added as a non-federal agency associate. In RAPIDS 7.3, they may be added as a civilian affiliate. Benefits and entitlements are equivalent to DoD civilians. RAPIDS has the capability to place an IPA on an OCONUS assignment and assign an emergency essential condition.

RAPIDS 7.3 now allows DoD beneficiaries to be dual entitled with other personnel categories. Users may add family members if entitled under the secondary personnel category.

Family members of DoD beneficiaries now receive their corresponding DoD beneficiary benefit sets and ID cards only if their association begin date to the DoD beneficiary is before, equal to, or within 10 months after the DoD beneficiary personnel begin date.

RAPIDS VOs can now lighten/darken fingerprint settings “on the fly” while logging in or capturing/verifying fingerprints for customers. To do this, click on the Edit button on the fingerprint capture window, then modify the Gain or Exposure settings to modify the lightness or darkness of the print for easier verification or capture.

### 8.1.3 Additional Functionality Enhancements

- SSMs/VOs have the capability to change a Foreign Identification Number (FIN) to a Social Security Number (SSN) or Individual Taxpayer ID Number (ITIN). RAPIDS 7.3 captures the appropriate documentation justifying the change.
- SSMs/VOs will scan and capture relationship documentation.
- In previous versions of RAPIDS, users were only allowed to select **DoD Sponsor ID** as the primary document source. RAPIDS 7.3 now allows users to select **Sponsor ID card** for primary and secondary proof of identity. The customer may present two different sponsor ID cards, such as a Civil Service CAC and a Military Retiree ID.
- RAPIDS 7.3 prevents a change to the sponsor’s gender code for unterminated Active Duty, Guard/Reserve, Retired Uniformed Service, Reserve Retirees, and Academy Student personnel categories.
RAPIDS searches DEERS before adding a new person to the database. When adding a new person in RAPIDS, if DEERS finds a match, it automatically adds the person and populates RAPIDS with the person’s data. The following data must match the person identifier, person identifier type, first three characters of the last name, and date of birth.

SSMs/VOs have the ability to issue an ID card in the event identity documents are not available for the VO to reference or scan. This practice should only be used in extreme circumstances when all of the customer’s ID has been lost or stolen—not as a convenience if the customer did not bring appropriate documentation. Skipping a document capture requires an SSM and will be audited.

RAPIDS users can add sponsor work address via the Address wizard and the Contacts view. Work addresses for Uniformed Services and DoD Civilians come from a source and cannot be updated by the VO.

The Benefits timeline was adjusted to show graphical representation of benefits for only 1 year in the past, the present year, and 2 years of future eligibility.

RAPIDS 7.3 now displays the reason for relationship termination on the Relationship view and for terminated personnel categories sent from DEERS.

RAPIDS 7.3 has revised the DD Form 1172 with the updated, approved DD Form.

RAPIDS 7.3 allows the VO to match or replace fingerprints before issuance from within the Characteristics view.

RAPIDS 7.3 now forces the selection of a person in the Address Update wizard before moving forward to the next step of the wizard.

The Back button in the Add Person wizard now takes the SSM/VO back in the Add Person wizard.

8.1.4 New Card Types

8.1.4.1 DOD CIVILIAN RETIREE

A DoD Civilian Retiree is someone who was formerly a DoD civil service member but has retired and now falls under the personnel category of DoD civilian retiree. VOs have the ability to add this personnel category to individuals who already exist in DEERS. DoD civilian retirees may be eligible for the Civilian Retiree card if the civilian personnel pay system has verified their personnel category. A personnel category that has been verified by the civilian personnel pay system will show on the RAPIDS Sponsor Conformation tab as Verified.

RAPIDS 7.3 allows the ability to add a DoD civilian retiree, and that person is entitled to an ID card. This is a new ID card type that prints on chipless plastic cardstock. DoD civilian records from 2002 forward have been preloaded into DEERS. Records before 2002 will not be available in DEERS until December 2008. Therefore, these individuals may not receive an ID at this time. SSMs may order chipless cardstock using the consumables order form posted on the Verifying Official’s Information System (VOIS).
**Figure 4.1.3 Chipless ID Cards—DoD Civilian Retiree**

**Note:** The DoD Civilian Retiree card uses chipless cardstock. Please remember to place chipless cardstock in the printer before issuing the Civilian Retiree card. DoD Civilian Retirees do not receive ID cards that contain a chip.

### 8.1.4.2 CIVILIAN RETIREE (NOAA)

The NOAA Civilian Retiree card (see Figure 4.14) is issued to the following retired NOAA Wage Mariners:

- Retired Personnel
- Retired NCOs
- Retired Crew members
- Family members
Note: The NOAA Civilian Retiree card uses chipless cardstock. Please remember to place chipless cardstock in the printer before issuing the Civilian Retiree card. NOAA Civilian Retirees do not receive ID cards that contain a chip. Family members of Retired Wage Mariners may be eligible for an ID card as well.

8.2 USING THE RAPIDS WORKSTATION

8.2.1 Log on to the RAPIDS Workstation

To log on, the VO must insert his or her CAC into a smart card reader/encoder attached to the RAPIDS workstation. At this point, RAPIDS uses the ActivClient utility to manage communication between the CAC and Windows. The VO’s DEERS ID is accessed from the CAC, and the VO then enters his or her 6–8 digit PIN to initiate the logon. Under the CAC configuration, RAPIDS begins to establish a Secure Sockets Layer (SSL) session using the VO’s PKI identity certificate and key pair.

1. Insert your CAC into the smart card reader.
   - Result: The Welcome to Windows window opens.

2. Click Ctrl-Alt-Delete to begin.
   - Result: The U.S. DoD Warning Statement opens.

3. Click OK to confirm you have read and understood the U.S. DoD Warning Statement.
   - Result: The VPN Dialer window opens.

4. Click Connect.
5. Click **Continue** to confirm you have read and understood the DoD authorized usage statement in the *VPN Client Banner* window.
   - Result: The *Log On to Windows* window opens.

6. Enter your **6–8 digit PIN**.

**Note:** A new Message of the Day (MOTD) appears in red. A previously read MOTD appears in black. Users can print the MOTD and save it to the workstation. Archived and current MOTDs can be found in the VOIS.

#### 8.2.2 Lock the RAPIDS Workstation

1. Remove the CAC from the VO smart card reader.
   - Result: The screen updates to the default Windows Locked screen.
   - Result: The *Computer Locked* window opens.

#### 8.2.3 Unlock the RAPIDS Workstation

1. Insert the CAC into the VO smart card reader.
   - Result: The *Unlock Computer* window opens.

2. Enter your **PIN** in the PIN field.

3. Click **OK**.
   - Result: The RAPIDS workstation unlocks to the last screen viewed.

#### 8.2.4 Exit the RAPIDS Application

4. Complete the steps necessary to save and close a Sponsor Record.

   **Option 1 (Menu Bar):**
   a. Click **File > Exit**.
      - Result: The RAPIDS application closes to the Windows desktop.

   **Option 2 (Person Viewer)**
   a. Click the **X** in the upper right corner of the RAPIDS application.
      - Result: The RAPIDS application closes to the Windows desktop.

**Note:** If you remove your CAC before the RAPIDS application is completely logged off, the workstation may lock or freeze; please allow the workstation to completely close before removing your CAC.

#### 8.2.5 Log off the RAPIDS Workstation

1. Complete the steps necessary to exit RAPIDS.
   - Result: RAPIDS closes to the Windows desktop.
2. Click Start > Log Off.
   - Result: The Logoff Windows window opens.

3. Click Log Off.

8.3 Performing Basic Functions in RAPIDS

8.3.1 Launch RAPIDS

1. Click OK.
   - Result: The Windows desktop opens.
   - Result: RAPIDS launches automatically.

2. If RAPIDS does not automatically launch, double-click the RAPIDS icon on the Windows desktop to open RAPIDS.
   - Result: Multiple authentications occur.
   - The Verifying Official CAC PIN window opens.

3. Enter your 6–8 digit PIN in the Verifying Official CAC PIN window.

4. Click OK.
   - Result: The application authenticates the VO CAC PIN.
   - Result: The RAPIDS-Logon window opens.

5. Place the appropriate finger (as shown on the primary finger dialog) on the fingerprint scanner when prompted in the RAPIDS-Logon window. The primary fingerprint is defaulted to your right index finger but can vary based on the fingerprint captured during the VO’s card issuance. If the primary fingerprint does not match, you may need to match the secondary fingerprint.
   - Result: RAPIDS authenticates the fingerprint.
   - Result: The Choose a Digital Certificate window opens.

6. Click the Certificate associated with your name and CAC.

7. Click OK.
   - Result: The Choose a Digital Certificate window closes.

8. Read the MOTD.

9. Print the MOTD for later reference.

10. Click Close.
    - Result: The Overview screen of the Person Viewer appears.

8.3.2 Open a Sponsor Record

1. Complete the steps necessary to open the Open Family window.
Option 1 (Menu Bar):
   a. Click **File > Open Family**.
      ▪ Result: The *Open Family* window opens.

Option 2 (Toolbar):
   a. Click the **Open Family** icon.
      ▪ Result: The *Open Family* window opens.

2. In the **Open Family** window:

   Option 1 (Barcode Scanner):
   a. Scan the customer’s 39-bar barcode (found on the back of the ID card).
      ▪ Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

   Option 2 (in the Personal Identifier Section):
   a. Select the **Type of Personal Identifier**. (The default selection is SSN)
   b. Enter the **Customer’s Personal Identifier**.
      ▪ Result: Default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

**Note:** RAPIDS may prompt you to insert the Sponsor’s CAC. If the Sponsor does have his or her CAC, insert it into the CAC reader and click **Yes**. If the Sponsor does not have his or her CAC, click **No**.

3. Verify information in the Overview screen in the Person Viewer.
   a. Verify that the picture in the Person Viewer matches the customer.
   b. Verify that the features listed in the Person Viewer match the customer. These features are—
      – Hair color
      – Eye color
      – Height
      – Weight
   c. Ask customers their address and verify that it matches the address shown in the Person Viewer.

**Note:** Information should be elicited from the customer. The VO should not volunteer information contained in the record to the customer for verification.

4. Update information in the Overview screen in the Person Viewer.
   a. Complete the steps necessary to open the Features tab in the Characteristics view of the Person Viewer in the Overview screen.
   b. Update characteristics using the appropriate drop-down menus, radio buttons, selection menus, and checkboxes.
   c. Save changes to DEERS.
8.3.3 Save Changes to a Record

1. Complete the steps necessary to update the Sponsor record.

   Option 1 (Menu Bar):
   a. Click **File > Save Family to DEERS**.
      ▪ Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

   Option 2 (Toolbar):
   a. Click the **Save Family to DEERS** icon.
      ▪ Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

   **Note:** Once you save a record to DEERS, the record becomes read-only; to make the Sponsor record updatable, click the **Reopen Family** icon in the Toolbar.

8.3.4 Close a Sponsor Record

1. Complete the steps necessary to save the Sponsor record to DEERS.

   Option 1 (Menu Bar):
   a. Click **File > Close Family**.

   Option 2 (Toolbar):
   a. Click the **inside X** in the upper right corner of the RAPIDS application.

8.3.5 Exit RAPIDS

1. Complete the steps necessary to save and close a Sponsor record.

   Option 1 (Menu Bar):
   b. Click **File > Exit**.
      ▪ Result: RAPIDS closes to the Windows desktop.

   Option 2 (Person Viewer):
   b. Click the **X** in the upper right corner of RAPIDS.
      ▪ Result: RAPIDS closes to the Windows desktop.

   **Note:** If you remove your CAC before RAPIDS is completely logged off, the workstation may lock or freeze; please allow the workstation to completely close before removing your CAC.

8.4 Using the RAPIDS Interface

Figure 8.1 is a screenshot of the new RAPIDS 7 user interface. The look and feel of RAPIDS 7 was developed based on usability studies at many RAPIDS issuance sites. Based on user input, the screens were enhanced to fit the needs of the RAPIDS user. The most significant change is the addition of the Person Viewer. The Person Viewer allows a VO to see the highlights of a
person’s record without having to navigate through multiple views. The Person Viewer is available for the sponsor as well as any family member. Simply highlight the person’s name in the Family Tree to see that person’s information in the Person Viewer. There are six different regions of the RAPIDS interface that allow you to perform CAC procedures and record operations in RAPIDS. These regions include—

- Menu Bar
- Toolbar
- Icon Bar
- Family Tree
- Person Viewer
- Information Viewer.

Figure 8.1. Screenshot of RAPIDS 7.3. Person Viewer

8.4.1 Menu Bar
The Menu Bar is a horizontal menu that appears at the top of the RAPIDS window.
The **File Menu** contains options of adding a new family, opening a family, or closing a family in DEERS.

The **Edit Menu** gives the option to cut, copy, and paste information.

The **View Menu** provides the option to view Sponsor and Family Members, Address, Characteristics, Benefits, ID Card, Plans, Coverage Plans, or Service Records.

The **Sponsor Menu** allows users to update characteristics, addresses, personnel records, benefits, and ID card.

The **Family Menu** allows users to add family members, update addresses, create DD forms 1172 and ID cards, and verify family members. POs can lock or unlock a record using this menu.

The **Reports Menu** provides users with a link to the RAPIDS Audit Reports Website where users can generate various reports.

The **Tools Menu** serves as a resource for SSMs and SVOs to update card data and customize workspace preferences.

The **Window Menu** allows users to arrange open windows and icons on the screen.

The **Help Menu** offers RAPIDS help, training resources, Web resources, the MOTD, what’s new, and information about RAPIDS.

### 8.4.2 Toolbar

The Toolbar is directly under the Menu Bar and offers shortcuts for performing common RAPIDS functions, opening useful tools, and accessing helpful resources.

- **New Family**
  The New Family icon opens the New Family navigator and asks for the Sponsor’s identifier (e.g., SSN, FIN). A new family equals a new DEERS record.

- **Open Family**
  The Open Family icon opens the *Open Family* window, which uses the Sponsor’s identifier to access a family’s records in DEERS. An open family represents an existing DEERS record.

- **Reopen Family**
  The Reopen Family icon closes the current family and then reopens the same family.

- **Save Family to Server**
The Save Family to Server icon allows users to save and view changes locally without saving to DEERS.

Save Family to DEERS
The Save Family to DEERS icon saves all changes made to a family’s record in DEERS.

Cut, Copy, and Paste
The Cut, Copy, and Paste icons allow the user to cut, copy, and past information between fields.

Create an ID Card
The Create an ID Card icon opens the Create ID Card wizard.

Create a DD Form
The Create a DD Form icon opens the Create a DD Form wizard.

Verify Family Members
The Verify Family Members icon opens the Verify Family Members wizard.

About
The About icon shows the current RAPIDS version. This information can also be accessed by Help > About.

Click Here for Additional Help
The Click Here for Additional Help (non-context sensitive) icon opens RAPIDS Help.

8.4.3 Icon Bar
There are seven icons in the Icon Bar.

Overview Icon
The Overview icon opens the Overview screen with the selected family member’s information showing.

Address Icon
The Address icon shows the address of the selected family member in the Person Viewer.

Characteristics Icon
The Characteristics icon shows the characteristics of the selected family member in the Person Viewer.
Personnel Status Icon
The Personnel Status icon shows the status of the family member in the Person Viewer.

Relationship Status Icon
The Relationship Status icon shows the relationship status of the selected family member in the Person Viewer.

Benefits Icon
The Benefits icon shows the benefits details of the selected family member in the Person Viewer.

ID Card Icon
The ID Card icon shows the ID card details of the selected family member in the Person Viewer.

8.4.4 Family Tree
The Family Tree is a series of nested folders, similar to the Windows filing system. Clicking the plus sign in front of a record can open or expand the record while displaying it and the icons.

The Sponsor’s and Family Members’ folders are at the top. Each family member has a separate folder under the Family Members folder.

Personnel Record(s) contain the following:

- Personnel or service record stored in DEERS
- Benefits
- ID card(s).

Family Tree Viewer—Sponsor’s Icons

Sponsor’s Folder
The Sponsor’s folder contains information related specifically to the Sponsor.
**Characteristics Icon**

The Characteristics icon accesses features and Sponsor information (e.g., marital status, blood type, organ donor status, DNA sample dates). The information for family members includes features, relationship, relationship condition, and student or incapacitated status.

**Family Tree Viewer—Personnel Record(s) Icons**

- **Personnel Record(s) Folder**
  
The Personnel Record(s) folder contains all of the Sponsors’ current personnel and service records that have been stored in the DEERS database. Attached to each folder are the benefits associated with each record (if multiple records exist, each is assigned a separate folder) and the current associated ID card(s).

- **Personnel Status Icon**
  
The Personnel Status icon accesses the Update Personnel Status area for the selected person (e.g., United States Army Reserve [USAR]).

- **Personnel Status With Condition Icon**
  
The Personnel Status With Condition icon accesses the same information areas as the Personnel Status icon, but it is visually different in order to notify the user of an existing status condition (e.g., USAR on Active Duty).

- **Family Member Folders**
  
The Family Member folders contain the information related to each member of the family, including the Sponsor, spouse, and child.

- **Characteristics Icon**
  
The Characteristics icon accesses features and Sponsor information (e.g., marital status, blood type, organ donor status, DNA sample dates). The information for family members includes features, relationship, relationship condition, and student or incapacitated status.

- **Relationship Status Icon**
  
The Relationship Status icon accesses the Update Relationship Status area for the selected person (e.g., spouse).

- **Relationship Status With Condition Icon**
The Relationship Status With Condition icon accesses the same information areas as the Relationship Status icon, but it is visually different to notify the user of an existing status condition (e.g., spouse overseas).

**Benefits Icon**
The Benefits icon stands for “benefits view for (name).” The icon accesses information such as base privileges, civilian health, direct care, or suspensions.

**ID Card Icon**
The ID Card icon is shown in one of four states: CAC, Teslin card, CAC, and Teslin card or Civilian Retiree card. The icon accesses the selected individual’s previously created card information for the specified record.

### 8.4.5 Person Viewer

The Person Viewer displays the relevant data based on the selections made in the other areas (Family Tree, Icon Bar, etc.). The Overview screen is the default screen in the Person Viewer when a record is opened. There is an Overview screen for each family member. You can access the Overview screen by clicking the Family Member’s folder or name in the Family Tree. The screen displays a photograph and summary of the person’s information, allowing quick identity proofing and easy access to other screens via buttons.

When a photograph of the customer is available in DEERS, it displays in the Overview screen at all times. The Overview screen also has buttons and text that correlate with icons and text in the Family Tree, Menu Bar, and Icon Bar.
Person Viewer—Standard Screen Elements

Usability studies showed that the VO wanted a way to look at customer information without having to click through various screens. The Person Viewer gives the VO to see a “Snapshot” of the record. The Person Viewer has numerous standard elements to help you navigate, review, and update information. For example, a locked icon shows the locked status of a person. Tabs allow you to navigate between grouped areas. Information is displayed in text and graphic format. Section title bars are also shown.

Person Viewer—Wizards

RAPIDS wizards are special pop-up windows that help you complete a step-by-step task.

All steps are listed on the left side of the Wizard window. The current step is highlighted so you can track your progress in the task. You can provide the necessary information on each page and then click the Next button. The Finish button appears after you have completed all steps.

Customizing the Interface

You can customize the size of the three viewers (i.e., Family Tree, Person, and Information) by selecting and dragging the frames or by selecting the Expand and Collapse Frame arrow buttons.

You can also adjust the workstation’s display properties for screen resolution. Right-click your Desktop > select the Settings tab > slide the Screen Resolution bar. The optimal screen resolution setting is 1152x864 for limited scrolling in RAPIDS.
ITEMS TO REMEMBER

• To adjust your workstation’s screen resolution:

1. Right-click your **Workstation’s Desktop**.

2. Select **Properties**.
   - Result: *Display Properties* window appears.

3. Click the **Settings** tab in the *Display Properties* window. Move the screen resolution slider to the desired resolution.

### 8.4.6 Information Viewer

The Information Viewer consists of a series of tabs and provides the VO with a variety of information and support.

- **Instructions Tab**
  The Instructions tab displays basic instructions and directions (in green text) for each RAPIDS screen.

- **Definition Tab**
  The Definition tab replaces the Instructions tab and shows additional information when the cursor rolls over definition hypertext.

- **Error/Warning Tab**
  The Error tab alerts the user by displaying an error message when the user fails to enter data correctly.

  The Warning tab replaces the Error tab and displays any warnings only when no errors present.

- **Task Tab**
  The Task tab displays your most recent tasks.

- **Confirmation Tab**
  The Confirmation tab shows the confirmation status of the sponsor’s record, as shown below. Confirmation status is obtained when a Master record source such as a service feed, Contractor Verification System (CVS), or Civilian Master feed sends confirmed information to DEERS/RAPIDS. The four confirmation status levels are—
  
  • Confirmed
8.5 Navigating to the Create ID Card Wizard Using RAPIDS

RAPIDS users can navigate to the Create ID Card wizard using five different components of the user interface.

8.5.1 Navigate to the Create ID Card Wizard Using the Menu Bar

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: Default state of the Overview screen with the Sponsor’s information in the Person Viewer appears.

2. Click Sponsor > ID Card > Create.
   - Result: The Create ID Card wizard opens.

8.5.2 Navigate to the Create ID Card Wizard Using the Toolbar

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: Default state of the Overview screen with the Sponsor’s information in the Person Viewer appears.

2. Click the Create an ID Card icon in the Toolbar.
   - Result: The Create ID Card wizard opens.
8.5.3 Navigate to the Create ID Card Wizard Using the Family Tree

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: Default state of the Overview screen with the Sponsor’s information in the Person Viewer appears.

2. Right-click the ID Card(s) icon > Create.
   - Result: The Create ID Card wizard opens.

8.5.4 Navigate to the Create ID Card Wizard Using the Person Viewer

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: Default state of the Overview screen with the Sponsor’s information in the Person Viewer appears.

2. Click the ID Card(s) button in the Person Viewer.
   - Result: ID Card view in the Person Viewer.

3. Click the View Card tab.
   - Result: The View Card tab becomes active.
4. Click Create ID Card.
   - Result: The Create ID Card wizard opens.

8.5.5 Navigate to the Create ID Card Wizard Using the Icon Bar

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: Default state of the Overview screen with the Sponsor’s information in the Person Viewer appears.

2. Click the ID Card icon.
   - Result: ID Card view in the Person Viewer appears.

3. Click the View Card tab.
   - Result: The View Card tab becomes active.

4. Click Create ID Card.
   - Result: The Create ID Card wizard opens.
Create ID Card

Current Task: Creating an ID Card

Which Cards Need to be Added?

- Full Name (Cards)  Category  Condition  Type  Condition  Begin Date  End Date
- Joe Smith, Jr...  Retired  NONE  Spouse  NONE  2003/03/03  INDUP
- Jane Doe       Retired  NONE  Spouse  PMS  2003/03/01  INDUP

Select All  View Benefit Details

Select the ID card(s) you wish to create.
Using the RAPIDS 7.3 Application

8.6 ID CARD OPERATIONS—CAC

8.6.1 Unlock a CAC/Reset a PIN

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   ▪ Result: Default state of the Overview screen with the Sponsor’s information in the Person Viewer appears.

2. Insert the customer’s CAC into the customer card reader.

3. Click Yes to confirm you want to unlock the CAC/reset the PIN.
   ▪ Result: The Warning window opens.

4. Click Yes to accept the security warning.
   ▪ Result: A second Warning window opens.

5. Click OK to accept the warning.
   ▪ Result: Default state of the Overview screen with the Sponsor’s information in the Person Viewer appears.

6. Open the RAPIDS - Unlock/Reset a CAC wizard.

   Option 1 (Menu Bar):
   a. Click Sponsor > ID Card > Unlock PIN.
      ▪ Result: The RAPIDS - Unlock/Reset a CAC wizard opens.

   Option 2 (Family Tree):
   a. Click ID Card(s).
      ▪ Result: The View Card tab opens in the Person Viewer.
   b. Click the Card Details tab.
      ▪ Result: The Card Details tab opens in the Person Viewer.
   c. Click Unlock/Reset PIN.
      ▪ Result: The RAPIDS - Unlock/Reset a CAC wizard opens.

   Option 3 (Family Tree):
   a. Right-click ID Card(s) > Unlock/Reset CAC > Sponsor ID Card.
      ▪ Result: The RAPIDS - Unlock/Reset a CAC wizard opens.

   Option 4 (Icon Bar):
   a. Click the ID Card icon.
      ▪ Result: The View Card tab opens in the Person Viewer.
   b. Click the Card Details tab.
      ▪ Result: The Card Details tab opens in the Person Viewer.
   c. Click Unlock/Reset PIN.
      ▪ Result: The RAPIDS - Unlock/Reset a CAC wizard opens.
Option 5 (Person Viewer):
  a. Click **ID Card(s)**.
     - Result: The View Card tab opens in the Person Viewer.
  b. Click the **Card Details** tab.
     - Result: The Card Details tab opens in the Person Viewer.
  c. Click **Unlock/Reset PIN**.
     - Result: The *RAPIDS - Unlock/Reset a CAC* wizard opens.

7. To ensure that the CAC is issued to the person who we know in DEERS, RAPIDS requires a fingerprint match. Without a successful fingerprint match, a CAC may not be unlocked nor can the PIN be reset. A fingerprint match will help verify that the customer is who they say they are. Click **Match** in the Primary Fingerprints area of the *RAPIDS - Unlock/Reset a CAC* wizard.
   - Result: The *RAPIDS - Match Primary Fingerprint* wizard opens.

8. Instruct the Sponsor to place his or her fingerprint on the fingerprint platen.
   - Result: Fingerprints match, and the *RAPIDS - Match Primary Fingerprint* wizard closes.

9. Click **Match** in the Secondary Fingerprints area of the *Unlock/Reset a CAC* wizard.
   - Result: The *RAPIDS - Match Secondary Fingerprint* wizard opens.

10. Instruct the Sponsor to place his or her fingerprint on the fingerprint platen.

11. Click **Next**.
    - Result: The *RAPIDS - Unlock/Reset a CAC* wizard advances to the Unlock/Reset PIN task.

12. Click **Unlock/Reset**.
    - Result: The *RAPIDS - Unlock/Reset a CAC* wizard advances to the Unlock/Reset PIN Progress task.
    - Result: The *RAPIDS - Capture PIN* window opens.

13. Instruct the Sponsor to enter a **6–8 digit PIN** using the numeric keypad.

14. Instruct the Sponsor to confirm his or her 6–8 digit PIN using the numeric keypad.

15. Click **OK**.
    - Result: The *RAPIDS - Capture PIN* window closes.
    - Result: The *RAPIDS - Unlock/Reset a CAC* wizard advances to the Unlock/Reset PIN Status task.

16. Click **Next**.
17. Click **Finish**.
   - Result: The *RAPIDS - Unlock/Reset a CAC* wizard closes.

18. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor’s record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.6.2 Issue a new CAC to an Active Duty service member

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: Default state of the Overview screen with the Sponsor’s information in the Person Viewer appears.

2. Open the *Create ID Card* wizard.
   - Option 1 (Toolbar):
     a. Click the **Create an ID Card** icon on the Toolbar.
     
        - Result: The *Create ID Card* wizard opens.
   - Option 2 (File Menu):
     a. Click **Sponsor > ID Card > Create**.
     
        - Result: The *Create ID Card* wizard opens.
   - Option 3 (Right-Click Family):
     a. Right-click the **ID Card** icon > **Create**.
     
        - Result: The *Create ID Card* wizard opens.
   - Option 4 (Person Viewer):
     a. Click **ID Card(s)**.
     
        - Result: ID Card view in the Person Viewer.
     b. Click the **View Card** tab.
     
        - Result: The View Card tab becomes active.
     c. Click **Create ID Card**.
     
        - Result: The *Create ID Card* wizard opens.
   - Option 5 (Icon Bar):
     a. Click the **ID Card** icon.
     
        - Result: ID Card view in the Person Viewer.
     b. Click the **View Card** tab.
     
        - Result: The View Card tab becomes active.
     c. Click **Create ID Card**.
     
        - Result: The *Create ID Card* wizard opens.

3. Click the **ID Card** checkbox.
Note: You can view the customer’s benefits details by completing the following steps (a–c):

a. Click **View Benefit Details**.
   - Result: The *RAPIDS - Benefit Details* window opens.

b. Verify Sponsor’s benefits in the *RAPIDS - Benefit Details* window.

c. Click **Close**.
   - Result: *RAPIDS - Benefit Details* window closes.

4. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Generate ID Card task.
   - Result: The *Create ID Card* wizard advances to the Get List of ID Cards to Terminate task.
   - Result: The *Create ID Card* wizard advances to the Terminate Previous task.

5. Collect the customer’s primary and secondary proof of identity documents.

6. Select a reason for termination in the Why Is This Previous ID Card Being Terminated? area.

Note: A CAC only must be terminated if the Sponsor has previously been issued a CAC.

7. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the View Terminated task.

Note: If the Sponsor has never been issued a CAC or the CAC has already been terminated, the View Terminated task is skipped.

8. Locate the return code in the View Terminated task in the *Create ID Card* wizard and write it on the terminated CAC with a permanent black marker.

Note: The terminated CAC must be returned to the DSC.

9. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Send Terminated ID Card to DEERS task.
   - Result: The *Create ID Card* wizard advances to the Adjust Card Dates task.

10. Use the arrows to select the ID card date range.

11. Click **Next**.
    - Result: The *Create ID Card* wizard updates to the Select Primary Proof of Identity task.

12. Ask the Sponsor for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.
   ▪ Result: Fields in the Document Details area adjust according to the document type.

14. Place the Sponsor’s primary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

15. Click **Scan** in the **Create ID Card** wizard.
   ▪ Result: The **RAPIDS - Scan Document** window opens.

16. Click **Preview Scanned Document** in the **RAPIDS - Scan Document** window.
   ▪ Result: RAPIDS scans the primary proof of identity document.

17. Use the horizontal and vertical scroll bars in the **RAPIDS - Scan Document** window to verify that the document image contains the document’s identity numbers.

18. Click **OK**.
   ▪ Result: The **RAPIDS - Scan Document** window closes.

19. Remove the primary proof of identity document from the scanner.

In the Document Details area of the Select Primary Proof of Identity task of the **Add Family** wizard—

20. Enter the **Document Serial/Identity Number**.

21. Enter the **Document Issue Date**.

22. Enter the **Document Expiration Date**.

23. Enter the **Country of Issuance**.

24. Select the **State/Province of Issuance**.

25. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Primary Proof of Identity task will not be available or present on the family member’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

26. Give the primary proof of identity document back to the Sponsor.

27. Click **Next**.
   ▪ Result: The **Create ID Card** wizard advances to the Secondary Proof of Identity task.
28. Ask the Sponsor for his or her secondary proof of identity and complete the steps necessary to verify the document’s authenticity.

   - Result: Fields in the Document Details area adjust accessibility according to the document type.

30. Place the Sponsor’s secondary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

31. Click **Scan** in the *Create ID Card* wizard.
   - Result: The *RAPIDS - Scan Document* window opens.

32. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
   - Result: RAPIDS scans the secondary proof of identity document.

33. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

34. Click **OK**.
   - Result: The *RAPIDS - Scan Document* window closes.

35. Remove the secondary proof of identity document from the scanner.

In the Document Details area of the Select Secondary Proof of Identity task of the *Create ID Card* wizard—

36. Enter the **Document Serial/Identity Number**.

37. Enter the **Document Issue Date**.

38. Enter the **Document Expiration Date**.

39. Enter the **Country of Issuance**.

40. Select the **State/Province of Issuance**.

41. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Secondary Proof of Identity task will not be available or present on the family member’s proof of identity. When this information is unavailable, leave the fields blank. Give the secondary proof of identity document back to the Sponsor. Certain fields in the Document
Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

42. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Select Proof of Identity task.
   - Result: The *Create ID Card* wizard advances to the Capture Biometrics task.
   - Result: The *RAPIDS - Capture Photo* window opens.

43. In the *RAPIDS - Capture Photo* window, use the Movement and Zoom controls to frame the picture.

44. Click **Capture Picture**.
   - Result: Picture of customer appears in *RAPIDS - Capture Photo* window.

45. Verify quality of picture. In the *RAPIDS - Capture Photo* window, use the Brightness and Contrast controls to improve the quality of the picture.

46. Click **OK**.
   - Result: The *RAPIDS - Capture Photo* window closes.

47. When the *RAPIDS - Match Primary Fingerprint* window opens, ask customer to identify his or her primary hand and place his or her primary finger on the fingerprint scanner to match the fingerprint.
   - Result: Fingerprint matches.
   - Result: The *RAPIDS - Match Primary Fingerprint* window closes.
   - Result: The *Create ID Card* wizard advances to the Capture Biometrics view.
   - Result: The *Create ID Card* wizard advances to the Creating a Fingerprint and Picture for the ID Card task.

48. Verify the results in the *Creating a Fingerprint and Picture for the ID Card* window.
   a. Photograph matches the customer.
   b. Fingerprints are on file.

49. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Print Preview task.

50. Carefully review the front view and back view of this card to ensure all information on the card is accurate, including—
   a. Issue date
   b. Expiration date
   c. Spelling of the name.

**Note:** At this point, no changes can be made to the card.

51. Click **Print ID Card**.
   - Result: RAPIDS locates a printer.
   - Result: The *RAPIDS TOPPAN CP* window shows while print is in progress.
- Result: The ID card prints.
- Result: The Create ID Card wizard advances to the Print Correctly? task.

52. Remove the CAC from the printer.

53. Review the CAC to ensure—
   a. Card is of good print quality.
   b. Photo can be used to identify the person.
   c. Barcodes are clear.
   d. Text is legible.

If the CAC is acceptable—

54. Click Yes.

55. Click Next.
   - Result: The RAPIDS - Scan ID Card window opens.

56. Scan the 39-code barcode.

57. Click Next.
   - Result: The Encode CAC task becomes active.

Note: If the ID card is unacceptable, complete steps a–f below:

   a. Click No Failed if the ID card is unacceptable.
   b. In the Create ID Card wizard, complete the Print Correctly task; in the Print Status section, click the No radio button if the ID card is unacceptable.
   c. Select the Reason for Failure in the reason for failure field.
   d. Click Next.
      - Result: The Create ID Card wizard returns to the Capture Biometrics task.
   e. Recapture biometrics, and complete the Capture Biometrics task.
   f. Scan the barcode on the newly printed card.

58. Insert the newly printed CAC into the customer card reader.

59. Inform the customer that he or she should begin thinking about a 6–8 digit PIN number for the new CAC.

60. Click Encode.
   - Result: The Create ID Card wizard advances to the Encode CAC task, and encoding begins.
   - Result: Obtain chip ID.
   - Result: Submit request for encoding.
   - Result: Customize card for DoD.
   - Result: Populate core DoD Applets.
   - Result: Verify PIV Applets.
- Result: View ID certificate.
- Result: View e-mail signing certificate
- Result: View e-mail encryption certificate
- Result: The RAPIDS - Capture PIN window opens.
  
  a. Ask the customer to enter his or her 6–8 digit PIN.
  - Result: Encrypted PIN numbers appear in Enter PIN field in the RAPIDS - Capture PIN window.
  b. Ask the customer to confirm his or her 6–8 digit PIN.
  - Result: Encrypted PIN numbers appear in Confirm PIN field in the RAPIDS - Capture PIN window.
  c. Click OK.
  - Result: The system completes Encode CAC Status task.

61. Click Next.
  - Result: The Create ID Card wizard advances to the Generate DD Form 2842 task.

62. Review the Certificate Acceptance Form with the customer; when the review is complete, click Sign Form.

63. Ask the customer to enter and confirm his or her 6–8 digit PIN.

64. Click OK.
  - Result: The Create ID Card wizard advances to the Read CHUID task.

65. Remove the recipient’s CAC from the contactless card reader and place it on top of the reader.

66. Click Read CHUID.
  - Result: The For Your Information window confirms the CHUID is successfully read.

67. Click OK.

68. Review the Summary results.

69. Click Finish.
  - Result: The Create ID Card wizard closes.

70. Give the new CAC to the Sponsor.

8.6.3 Update a CAC

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
  - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Update ID Card wizard.
Option 1 (Menu Bar):
   a. Click **Sponsor > ID Card > Update**.
      ▪ Result: The *Update ID Card* wizard opens to the Select Cards to Update task.

Option 2 (Menu Bar):
   a. Click **View > ID Card > Update**.
      ▪ Result: The *Update ID Card* wizard opens to the Select Cards to Update task.

Option 3 (Icon Bar):
   a. Click the **ID Card** icon.
      ▪ Result: The ID Card view in the Person Viewer opens.
   b. Click the **Card Details** tab.
      ▪ Result: The Card Details tab becomes active.
   c. Click **Update** in ID Card view in the Person Viewer.
      ▪ Result: The *Update ID Card* wizard opens to the Select Cards to Update task.

Option 4 (Family Tree):
   a. Right-click **ID Card(s)**.
      ▪ Result: The ID Card(s) right-click menu opens.
   b. Click **Update > Name of CAC**.
      ▪ Result: The *Update ID Card* wizard opens to the Select Cards to Update task.

Option 5 (Family Tree):
   a. Click **ID Card(s)**.
      ▪ Result: The ID Card view in the Person Viewer opens.
   b. Click the **Card Details** tab.
      ▪ Result: The Card Details tab becomes active.
   c. Click **Update** in ID Card view in the Person Viewer.
      ▪ Result: The *Update ID Card* wizard opens to the Select Cards to Update task.

Option 6 (Toolbar):
   a. Click **Update CAC**.
      ▪ Result: The *Update ID Card* wizard opens.
   b. Click the **Card Details** tab.
      ▪ Result: The Card Details tab becomes active.
   c. Click **Update** in ID Card view in the Person Viewer.
      ▪ Result: The *Update ID Card* wizard opens to the Select Cards to Update task.

Option 7 (Person Viewer):
   a. Click **ID Card(s)**.
      ▪ Result: The ID Card view in the Person Viewer opens.
   b. Click the **Card Details** tab.
      ▪ Result: The Card Details tab becomes active.
   c. Click **Update** in ID Card view in the Person Viewer.
      ▪ Result: The *Update ID Card* wizard opens to the Select Cards to Update task.
3. Click the **ID Card** checkbox.

4. Click **Next**.
   - Result: The *Update ID Card* wizard task list advances to the Update CAC task.

5. Insert the customer’s CAC into the customer card reader.

6. Click **Update**.
   - Result: The *Card Recipient PIN* window opens.

7. Ask the customer to enter and confirm his or her 6–8 digit PIN.

8. Click **OK**.
   - Result: The *Update ID Card* wizard task list advances to the Encode CAC Progress task.
   - Result: The *Update ID Card* wizard task list advances to the Update CAC Status task.

9. Click **Next**.
   - Result: The *Update ID Card* wizard task list advances to the Save ID Card task.
   - Result: The *Update ID Card* wizard task list advances to the Summary task.

10. Click **Finish**.
    - Result: The Sponsor record reloads.
    - Result: The CAC is updated.
    - Result: The *Update ID Card* wizard closes.
    - Result: The default state of the Overview screen displays in the Person Viewer and the Sponsor’s folder displays in the Family Tree.

**8.6.4 Check whether a certificate is encoded on a CAC**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the *View Certificates on Card* window.

   **Option 1 (Family Tree):**
   a. Click **ID Card(s)**.
      - Result: The ID Card view in the Person Viewer displays.
   b. Click the **Card Details** tab in the Person Viewer.
      - Result: The Card Details view in the Person Viewer displays.
   c. Click **View Certs** in the Current Certificates area.
      - Result: The *View Certificates on Card* window opens.

   **Option 2 (Icon Bar):**
   a. Click the **ID Card** icon.
3. Use the drop-down menu to select a Certificate Type.

4. Click Read Data From Card in the View Certificates on Card window to view certificates from the ID card.
   - Result: The View Certificates on Card window shows the issuer, serial number, expiration date, issue date, and e-mail address.

Note: You must click Read Data From Card to view the certificates encoded on the ID card in the View Certificates on Card window.

![Image of View Certificates on Card window]

**8.6.5 Manually terminate an ID card**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Terminate ID Card wizard.
Option 1 (Menu Bar):
   a. Click Sponsor > ID Card > Terminate > Sponsor ID Card.
      ▪ Result: The Terminate ID Card wizard opens.

Option 2 (Menu Bar):
   a. Click View > ID Card.
      ▪ Result: The ID card information displays in the Person Viewer.
   b. Click Terminate ID Card.
      ▪ Result: The Terminate ID Card wizard opens.

Option 3 (Family Tree):
   a. Right-click the ID Card(s) icon > Terminate > Sponsor ID Card.
      ▪ Result: The Terminate ID Card wizard opens.

Option 4 (Family Tree):
   a. Click the ID Card(s) icon.
      ▪ Result: The ID card information displays in the Person Viewer.
   b. Click Terminate ID Card.
      ▪ Result: The Terminate ID Card wizard opens.

Option 5 (Person Viewer):
   a. Click ID Card(s).
      ▪ Result: The ID card information displays in the Person Viewer.
   b. Click Terminate ID Card.
      ▪ Result: The Terminate ID Card wizard opens.

Option 6 (Person Viewer):
   a. Click the Sponsor ID Card.
      ▪ Result: The ID card information displays in the Person Viewer.
   b. Click Terminate ID Card.
      ▪ Result: The Terminate ID Card wizard opens.

Option 7 (Icon Bar):
   a. Click the ID Card icon.
      ▪ Result: The ID card information displays in the Person Viewer.
   b. Click Terminate ID Card.
      ▪ Result: The Terminate ID Card wizard opens.

3. Select the Reason for Termination in the Why is the Existing ID Card Being Terminated? area.

4. Click Next.

Note: In some cases, the Need More Information window appears. If more information is needed, select the appropriate option.
5. Click Finish.
   - Result: The Terminate ID Card wizard closes.

**Note:** Terminated relationships, personnel categories, and ID cards are shown in red text.

### 8.7  ID CARD OPERATIONS—TESLIN

#### 8.7.1  Issue a Teslin card to a Retired Sponsor

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Create ID Card wizard.

   **Option 1 (Toolbar):**
   a. Click the **Create an ID Card** icon on the Toolbar.
      - Result: The Create ID Card wizard opens.

   **Option 2 (File Menu):**
   a. Click **Sponsor > ID Card > Create**.
      - Result: The Create ID Card wizard opens.

   **Option 3 (Right-Click Family):**
   a. Right-click the **ID Card** icon > **Create**.
      - Result: The Create ID Card wizard opens.

   **Option 4 (Person Viewer):**
   a. Click **ID Card(s)**.
      - Result: ID Card view in the Person Viewer.
   b. Click the **View Card** tab.
      - Result: The View Card tab becomes active.
   c. Click **Create ID Card**.
      - Result: The Create ID Card wizard opens.
Option 5 (Icon Bar):
   a. Click the **ID Card** icon.
      ▪ Result: ID Card view in the Person Viewer.
   b. Click the **View Card** tab.
      ▪ Result: The View Card tab becomes active.
   c. Click **Create ID Card**.
      ▪ Result: The *Create ID Card* wizard opens.
   d. Click the **ID Card** checkbox.

**Note:** View the customer’s benefits details by completing the following steps (a–d):

   a. Click the **View Benefit Details** button.
      ▪ Result: The *RAPIDS - Benefit Details* window opens.
   b. Verify the Sponsor’s benefits in the *RAPIDS - Benefit Details* window.
   c. Click **Close**.
      ▪ Result: *RAPIDS - Benefit Details* window closes.
   d. Click **Next**.
      ▪ Result: The *Create ID Card* wizard advances to the Generate ID Card task.
      ▪ Result: The *Create ID Card* wizard advances to the Get List of ID Cards to Terminate task.
      ▪ Result: The *Create ID Card* wizard advances to the Terminate Previous task.

3. Collect the customer’s primary and secondary proof of identity documents.

4. Select a **Reason for Termination** in the Why Is This Previous ID Card Being Terminated? area.

**Note:** A Teslin Card only must be terminated if the Sponsor has previously been issued a Teslin Card.

5. Click **Next**.
   ▪ Result: The *Create ID Card* wizard advances to the View Terminated task.

6. Locate the return code in the View Terminated task in the *Create ID Card* wizard and write it on the terminated Teslin with a permanent black marker.

**Note:** The terminated Teslin Card must be returned to the DSC.

7. Click **Next**.
   ▪ Result: The *Create ID Card* wizard advances to the Send Terminated ID Card to DEERS task.
   ▪ Result: The *Create ID Card* wizard advances to the Adjust Card Dates task.

8. Click **Next**.
   ▪ Result: The *Create ID Card* wizard updates to the Primary Proof of Identity task.
9. Ask the Sponsor for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.

10. Select a **Primary Proof of Identity** document type in the Identity Document Selection area.
   - Result: Fields in the Document Details area adjust according to the document type.

11. Ask the Sponsor for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.

12. Place the Sponsor’s primary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

13. Click **Scan** in the *Create ID Card* wizard.
   - Result: The *RAPIDS - Scan Document* window opens.

14. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
   - Result: RAPIDS scans the primary proof of identity document.

15. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

16. Click **OK**.
   - Result: The *RAPIDS - Scan Document* window closes.

17. Remove the primary proof of identity document from the scanner.

In the Document Details area of the Select Primary Proof of Identity task of the *Create ID Card* wizard—

18. Enter the **Document Serial/Identity Number**.

19. Enter the **Document Issue Date**.

20. Enter the **Document Expiration Date**.

21. Enter the **Country of Issuance**.

22. Select the **State/Province of Issuance**.

23. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Primary Proof of Identity task will not be available or present on the family member’s proof of identity document. When this information is unavailable, leave the fields blank. Certain
fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

24. Give the primary proof of identity document back to the Sponsor.

25. Click Next.
   - Result: The Create ID Card wizard advances to the Secondary Proof of Identity task.

26. Ask the Sponsor for his or her secondary proof of identity and complete the steps necessary to verify the document’s authenticity.

   - Result: Fields in the Document Details area adjust accessibility according to the document type.

28. Place the Sponsor’s secondary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

29. Click Scan in the Create ID Card wizard.
   - Result: The RAPIDS - Scan Document window opens.

30. Click Preview Scanned Document in the RAPIDS - Scan Document window.
   - Result: RAPIDS scans the secondary proof of identity document.

31. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

32. Click OK.
   - Result: The RAPIDS - Scan Document window closes.

33. Remove the secondary proof of identity document from the scanner.

In the Document Details area of the Select Secondary Proof of Identity task of the Create ID Card wizard—

34. Enter the Document Serial/Identity Number.

35. Enter the Document Issue Date.

36. Enter the Document Expiration Date.

37. Enter the Country of Issuance.

38. Select the State/Province of Issuance.
39. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Secondary Proof of Identity task will not be available or present on the family member’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

40. Give the secondary proof of identity back to the Sponsor.

41. Click **Next**.
   - Result: System completes the Select Proof of Identity task.
   - Result: The system updates the ID card.
   - Result: The *Create ID Card* wizard advances to the Capture Biometrics task.

42. Click **Capture Picture**.
   - Result: Picture of customer appears in *RAPIDS - Capture Photo* window.

43. Verify quality of picture. In the *RAPIDS - Capture Photo* window, use the Brightness and Contrast controls to improve the quality of the picture.

44. Click **OK**.
   - Result: The *RAPIDS - Match Primary Fingerprint* window opens.

45. When the *RAPIDS - Match Primary Fingerprint* window opens, ask customer to identify his or her primary hand and place his or her primary finger on the fingerprint scanner to match the fingerprint.
   - Result: Fingerprints match.
   - Result: The *RAPIDS - Match Primary Fingerprint* window closes.
   - Result: The *RAPIDS - Match Secondary Fingerprint* window opens.

46. When the *RAPIDS - Match Secondary Fingerprint* window opens, ask customer to identify his or her secondary hand and place his or her secondary finger on the fingerprint scanner to match the fingerprint.
   - Result: Fingerprints match.
   - Result: The *RAPIDS - Match Secondary Fingerprint* window closes.

47. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Prepare for Printing task.

48. Click **Next**.
   - Result: The task list updates to the Print Preview step.

49. Carefully review the front view and back view of this card to ensure all information on the card is accurate, including—
   a. Issue date.
   b. Expiration date.
c. Spelling of the name.

Note: At this point, no changes can be made to the card.

50. Click **Print ID Card**.
   - Result: RAPIDS locates a printer.
   - Result: RAPIDS locates a printer.
   - Result: RAPIDS sends the ID card to the printer.

51. When the printer has finished printing the front side of DD Form 2 (RET), place the cardstock in the printer’s multipurpose tray, blank side face up, with the top edge toward the printer and the left side aligned with the left guide.
   - Result: The *Print the Back Side of the ID Card* window opens.

52. When the printer has finished printing the back side of DD Form 2, remove the cardstock from the printer, turn the cardstock over so the blank side is facing up, and return it to the multipurpose tray with the top edge toward the printer.

53. Click **OK**.

54. Verify results of front view and back view of ID card.
   - Result: The *Create ID Card* wizard advances to the Sign and Laminate task.

55. Complete the Sign and Laminate step.

56. Prepare ID card for (customer’s name).

57. Instruct the customer to sign the card with black, blue-black, or blue ink.

58. Remove excess cardstock from around the Teslin card.

59. Insert the card into the laminator with the face inserted so that the hologram is on the front/face side of the card and the short edge inserted first.

60. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Print Correctly? task.

61. Review the Teslin card to ensure—
   a. Card is of good print quality.
   b. Photo can be used to identify the person.
   c. Barcodes are clear.
   d. Text is legible.

62. If the Teslin card is acceptable, click **Yes**.

Note: If the Teslin card is unacceptable, complete steps a–c below:
a. Click **No Failed** in the Printing Status area.
b. Select the **Reason for Failure** in the Reason for Failure field.
c. Click **Next**.
   - Result: The Create ID Card wizard advances to the Save ID Card task.
   - Result: The Create ID Card wizard advances to the Generate ID Card task.
   - Result: The Create ID Card wizard advances to the Prepare for Printing task.

63. Click **Next**.
   - Result: The Create ID Card wizard advances to the Print Correctly? task.

64. Scan the 39-code barcode.
   - Result: The Create ID Card wizard advances to the Summary task.

65. Review the Summary results.

66. Click **Finish**.
   - Result: The Create ID Card wizard closes.

67. Give the Teslin card to the Sponsor.

### 8.7.2 Issue a temporary ID card to a family member

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Create ID Card wizard.

Option 1 (Toolbar):
   a. Click the **Create an ID Card** icon on the Toolbar.
      - Result: The Create ID Card wizard opens.

Option 2 (File Menu):
   a. Click **Sponsor > ID Card > Create**.
      - Result: The Create ID Card wizard opens.

Option 3 (Right-Click **Family**):
   a. Right-click the **ID Card(s)** icon > **Create**.
      - Result: The Create ID Card wizard opens.

Option 4 (Person Viewer):
   a. Click **ID Card(s)**.
      - Result: The ID Card view in the Person Viewer shows.
   b. Click the **View Card** tab.
      - Result: The View Card tab becomes active.
   c. Click **Create ID Card**.
      - Result: The Create ID Card wizard opens.
Option 5 (Icon Bar):

a. Click the **ID Card** icon.
   - Result: The ID Card view in the Person Viewer shows.

b. Click the **View Card** tab.
   - Result: The View Card tab becomes active.

c. Click **Create ID Card**.
   - Result: The Create ID Card wizard opens.

4. Click the **Temporary ID Card** checkbox next to the family member’s name.

**Note:** You can view the customer’s benefits details by completing the following steps (a–c):

a. Click **View Benefit Details**.
   - Result: The RAPIDS - Benefit Details window opens.

b. Verify benefits in the RAPIDS - Benefit Details window.

c. Click **Close**.
   - Result: The RAPIDS - Benefit Details window closes.

5. Click **Next**.
   - Result: The Create ID Card wizard advances to the Generate ID Card task.
   - Result: The Create ID Card wizard advances to the Get List of ID Cards to Terminate task.
   - Result: The Create ID Card wizard advances to the Adjust Card Dates task.

6. Enter the **ID Card Date Range**.

**Note:** Changing the default expiration date range forces you to choose a reason for this change. An example of such a reason is “awaiting Sponsor verification.”

7. Click **Next**.
   - Result: The Create ID Card wizard advances to the Primary Proof of Identity task.

8. Ask the family member for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.

   - Result: Fields in the Document Details area adjust according to the document type.

10. Ask the family member for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.

11. Place the family member’s primary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-
right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

12. **Click** Scan in the *Create ID Card* wizard.  
   - Result: The *RAPIDS - Scan Document* window opens.

13. **Click** Preview Scanned Document in the *RAPIDS - Scan Document* window.  
   - Result: RAPIDS scans the primary proof of identity document.

14. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

15. **Click** OK.  
   - Result: The *RAPIDS - Scan Document* window closes.

16. Remove the primary proof of identity document from the scanner.

In the Document Details area of the Select Primary Proof of Identity task of the *Create ID Card* wizard—

17. Enter the **Document Serial/Identity Number**.

18. Enter the **Document Issue Date**.

19. Enter the **Document Expiration Date**.

20. Enter the **Country of Issuance**.

21. Select the **State/Province of Issuance**.

22. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Primary Proof of Identity task will not be available or present on the family member’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

23. Give the primary proof of identity document back to the family member.

24. **Click** Next.  
   - Result: The *Create ID Card* wizard advances to the Secondary Proof of Identity task.

25. Ask the family member for his or her secondary proof of identity and complete the steps necessary to verify the document’s authenticity.
   - Result: Fields in the Document Details area adjust accessibility according to the document type.

27. Place the family member’s secondary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

28. Click **Scan** in the *Create ID Card* wizard.
   - Result: The *RAPIDS - Scan Document* window opens.

29. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
   - Result: RAPIDS scans the secondary proof of identity document.

30. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

31. Click **OK**.
   - Result: The *RAPIDS - Scan Document* window closes.

32. Remove the secondary proof of identity document from the scanner.

In the Document Details area of the Select Secondary Proof of Identity task of the *Create ID Card* wizard—

33. Enter the **Document Serial/Identity Number**.
34. Enter the **Document Issue Date**.
35. Enter the **Document Expiration Date**.
36. Enter the **Country of Issuance**.
37. Select the **State/Province of Issuance**.
38. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Secondary Proof of Identity task will not be available or present on the family member’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

39. Give the secondary proof of identity document back to the family member.
40. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Capture Biometrics task.
   - Result: The *RAPIDS - Capture Photo* window opens.

41. Use the Movement and Zoom controls to frame the picture.

42. Click **Capture Picture**.
   - Result: Picture of customer appears in *RAPIDS - Capture Photo* window.

43. Verify quality of picture. In the *RAPIDS - Capture Photo* window, use the Brightness and Contrast controls to improve the quality of the picture.

44. Click **OK**.
   - Result: The *RAPIDS - Capture Primary Fingerprint* window opens.

45. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Update ID Card task.
   - Result: The *Create ID Card* wizard advances to the Prepare for Printing task.

46. Verify the information on the Prepare for Printing task for accuracy.

47. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Print Preview task.

48. Determine whether a dual status overstamp is required and select the appropriate radio button.

49. Determine whether the family member’s SSN needs to be printed on the ID card and check or uncheck the Do not print SSN checkbox.

50. Click **Print ID Card**.
   - Result: The *Create ID Card* wizard advances to the Print ID Card task.

51. When the printer has finished printing the front side of the DD Form, place the cardstock in the printer’s multipurpose tray, blank side face up, with the top edge toward the printer and the left side aligned with the left guide. Click **OK**.
   - Result: The *Create ID Card* wizard advances to the Sign and Laminate task.

52. Instruct the family member to sign the card with black, blue-black, or blue ink.

53. Laminate the card. Remove the excess cardstock from around the Teslin card. Insert the card with the face inserted so that the hologram is on the front/face side of the card. Insert the card into the laminator with the short edge inserted first.

54. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Print Correctly? task.
55. Verify the information on the Print Correctly? task for accuracy.

56. Click Yes in the Did the ID Card Print Correctly? area.
   - Result: The Create ID Card wizard advances to the Print Correctly? task.

57. Scan the Code 39 barcode.
   - Result: The Create ID Card wizard advances to the Save ID Card task.
   - Result: The Create ID Card wizard advances to the Summary task.

58. Review the Summary task for accuracy.
   - Result: The Create ID Card wizard advances to the Summary task.

59. Click Finish.
   - Result: The Create ID Card wizard closes.

60. Click the Save Family to DEERS icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.7.3 Issue a Teslin Card to a Merchant Marine Academy Personnel

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Create ID Card wizard.

   Option 1 (Toolbar):
   a. Click the Create an ID Card icon on the Toolbar.
      - Result: The Create ID Card wizard opens.

   Option 2 (File Menu):
   a. Click Sponsor > ID Card > Create.
      - Result: The Create ID Card wizard opens.

   Option 3 (Right-Click Family):
   a. Right-click the ID Card icon > Create.
      - Result: The Create ID Card wizard opens.

   Option 4 (Person Viewer):
   a. Click ID Card(s).
      - Result: ID Card view displays in the Person Viewer.
   b. Click the View Card tab.
      - Result: The View Card tab becomes active.
   c. Click Create ID Card.
Result: The Create ID Card wizard opens.

Option 5 (Icon Bar):
- a. Click the ID Card icon.
  - Result: ID Card view displays in the Person Viewer.
- b. Click the View Card tab.
  - Result: The View Card tab becomes active.
- c. Click Create ID Card.
  - Result: The Create ID Card wizard opens.
- d. Click the ID Card checkbox.

Note: You can view the customer’s benefits details by completing the following steps (a–d):

- a. Click the View Benefit Details button.
  - Result: The RAPIDS - Benefit Details window opens.
- b. Verify Sponsor’s benefits in the RAPIDS - Benefit Details window.
- c. Click Close.
  - Result: RAPIDS - Benefit Details window closes.
- d. Click Next.
  - Result: The Create ID Card wizard advances to the Generate ID Card task.
  - Result: The Create ID Card wizard advances to the Get List of ID Cards to Terminate task.
  - Result: The Create ID Card wizard advances to the Terminate Previous task.

3. Collect the customer’s primary and secondary proof of identity documents.

4. Select a Reason for Termination in the Why Is This Previous ID Card Being Terminated? area.

Note: A Teslin card only must be terminated if the Sponsor has previously been issued a Teslin.

5. Click Next.
   - Result: The Create ID Card wizard advances to the View Terminated task.

6. Locate the return code in the View Terminated task in the Create ID Card wizard and write it on the terminated Teslin with a permanent black marker.

Note: The terminated Teslin card must be returned to the DSC.

7. Click Next.
   - Result: The Create ID Card wizard advances to the Send Terminated ID Card to DEERS task.
   - Result: The Create ID Card wizard advances to the Adjust Card Dates task.
8. Click Next.  
   - Result: The Create ID Card wizard updates to the Primary Proof of Identity task.

9. Ask the Sponsor for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.

10. Select a Primary Proof of Identity document type in the Identity Document Selection area.  
    - Result: Fields in the Document Details area adjust according to the document type.

11. Ask the Sponsor for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.

12. Place the Sponsor’s primary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

13. Click Scan in the Create ID Card wizard.  
    - Result: The RAPIDS - Scan Document window opens.

14. Click Preview Scanned Document in the RAPIDS - Scan Document window.  
    - Result: RAPIDS scans the primary proof of identity document.

15. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

16. Click OK.  
    - Result: The RAPIDS - Scan Document window closes.

17. Remove the primary proof of identity document from the scanner.

In the Document Details area of the Select Primary Proof of Identity task of the Create ID Card wizard—

18. Enter the Document Serial/Identity Number.

19. Enter the Document Issue Date.

20. Enter the Document Expiration Date.

21. Enter the Country of Issuance.

22. Select the State/Province of Issuance.

23. Enter the County/City of Issuance.
Note: In some cases, the information required to complete the Document Details area of the Select Primary Proof of Identity task will not be available or present on the family member’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

24. Give the primary proof of identity document back to the Sponsor.

25. Click Next.
   - Result: The Create ID Card wizard advances to the Secondary Proof of Identity task.

26. Ask the Sponsor for his or her secondary proof of identity and complete the steps necessary to verify the document’s authenticity.

   - Result: Fields in the Document Details area adjust accessibility according to the document type.

28. Place the Sponsor’s secondary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

29. Click Scan in the Create ID Card wizard.
   - Result: The RAPIDS - Scan Document window opens.

30. Click Preview Scanned Document in the RAPIDS - Scan Document window.
   - Result: RAPIDS scans the secondary proof of identity document.

31. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

32. Click OK.
   - Result: The RAPIDS - Scan Document window closes.

33. Remove the secondary proof of identity document from the scanner.

In the Document Details area of the Select Secondary Proof of Identity task of the Create ID Card wizard—

34. Enter the Document Serial/Identity Number.

35. Enter the Document Issue Date.

36. Enter the Document Expiration Date.
37. Enter the **Country of Issuance**.

38. Select the **State/Province of Issuance**.

39. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Secondary Proof of Identity task will not be available or present on the family member’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

40. Give the secondary proof of identity document back to the Sponsor.

41. Click **Next**.
   - Result: The system completes Select Proof of Identity task.
   - Result: The system updates the ID card.
   - Result: The *Create ID Card* wizard advances to the Capture Biometrics task.

42. Click **Capture Picture**.
   - Result: Picture of customer appears in *RAPIDS - Capture Photo* window.

43. Verify quality of picture. In the *RAPIDS - Capture Photo* window, use the Brightness and Contrast controls to improve the quality of the picture.

44. Click **OK**.
   - Result: The *RAPIDS - Match Primary Fingerprint* window opens.

45. When the *RAPIDS - Match Primary Fingerprint* window opens, ask customer to identify his or her primary hand and place his or her primary finger on the fingerprint scanner to match the fingerprint.
   - Result: Fingerprints match.
   - Result: The *RAPIDS - Match Primary Fingerprint* window closes.
   - Result: The *RAPIDS - Match Secondary Fingerprint* window opens.

46. When the *RAPIDS - Match Secondary Fingerprint* window opens, ask customer to identify his or her secondary hand and place his or her secondary finger on the fingerprint scanner to match the fingerprint.
   - Result: Fingerprints match.
   - Result: The *RAPIDS - Match Secondary Fingerprint* window closes.

47. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Prepare for Printing task.

48. Click **Next**.
   - Result: The task list updates to the Print Preview step.
49. Carefully review the front view and back view of this card to ensure all information on the card is accurate, including:
   a. Issue date.
   b. Expiration date.
   c. Spelling of the name.

*Note:* At this point, no changes can be made to the card.

50. Click **Print ID Card**.
   - Result: RAPIDS locates a printer.
   - Result: RAPIDS locates a printer.
   - Result: RAPIDS sends the ID Card to the printer.

51. When the printer has finished printing the front side of DD Form 2 (RET), place the cardstock in the printer’s multipurpose tray, blank side face up, with the top edge toward the printer and the left side aligned with the left guide.
   - Result: The **Print the Back Side of the ID Card** window opens.

52. When the printer has finished printing the back side of the DD Form 2, remove the cardstock from the printer, turn the cardstock over so the blank side is facing up, and return it to the multipurpose tray with the top edge toward the printer.

53. Click **OK**.

54. Verify results of front view and back view of ID card.
   - Result: The **Create ID Card** wizard advances to the Sign and Laminate task.

55. Complete the Sign and Laminate step.

56. Prepare ID card for (customer’s name).

57. Instruct the customer to sign the card with black, blue-black, or blue ink.

58. Remove excess cardstock from around the Teslin card.

59. Insert the card into the laminator with the face inserted so that the hologram is on the front/face side of the card and the short edge inserted first.

60. Click **Next**.
   - Result: The **Create ID Card** wizard advances to the Print Correctly? task.

61. Review the Teslin card to ensure—
   a. Card is of good print quality
   b. Photo can be used to identify the person
   c. Barcodes are clear
   d. Text is legible.
62. If the Teslin Card is acceptable, click **Yes**.

**Note:** If the Teslin card is unacceptable, complete steps a–c below:

- **a.** Click **No Failed** in the Printing Status area.
- **b.** Select the **Reason for Failure** in the Reason for Failure field.
- **c.** Click **Next**.
  - Result: The *Create ID Card* wizard advances to the Save ID Card task.
  - Result: The *Create ID Card* wizard advances to the Generate ID Card task.
  - Result: The *Create ID Card* wizard advances to the Prepare for Printing task.

63. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Print Correctly? task.

64. Scan the 39-code barcode.
   - Result: The *Create ID Card* wizard advances to the Summary task.

65. Review the information in the Summary task for accuracy.

66. Click **Finish**.
   - Result: The *Create ID Card* wizard closes.

67. Give the Teslin Card to the Sponsor.

### 8.7.4 Issue A NOAA Civilian Retiree Card to the Family Member of a NOAA Wage Mariner Retiree

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the *Create ID Card* wizard.

   **Option 1 (Toolbar):**
   - a. Click the **Create an ID Card** icon on the Toolbar.
   - Result: The *Create ID Card* wizard opens.

   **Option 2 (File Menu):**
   - a. Click **Sponsor > ID Card > Create**.
   - Result: The *Create ID Card* wizard opens.

   **Option 3 (Right-Click Family):**
   - a. Right-click the **ID Card** icon > **Create**.
   - Result: The *Create ID Card* wizard opens.
Option 4 (Person Viewer):
   a. Click **ID Card(s)**.
      - Result: ID Card view displays in the Person Viewer.
   b. Click the **View Card** tab.
      - Result: The View Card tab becomes active.
   c. Click **Create ID Card**.
      - Result: The *Create ID Card* wizard opens.

Option 5 (Icon Bar):
   a. Click the **ID Card** icon.
      - Result: ID Card view displays in the Person Viewer.
   b. Click the **View Card** tab.
      - Result: The View Card tab becomes active.
   c. Click **Create ID Card**.
      - Result: The *Create ID Card* wizard opens.

3. Click the **ID Card** checkbox for the appropriate family member.

**Note:** You can view the customer’s benefits details by completing the following steps: (a–c)
   a. Click **View Benefit Details**.
      - Result: The *RAPIDS - Benefit Details* window opens.
   b. Verify Sponsor’s benefits in the *RAPIDS - Benefit Details* window.
   c. Click **Close**.
      - Result: *RAPIDS - Benefit Details* window closes.

4. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Generate ID Card task.
   - Result: The *Create ID Card* wizard advances to the Get List of ID Cards to Terminate task.
   - Result: The *Create ID Card* wizard advances to the Terminate Previous task.

5. Collect the customer’s primary and secondary proof of identity documents.

6. Select a **Reason for Termination** in the Why Is This Previous ID Card Being Terminated? area.

**Note:** A CAC only must be terminated if the Sponsor has previously been issued a CAC.

7. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the View Terminated task.

**Note:** If the Sponsor has never been issued a CAC or the CAC has already been terminated, the View Terminated task is skipped.
8. Locate the return code in the View Terminated task in the Create ID Card wizard and write it on the terminated CAC with a permanent black marker.

*Note:* The terminated CAC must be returned to the DSC.

9. Click **Next**.
   - Result: The Create ID Card wizard advances to the Send Terminated ID Card to DEERS task.
   - Result: The Create ID Card wizard advances to the Adjust Card Dates task.

10. Use the arrows to select the **ID Card Date Range**.

11. Click **Next**.
    - Result: The Create ID Card wizard updates to the Select Primary Proof of Identity task.

12. Ask the Sponsor for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.

    - Result: Fields in the Document Details area adjust according to the document type.

14. Place the Sponsor’s primary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

15. Click **Scan** in the Create ID Card wizard.
    - Result: The RAPIDS - Scan Document window opens.

16. Click **Preview Scanned Document** in the RAPIDS - Scan Document window.
    - Result: RAPIDS scans the primary proof of identity document.

17. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

18. Click **OK**.
    - Result: The RAPIDS - Scan Document window closes.

19. Remove the primary proof of identity document from the scanner.

In the Document Details area of the Select Primary Proof of Identity task of the Add Family wizard—

20. Enter the **Document Serial/Identity Number**.

21. Enter the **Document Issue Date**.

22. Enter the **Document Expiration Date**.

23. Enter the **Country of Issuance**.

24. Select the **State/Province of Issuance**.

25. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Primary Proof of Identity task will not be available or present on the family member’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

26. Give the primary proof of identity document back to the Sponsor.

27. Click **Next**.
   - Result: The **Create ID Card** wizard advances to the Secondary Proof of Identity task.

28. Ask the Sponsor for his or her secondary proof of identity and complete the steps necessary to verify the document’s authenticity.

   - Result: Fields in the Document Details area adjust accessibility according to the document type.

30. Place the Sponsor’s secondary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

31. Click **Scan** in the **Create ID Card** wizard.
   - Result: The **RAPIDS - Scan Document** window opens.

32. Click **Preview Scanned Document** in the **RAPIDS - Scan Document** window.
   - Result: RAPIDS scans the secondary proof of identity document.

33. Use the horizontal and vertical scroll bars in the **RAPIDS - Scan Document** window to verify that the document image contains the document’s identity numbers.

34. Click **OK**.
   - Result: The **RAPIDS - Scan Document** window closes.

35. Remove the secondary proof of identity document from the scanner.
In the Document Details area of the Select Secondary Proof of Identity task of the Create ID Card wizard—

36. Enter the Document Serial/Identity Number.

37. Enter the Document Issue Date.

38. Enter the Document Expiration Date.

39. Enter the Country of Issuance.

40. Select the State/Province of Issuance.

41. Enter the County/City of Issuance.

Note: In some cases, the information required to complete the Document Details area of the Select Secondary Proof of Identity task will not be available or present on the family member’s proof of identity. When this information is unavailable, leave the fields blank. Give the secondary proof of identity document back to the Sponsor. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

42. Click Next.
   - Result: The Create ID Card wizard advances to the Capture Biometrics task.
   - Result: The RAPIDS - Capture Photo window opens.

43. In the RAPIDS - Capture Photo window, use the Movement and Zoom controls to frame the picture.

44. Click Capture Picture.
   - Result: Picture of customer appears in RAPIDS - Capture Photo window.

45. Verify the quality of picture. In the RAPIDS - Capture Photo window, use the Brightness and Contrast controls to improve the quality of the picture.

46. Click OK.
   - Result: The RAPIDS - Capture Photo window closes.

47. Click Next.
   - Result: The Create ID Card wizard advances to the Update ID Card task.
   - Result: The Create ID Card wizard advances to the Print Preview task.

48. Carefully review the front view and back view of this card to ensure all information on the card is accurate, including—
   a. Issue date
   b. Expiration date
c. Spelling of the name.

**Note:** At this point, no changes can be made to the card.

49. **Click Print ID Card.**
   - Result: RAPIDS locates a printer.
   - Result: The **RAPIDS TOPPAN CP** window shows while print is in progress.
   - Result: The ID card prints.
   - Result: The **Create ID Card** wizard advances to the Print Correctly? task.

50. **Remove the ID Privilege Card from the printer.**

51. **Review the ID Privilege Card to ensure—**
   a. Card is of good print quality
   b. Photo can be used to identify the person
   c. Barcodes are clear
   d. Text is legible.

If the ID Privilege Card is acceptable—

52. **Click Yes.**

53. **Click Next.**
   - Result: The **RAPIDS - Scan ID Card** window opens.

54. **Scan the 39-code barcode.**
   - Result: The **RAPIDS - Scan ID Card** window closes.
   - Result: The **Create ID Card** wizard advances to the Summary task.

55. **Review the information in the Summary task for accuracy.**

56. **Click Finish.**
   - Result: The **Create ID Card** wizard closes.

57. **Give the new NOAA Civilian Retiree card to the family member.**

### 8.7.5 Issue An ID Card to a Disabled Veteran (DAV)

Disabled Veterans (DAV) that are 100% disabled are eligible for DD Form 1173 Uniformed Services Identification and Privilege Card.

**Note:** Please see section 8.7.1 of this user guide for detailed instructions on how to issue a Teslin card.
8.8 RECORDS OPERATIONS—GENERAL

8.8.1 Capture a Fingerprint

To capture a good fingerprint, your customer must have clean hands and must place his or her finger properly on the reader. Clean hands and proper placement of the finger do not guarantee an accurate fingerprint read. Sweaty hands and worn fingerprints can cause problems when attempting to read a fingerprint.

1. When the Capture Primary Fingerprint window opens, ask the customer to identify his or her primary hand and place his or her primary finger on the fingerprint scanner to capture the fingerprint.
   ▪ Result: Fingerprints are captured and confirmed.

2. When the RAPIDS - Capture Secondary Fingerprint window opens, ask the customer to identify his or her primary hand and place his or her secondary finger on the fingerprint scanner to capture the fingerprint.
   ▪ Result: Fingerprints are captured and confirmed.
   ▪ Result: The Capture Secondary Fingerprint window closes.
   ▪ Result: The recorded biometrics from the Creating a Fingerprint and Picture tasks are displayed.

8.8.2 Skip the verification of an existing fingerprint

You can skip the verification of an existing fingerprint when verification of the primary and secondary fingerprints fail or the customer is not present. Skipping fingerprint verification should only be done when the customer’s identity can be verified through another means, or if you have already positively identified the customer.

Skipping the verification of a customer's fingerprint is very rare and requires the digital signature of your site's SSM. All skipped fingerprint verifications are audited by DMDC.

1. Complete the steps necessary to open the Sponsor’s record, verify his or her identity, and navigate to the Capture Biometrics task in the Create ID Card wizard.
   ▪ Result: The RAPIDS - Match Primary Fingerprint window opens.
2. Click Cancel.
   ▪ Result: The RAPIDS - Match Primary Fingerprint window closes.
   ▪ Result: The RAPIDS - Match Secondary Fingerprint window opens.
3. Click Cancel.
   ▪ Result: The RAPIDS - Match Secondary Fingerprint window closes.
4. Click Next.
   ▪ Result: The Create ID Card wizard advances to the Verification Failure task.
5. Click Skip Verification.
6. Click Next.
   - Result: The Create ID Card wizard advances to the Select SSM task.

7. Select the SSM at your site who will authorize the skip fingerprint verification.

8. Click Next.
   - Result: The Create ID Card wizard advances to the Remove the Recipient Card task.

9. Remove the recipient’s card from the customer card reader.

10. Click Next.
    - Result: The Create ID Card wizard advances to the Insert SSM’s Card task.

11. Instruct the SSM to insert his or her CAC into the customer card reader.

12. Click Next.
    - Result: The Site Security Manager PIN window opens.

13. Instruct the SSM to enter his or her PIN.

14. Click OK.
    - Result: The Site Security Manager PIN window closes.
    - Result: The Create ID Card wizard advances to the Authorize Verify Fingerprint task.

15. Instruct the SSM to verify that the photograph on the screen matches the customer.

16. Instruct the SSM to read the authorization statement.

17. Instruct the SSM to click Authorize.
    - Result: The Create ID Card wizard advances to the Remove SSM Card task.

18. Instruct the SSM to remove his or her CAC from the customer card reader.
    - Result: The Create ID Card wizard advances to the Remove SSM Card task.

19. Click Next.
    - Result: The Create ID Card wizard advances to the Capture Biometrics task.
    - Result: The RAPIDS - Capture Primary Fingerprint window opens.

Note: The fingerprint verification has been skipped.

**8.8.3 Skip the capture of a fingerprint**

You can skip the capture of an existing fingerprint when the capture of the primary and secondary fingerprints fail or the customer is not present. Skipping fingerprint capture should
only be done when the customer’s identity can be verified through another means, or if you have already positively identified the customer.

Skipping the capture of a customer's fingerprint is very rare and requires the digital signature of your site's SSM. All skipped fingerprint captures are audited by DMDC.

1. Complete the steps necessary to open the Sponsor’s record, verify his or her identity, and skip the capture of their fingerprint in the Create ID Card wizard.
   ▪ Result: The RAPIDS - Capture Primary Fingerprint window opens.

2. Click Cancel.
   ▪ Result: The RAPIDS - Capture Primary Fingerprint window closes.

3. Click Next.
   ▪ Result: The Create ID Card wizard advances to the Verification Failure task.

4. Click Skip Capture.

5. Click Next.
   ▪ Result: The Create ID Card wizard advances to the Select SSM task.

6. Select the SSM at your site who will authorize the skip fingerprint verification.

7. Click Next.
   ▪ Result: The Create ID Card wizard advances to the Remove the Recipient Card task.

8. Remove the recipient’s card from the customer card reader.

9. Click Next.
   ▪ Result: The Create ID Card wizard advances to the Insert SSM’s Card task.

10. Instruct the SSM to insert his or her CAC into the customer card reader.

11. Click Next.
    ▪ Result: The Site Security Manager PIN window opens.

12. Instruct the SSM to enter his or her PIN.

13. Click OK.
    ▪ Result: The Site Security Manager PIN window closes.
    ▪ Result: The Create ID Card wizard advances to the Authorize Verify Fingerprint task.

14. Instruct the SSM to verify that the photograph on the screen matches the customer.

15. Instruct the SSM to read the authorization statement.
16. Instruct the SSM to click **Authorize**.
   - Result: The *Create ID Card* wizard advances to the Remove SSM Card task.

17. Instruct the SSM to remove his or her CAC from the customer card reader.
   - Result: The *Create ID Card* wizard advances to the Remove SSM Card task.

18. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Capture Biometrics task.

**Note:** The fingerprint capture has been skipped.

### 8.8.4 Capture a Photograph

The RAPIDS system applies a digitized, full-face photograph similar to a passport photograph. No title board is used.

1. Photograph military personnel in uniform or civilian clothes.
2. Position the applicant between 3 and 5 ft from the camera (optimal distance is 4 ft).
3. Fill the entire white area on the cardstock with the applicant’s face.
4. Cut photo off just below shoulders when in military clothing so insignia, badges, and emblems are not visible.

### 8.8.5 Capture a Proof of Identity

The Select Primary Proof of Identity task appears.

   - Result: Fields in the Document Details area adjust accessibility according to the document type.

2. Place primary proof of identity document on the scanning bed of the document scanner.

3. Select **Scan**.
   - Result: The *Scan Document* window opens.

4. Select **Preview Scanned Document**.

5. Verify the document; select **OK**.
   - Result: The *RAPIDS Scan Document* window closes.

In the Document Details area of the Select Primary Proof of Identity task—

6. Enter **Document Serial/Identity Number**.

7. Enter the **Document Issue Date**.
8. Enter the **Document Expiration Date**.

9. Enter the **Country of Issuance**.

10. Select the **State/Province of Issuance**.

11. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Primary Proof of Identity task will not be available or present on the customer’s proof of identity. When this information is unavailable, contact the SSM and request the missing information from the customer.

12. Verify that your name appears in the Document Verified By area of the screen.

13. Click **Next**.
   - Result: The *Create ID Card* wizard advances to the Select Secondary Proof of Identity task.

   - Result: Fields in the Document Details area adjust accessibility according to the document type.

15. Place secondary proof of identity document on the scanning bed of the document scanner.

16. Select **Scan**.
   - Result: The *RAPIDS Scan Document* window opens.
   - Select **Preview Scanned Document**.

17. Verify the document; select **OK**.
   - Result: The *RAPIDS Scan Document* window closes.

In the Document Details area of the Select Secondary Proof of Identity task—

18. Enter the **Document Serial/Identity Number**.

19. Enter the **Document Issue Date**.

20. Enter the **Document Expiration Date**.

21. Enter the **Country of Issuance**.

22. Select the **State/Province of Issuance**.

23. Enter the **County/City of Issuance**.
Note: In some cases, the information required to complete the Document Details area of the Select Secondary Proof of Identity task will not be available or present on the Sponsor’s proof of identity. When this information is unavailable, contact the SSM and request the missing information from the customer.

24. Verify that your name appears in the Document Verified By area of the screen.

25. Click Next.
   - Result: System completes the Select Proof of Identity task.

### 8.8.6 Suspend privileges

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Navigate to the Base Privileges tab of the Benefits screen in the Person Viewer.

Option 1 (Icon Bar):
   a. Click the **Benefits** icon.
      - Result: The Base Privileges tab of the Benefits screen in the Person Viewer is active.

Option 2 (Menu Bar):
   a. Click **Sponsor > Benefits > Suspend Base Privileges**.
      - Result: The Base Privileges tab of the Benefits screen in the Person Viewer is active.

Option 3 (Menu Bar):
   a. Click **View > Benefits > Base Privileges**.
      - Result: The Base Privileges tab of the Benefits screen in the Person Viewer is active.

Option 4 (Family Tree):
   a. Click the **Benefits** icon.
      - Result: The Base Privileges tab of the Benefits screen in the Person Viewer is active.

Option 5 (Family Tree):
   a. Right-click the **Benefits** icon.
      - Result: The Benefits right-click menu opens.
   b. Select **Suspend Base Privileges**.
      - Result: The Base Privileges tab of the Benefits screen in the Person Viewer is active.
Option 6 (Person Viewer):
   a. Click **Benefits** in the Person Viewer.
      - Result: The Base Privileges tab of the Benefits screen in the Person Viewer is active.

3. Click the **Exchange Unlimited** checkbox.

4. Click **Add Suspension(s)**.
   - Result: The *RAPIDS - Add Suspension* wizard opens.

5. Click the **Exchange Unlimited** checkbox in the Suspending area of the *RAPIDS - Add Suspension* wizard.

6. Enter the **Date** the suspension will begin in the Begin Date field.

7. Enter the **Date** the suspension will be lifted in the End Date field.

8. Select the **Appropriate Reason** for suspension in the Reason field.

9. Enter the **Name** of the person who has authorized the suspension in the Authorization field.

10. Click **OK**.
    - Result: The *Add Suspension* window opens.
    - Result: The *Add Suspension* window closes.
    - Result: The Base Privileges tab of the Benefits screen in the Person Viewer is active.

**Note:** The suspension is highlighted in red in the Privileges area of the Base Privileges tab.

11. Click the **Save Family to DEERS** icon in the Toolbar.
    - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

**8.8.7 Add Medicare to a record**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
- Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Medicare tab of the Benefits screen in the Person Viewer.

Option 1 (Toolbar):
   a. Click the Benefits icon.
      - Result: The Benefits information displays in the Person Viewer and shows as active.

Option 2 (Family Tree):
   a. Click the Benefits folder.
      - Result: The Benefits information displays in the Person Viewer and shows as active.

Option 3 (Right-Click Family Tree):
   a. Right-click the Benefits folder.
      - Result: The Benefits right-click menu opens.
   b. Click Add Medicare.
      - Result: The Medicare information displays in the Person Viewer and shows as active.

Option 4 (Person Viewer):
   a. Click Benefits.
      - Result: The Benefits information displays in the Person Viewer and shows as active.

Option 5 (Icon Bar):
   a. Click the Benefits icon.
      - Result: The Benefits information displays in the Person Viewer and shows as active.

3. Select the Medicare tab.
   - Result: The Medicare information displays under the Current Medicare Programs area.

4. Click Add Medicare.
   - Result: The RAPIDS - Add Medicare wizard opens.

5. Select the Type of Medicare being added from the menu under the Adding Medicare area of the RAPIDS - Add Medicare wizard.

6. Enter the Date coverage will begin in the Begin Date field.

Note: The Medicare begin date is always on the first day of the month.
7. Enter the **Health Insurance Claim Number (HICN) or Medicare Claim Number** in the HICN field.

8. Enter the **Reason** for Medicare in the Reason field.

9. Click **OK**.
   - Result: The *RAPIDS - Add Medicare* wizard opens.

**Note:** The Medicare information displays under the Current Medicare Programs area of the Medicare (A) or (B) tabs.

10. Click the **Save Family to DEERS** icon in the Toolbar.
    - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

**8.8.8 Change a Foreign Identification Number (FIN) to a Social Security Number (SSN)**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Click the **Characteristics** icon in the Icon Bar.
   - Result: The Identity tab in the Characteristics view of the Person Viewer becomes active.

3. Click **Edit** in the Personal Identifier area of the Identity tab.
   - Result: The *Change Identifier* wizard opens with the TIN showing as the primary personal identifier.

4. Click the **Primary** radio button.

5. Click the **Primary** drop-down menu.

6. Click **SSN**.

7. Ask the Sponsor for his or her Social Security Card and complete the steps necessary to verify the document’s authenticity.

8. Enter the **Sponsor’s SSN** as it appears on the Social Security Card.

9. Click **Next**.
    - Result: The *Change Identifier* wizard advances to the Change Identifier Documentation task.
10. Ask the Sponsor for his or her identifier documentation and complete the steps necessary to verify the document’s authenticity.

11. Select an **Identifier Documentation** type in the Change Identifier Document(s) area.
   - Result: Fields in the Document Details area adjust according to the document type.

12. Place the Sponsor’s identifier documentation face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

13. Click **Scan** in the *Change Identifier* wizard.
   - Result: The *RAPIDS - Scan Document* window opens.

14. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
   - Result: RAPIDS scans the identifier documentation document.

15. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

16. Click **OK**.
   - Result: The *RAPIDS - Scan Document* window closes.

17. Remove the identifier documentation document from the scanner and give it back to the Sponsor.

In the Document Details area of the Change Identifier Documentation task of the *Change Identifier* wizard—

18. Enter the **Document Serial/Identity Number**. This number should be the Sponsor’s SSN.

19. Select the **State/Province of Issuance**.

20. Click **Next**.
   - Result: The *Change Identifier* wizard advances to the Send to Server task.
   - Result: The *Change Identifier* wizard advances to the Summary task.

21. Review the information in the Summary Task screen for accuracy.

22. Click **Finish**.
   - Result: The *Change Identifier* wizard closes.

23. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.
8.8.9 Update Address (Copy home address from Sponsor to Family Members)

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   ▪ Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the *Update Address* wizard.

   Option 1 (Menu Bar):
   a. Click **View > Update Address**.
      ▪ Result: The *Update Address* wizard opens.

   Option 2 (Menu Bar):
   a. Click **Sponsor > Update Address**.
      ▪ Result: The *Update Address* wizard opens.

   Option 3 (Menu Bar):
   a. Click **Family > Family Member Name > Update Address**.
      ▪ Result: The *Update Address* wizard opens.

   Option 4 (Toolbar):
   a. Click the *Update Address* icon.
      ▪ Result: The *Update Address* wizard opens.

3. Click the **Add/Update/Copy Home Address** checkbox.

4. Click **Next**.
   ▪ Result: The *Update Address* wizard advances to the Add/Update/Copy Home Address task.

5. Click the **Sponsor’s** radio button in the Copy the Home Address From area.

   **Note:** The VO can update the address of the Sponsor in the Home Address area if necessary.

6. Click the **Family Member** checkbox(s) in the Copy the Home Address To area.

7. Click **Next**.
   ▪ Result: The *Update Address* wizard advances to the Address Summary task.

8. Click **Finish**.
   ▪ Result: The *Update Address* wizard closes.
8.9 ID CARD OPERATIONS—SPONSOR

8.9.1 Check a Sponsor’s verification status

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

   Option 1 (Information Viewer):
   a. Click the Sponsor Confirmation tab.
      - Result: The Sponsor’s confirmation status displays in the Information Viewer.

   Option 2 (Family Tree):
   a. Click the Personnel Status icon.
      - Result: The Sponsor’s Personnel Condition tab displays in the Person Viewer.
   b. Click the Personnel Status tab in the Person Viewer.
      - Result: The Sponsor’s Personnel Status tab shows the Sponsor confirmation status.

   Option 3 (Icon Bar):
   a. Click the Personnel Status icon.
      - Result: The Sponsor’s Personnel Condition tab displays in the Person Viewer.
   b. Click the Personnel Status tab in the Person Viewer.
      - Result: The Sponsor’s Personnel Status tab shows the Sponsor confirmation status.

   Option 4 (Menu Bar):
   a. Click View > Personnel Record(s) > Personnel Condition.
      - Result: The Sponsor’s Personnel Condition tab displays in the Person Viewer.
   b. Click the Personnel Status tab in the Person Viewer.
      - Result: The Sponsor’s Personnel Status tab shows the Sponsor confirmation status.

Note: The following are the four confirmation statuses:

- **Verified**—Information has been verified by the Service/Agency data feed or the Contractor Verification System (CVS).
- **Unverified**—Information has been added through RAPIDS, but either the Service/Agency data feed or CVS has yet to verify the data.
- **NOT Verifiable**—Information added through RAPIDS will never be verified by the Service/Agency data feed or CVS.

- **Discrepant Data**—Information added through RAPIDS does not match the information supplied by the Service/Agency data feed or CVS.

**Note**: Effective 31 October 2008, the RAPIDS application will require a DoD Contractor record to be verified by CVS before a Common Access Card (CAC) can be issued.

A DoD Contractor sponsored and verified through CVS will no longer be required to present the DD Form 1172-2 to the RAPIDS SSM/VO. This change does not impact ID card issuance with proper documentation for Foreign Affiliate Contractors and Civilian Affiliate/Other Federal Agency Contractors.

### 8.9.2 Add an overseas condition to a civilian who goes overseas for more than 1 year to accompany forces

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

   **Option 1 (Person Viewer):**
   a. Click **Add** in the Personnel Status bar in the Condition category in the Person Viewer.
   - Result: The Add Personnel Status: (Condition) wizard opens with [Civil Service (DoD and Uniformed Service)] as the default category.

   **Option 2 (Family Tree):**
   a. Right-click the [Civil Service (DoD and Uniformed Service)] icon > **Personnel Status Details** > Add (Condition).
   - Result: The Add Personnel Status: (Condition) wizard opens with [Civil Service (DoD and Uniformed Service)] as the default category.

2. In the Update Personnel Status [Category] + (Condition) area, click **Non-CONUS Assignment**.
   - Result: The Add Additional Details area expands.

3. Enter the **Date of Assignment Termination** in the Date Assignment Terminated Estimated field.

4. Use the drop-down menu to select the appropriate **Geneva Conventions Code** (if applicable).
   - Result: The Code field updates.

5. Use the drop-down menu to select the **Country** to which the Sponsor is assigned.
   - Result: The Code field updates to the code of the selected country.
6. Click the **Accompanying Forces** checkbox.

7. Click **Next**.
   - Result: The task list updates to the Send to Server task.
   - Result: The *Add Personnel Status: (Condition)* wizard updates to the Summary task.

8. Click **Finish**.
   - Result: The *Add Personnel Status: (Condition)* wizard closes.
   - Result: The Overview screen updates to show the condition in the Family Tree.

**Note:** You can also view the Personnel Status: (Condition) by following these steps:

a. Click the drop-down menu in the Personnel Status bar in the Condition category in the Person Viewer.

b. Click **Non-CONUS Assignment**.
   - Result: Non-CONUS assignment shows in the Personnel Status bar in the Condition category in the Person Viewer.

**8.9.3 Update a Sponsor’s rank**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
2. Open the Active Duty tab of Personnel Status in the Person Viewer.

Option 1 (Menu Bar):
   a. Click View > Personnel Record(s) > [Active Duty].
      ▪ Result: The Personnel Status screen opens in the Person Viewer with the Active Duty tab showing as active.

Option 2 (Family Tree):
   a. Click Personnel Status.
      ▪ Result: The Personnel Status screen opens in the Person Viewer with the Active Duty tab showing as active.

Option 3 (Person Viewer):
   a. Click Current Personnel(s).
      ▪ Result: The Personnel Status tab appears in the Person Viewer.
   b. Click the Active Duty tab.
      ▪ Result: The Personnel Status screen opens in the Person Viewer with the Active Duty tab showing as active.

Option 4 (Icon Bar):
   a. Click the Personnel Status icon.
      ▪ Result: The Personnel Status tab appears in the Person Viewer.
   b. Click the Active Duty tab.
      ▪ Result: The Personnel Status screen opens in the Person Viewer with the Active Duty tab active.

3. Select the appropriate Rank and Pay Grade in the Rank and Pay Grade Selection area of the Update Personnel Status Pay Category Details area.

4. Enter a Pay Category Begin Date.

5. Click the Save Family to DEERS icon in the Toolbar.
   ▪ Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

8.9.4 Retire a Sponsor

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   ▪ Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Remove Personnel Status wizard.
Option 1 (File Menu):
a. Click Sponsor > Personnel Record > End Personnel Status > [Active Duty].
   ▪ Result: The Remove Personnel Status wizard opens.

Option 2 (Family Tree):
   ▪ Result: The Remove Personnel Status wizard opens.

Option 3 (Person Viewer):
a. Click the [Active Duty] status in the Current Personnel(s) area of the Person Viewer.
b. Click End Personnel Status Due To drop-down menu.
c. Select Retirement.
   ▪ Result: The Remove Personnel Status wizard opens.

3. Select Retirement from the Due To drop-down menu in the Remove Personnel Status wizard.
   ▪ Result: The Remove Personnel Status wizard advances to the Remove Personnel Status task.

4. Enter a Retirement Date in the Retirement Date field.

5. Select the appropriate Retirement Type in the Retirement Type area.

6. Click Next.
   ▪ Result: The Remove Personnel Status wizard advances to the Send to Server task.
   ▪ Result: The Remove Personnel Status wizard advances to the Summary task.

7. Review the information in the Summary task in the Remove Personnel Status wizard for accuracy.

8. Click Finish.
   ▪ Result: The Remove Personnel Status wizard closes.

Note: Terminated relationships, personnel categories, and ID cards are shown in red text.
9. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.9.5 Activate a Guard or Reserve Sponsor

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the **Add Personnel Status: (Condition)** wizard.

   **Option 1 (File Menu):**
   a. Click **Sponsor > Personnel Record(s) > Add (Condition)**.
      - Result: The **Add Personnel Status (Condition)** wizard opens.

   **Option 2 (Family Tree):**
   a. Click **Personnel Status**.
      - Result: The National Guard tab is active in the Personnel Status screen in the Person Viewer.
   b. Click the **Add Condition of** drop-down menu.
   c. Click **On Active Duty**.
      - Result: The **Add Personnel Status (Condition)** wizard opens.

   **Option 3 (Right-Click Family Tree):**
   a. Right-click **Personnel Status**.
      - Result: The Personnel Status right-click menu opens.
   b. Click **Add (Condition)**.
      - Result: The **Add Personnel Status (Condition)** wizard opens.

   **Option 4 (Person Viewer):**
   a. Click the **National Guard** status in the Current Personnel(s) area of the Person Viewer.
      - Result: The National Guard tab is active in the Personnel Status screen in the Person Viewer.
b. Click the **Add Condition of** drop-down menu.

c. Click **On Active Duty**.
   - Result: The *Add Personnel Status (Condition)* wizard opens.

**Option 5 (Icon Bar):**

a. Click the **Personnel Status** icon.
   - Result: The Personnel Status tab is active in the Personnel Record screen in the Person Viewer.

b. Click the **National Guard** tab.

c. Click the **Add Condition of** drop-down menu.

d. Click **On Active Duty**.
   - Result: The *Add Personnel Status (Condition)* wizard opens.

**Option 6 (Personnel Status Bar):**

a. Click **Add** in the Personnel Status Bar in the Condition category in the Person Viewer.
   - Result: The *Add Personnel Status: (Condition)* wizard opens.

In the Update Personnel Status [Category] + (Condition) area—

3. Verify that National Guard is the default category.

4. Click **On Active Duty**.
   - Result: The Add Additional Details area expands.

5. Enter the **Active Duty Begin Date** in the Active Duty Begin Date field.

6. Enter the **Active Duty End Date** in the Active Duty End Date (estimated) field.

7. Verify the Sponsor’s e-mail address.

In the Add Additional Details area, use the drop-down menu to click the **Special Operation** to which the Sponsor is assigned (if applicable).

8. Click **Next**.
   - Result: The *Add Personnel Status: (Condition)* wizard advances to the Send to Server task.
   - Result: The *Add Personnel Status: (Condition)* wizard advances to the Summary task.

9. Review the information in the Summary Task screen for accuracy.

10. Click **Finish**.
    - Result: The *Add Personnel Status: (Condition)* wizard closes.

11. Click the **Save Family to DEERS** icon in the Toolbar.
- Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.9.6 Extend the Active Duty end date for a Guard or Reserve Sponsor

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.
   - Option 1 (File Menu):
     - a. Click **View > Personnel Record(s) > [National Guard] + (On Active Duty)**.
       - Result: The [National Guard] + (On Active Duty) Condition tab is active in the Person Viewer.
   - Option 2 (Family Tree):
     - a. Click the **[National Guard] + (On Active Duty)** condition in the Current Personnel(s) in the Person Viewer.
     - Result: The [National Guard] + (On Active Duty) Condition tab is active in the Person Viewer.
3. Enter the new **Active Duty End Date** in the Active Duty End Date (estimated) field to reflect the Active Duty extension.
4. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.9.7 Deactivate a Guard or Reserve Sponsor

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.
2. Open the **Remove Personnel Status** wizard.
   - Option 1 (File Menu):
     - a. Click **Sponsor > Personnel Record > End Personnel Status > [National Guard] + (On Active Duty)**.
       - Result: The **Remove Personnel Status** wizard opens.
   - Option 2 (Family Tree):
a. Right-click the [National Guard] + (On Active Duty) folder > Personnel Status Details > End Personnel Status.
   ▪ Result: The Remove Personnel Status wizard opens.

Option 3 (Person Viewer):
   a. Click the [National Guard] + (On Active Duty) status in the Current Personnel(s) area of the Person Viewer.
      ▪ Result: The [National Guard] + (On Active Duty) tab is active in the Personnel Status screen in the Person Viewer.
   b. Click End Personnel Status Due To drop-down menu.
   c. Select Separation.
      ▪ Result: The Remove Personnel Status wizard opens.

3. Select Separation as the reason for removing the Active Duty personnel status.

4. Enter a Date of Separation in the Separation Date field in the Remove Personnel Status wizard.

5. Complete the Separation Program Designator field in the Remove Personnel Status wizard.


7. Select a Character of Service in the Character of Service area in the Remove Personnel Status wizard.

8. Click Next.
   ▪ Result: The Remove Personnel Status wizard advances to the Send to Server task.
   ▪ Result: The Remove Personnel Status wizard advances to the Summary task.

9. Review the information in the Summary task in the Remove Personnel Status wizard for accuracy.

10. Click Finish.
    ▪ Result: The Remove Personnel Status wizard closes.

11. Click the Save Family to DEERS icon in the Toolbar.
    ▪ Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

8.9.8 Separate Guard/Reserve Sponsor Involuntarily From the Selected Reserves

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   ▪ Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.
2. Open the *Remove Personnel Status* wizard.

Option 1 (File Menu):
   a. Click **Sponsor** > **Personnel Record** > **End Personnel Status** > **[Active Duty]**.
      - Result: The *Remove Personnel Status* wizard opens.

Option 2 (Family Tree):
   a. Right-click the **[Active Duty]** folder > **Personnel Status Details** > **End Personnel Status**.
      - Result: The *Remove Personnel Status* wizard opens.

Option 3 (Person Viewer):
   a. Click the **[Active Duty]** status in the Current Personnel(s) area of the Person Viewer.
   b. Click **End Personnel Status Due To** drop-down menu.
   c. Select **Retirement**.
      - Result: The *Remove Personnel Status* wizard opens.

3. Select **Separation** from the Due To drop-down menu in the *Remove Personnel Status* wizard.

4. Enter a **Separation Date** in the Retirement Date field.

5. Enter the **Separation Program Designator Code** (found on DD Form 214, *Certificate of Release or Discharge From Active Duty*).

6. Enter the **Re-Enlistment Eligibility Code** (found on DD Form 214).

7. Select a **Character of Service** in the Character of Service field.

8. Click **Next**.
   - Result: The *Remove Personnel Status* wizard advances to the Send to Server task.
   - Result: The *Remove Personnel Status* wizard advances to the Summary task.

9. Review the information in the Summary task for accuracy.

10. Click **Finish**.
     - Result: The *Remove Personnel Status* wizard closes.

11. Click the **Save Family to DEERS** icon in the Toolbar.
    - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.
8.9.9 Update Individual Ready Reserve to Selected Reserves
1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   ▪ Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.
2. Click the Sponsor’s Personnel Status icon in the Family Tree.
   ▪ Result: The Sponsor’s [National Guard] Status tab is active in the Person Viewer.
3. Click the Reserve Component Category drop-down menu.
4. Select Selected Reserve from the Reserve Component Category drop-down menu.
5. Enter the Selected Reserve Begin Date in the Begin Date field.
6. Click the Save Family to DEERS icon in the Toolbar.
   ▪ Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

Note: The service member is now eligible for a CAC. Collect the Teslin Individual Ready Reserves ID card and issue the member a new CAC. The family members are also eligible to receive a new Teslin card.

8.9.10 Separate Guard/Reserve Sponsor Qualifying for Transitional Assistance (TA)
▪ See the Deactivate a Guard or Reserve Sponsor section.

Note: Guard or Reserve Sponsors may automatically receive TA if certain contingencies exist on their record in DEERS. One example would be if the Guard or Reserve was activated because of the special operation of Operation Iraqi Freedom.

Guard or Reserve Sponsors may also receive TA upon deactivation of their Active Duty if their DD Form 214 SPD code entitles them to the TA benefit.

8.9.11 Provide Limited Exchange Benefits to United States Coast Guard (USCG) Non-Appropriated Fund (NAF) Exchange Employees
▪ See the Create a New Sponsor Record section.

Note: When selecting the category of DoD Civilian Employee > NAF Employee (DoD and Uniformed Service) with the sponsoring agency set to USCG Exchange, the Sponsor automatically receives limited exchange benefits.

8.9.12 Recall a retiree to Active Duty service
1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
- Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Remove Personnel Status wizard.

Option 1 (File Menu):
   a. Click Sponsor > Personnel Record > End Personnel Status > [Retired].
      - Result: The Remove Personnel Status wizard opens.

Option 2 (Family Tree):
   a. Right-click the [Retired] folder > Personnel Status Details > End Personnel Status.
      - Result: The Remove Personnel Status wizard opens.

Option 3 (Person Viewer):
   a. Click the [Retired] status in the Current Personnel(s) area of the Person Viewer.
      - Result: The [Retired] tab is active in the Personnel Status screen in the Person Viewer.
   b. Click the End Personnel Status Due To drop-down menu.
   c. Select Activation.
      - Result: The Remove Personnel Status wizard opens.

3. Select Activation from the Due To drop-down menu in the Remove Personnel Status wizard.
   - Result: The Remove Personnel Status wizard advances to the Remove Personnel Status task.

![Remove Personnel Status](image)

4. Enter the Activation Date in the Activation Date field.

5. Click Next.
   - Result: The Remove Personnel Status wizard advances to the Category and Details task.

6. Select the appropriate Category.

7. Enter the Activation Begin Date in the Begin Date field.
8. Enter the **End Date** in the End Date field.

9. Enter the Sponsor’s **Work E-Mail Address** in the Work E-mail field.

10. Select the **Sponsoring Agency** from the Sponsor Agency drop-down menu.

11. Select a **Rank and Pay Grade** from the Rank and Pay Grade area.

12. Click **Next**.
   - Result: The *Remove Personnel Status* wizard advances to the Send to Server task.
   - Result: The *Remove Personnel Status* wizard advances to the Summary task.

13. Review the information in the Summary task in the *Remove Personnel Status* wizard for accuracy.

14. Click **Finish**.
   - Result: The *Remove Personnel Status* wizard closes.

**Note:** Terminated relationships, personnel categories, and ID cards are shown in red text.
15. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.9.13 Create a new Sponsor record

1. Complete the steps necessary to log on to RAPIDS.
   - Result: RAPIDS opens to the default state of the Overview screen.

2. Open the **Add Family** wizard.

   Option 1 (Toolbar):
   - a. Click the **New Family** icon.
      - Result: The **Add Family** wizard opens.

   Option 2 (Menu Bar):
   - b. Click **File > New Family**.
      - Result: The **Add Family** wizard opens.

3. Enter the Sponsor’s **Name** in the Name area of the **Add Family** wizard.

4. Select the provided **Primary ID Number** from the Primary drop-down menu.
   - Result: The field to the right adjusts according to the type of ID number selected.

5. Enter the **Primary ID Number** unless automatically generated.

6. Click **Next**.
   - Result: The **Add Family** wizard advances to the Looking for Person task.
   - Result: The **Add Family** wizard advances to the Primary Proof of Identity task.

7. Ask the Sponsor for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.
8. Select a **Primary Proof of Identity** document type in the Identity Document Selection area.
   - Result: Fields in the Document Details area adjust according to the document type.

9. Place the Sponsor’s primary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

10. Click **Scan** in the *Add Family* wizard.
    - Result: The *RAPIDS - Scan Document* window opens.

11. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
    - Result: RAPIDS scans the primary proof of identity document.

12. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

13. Click **OK**.
    - Result: The *RAPIDS - Scan Document* window closes.

14. Remove the primary proof of identity document from the scanner.

In the Document Details area of the Select Primary Proof of Identity task of the *Add Family* wizard—

15. Enter the **Document Serial/Identity Number**.

16. Enter the **Document Issue Date**.

17. Enter the **Document Expiration Date**.

18. Enter the **Country of Issuance**.

19. Select the **State/Province of Issuance**.

20. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Primary Proof of Identity task will not be available or present on the Sponsor’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

21. Give the primary proof of identity document back to the Sponsor.

22. Click **Next**.
23. Ask the Sponsor for his or her secondary proof of identity and complete the steps necessary to verify the document’s authenticity.

   - Result: Fields in the Document Details area adjust accessibility according to the document type.

25. Place the Sponsor’s secondary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

26. Click *Scan* in the *Add Family* wizard.
   - Result: The *RAPIDS - Scan Document* window opens.

27. Click *Preview Scanned Document* in the *RAPIDS - Scan Document* window.
   - Result: RAPIDS scans the secondary proof of identity document.

28. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

29. Click *OK*.
   - Result: The *RAPIDS - Scan Document* window closes.

30. Remove the secondary proof of identity document from the scanner.

In the Document Details area of the Select Secondary Proof of Identity task of the *Add Family* wizard—

31. Enter the **Document Serial/Identity Number**.

32. Enter the **Document Issue Date**.

33. Enter the **Document Expiration Date**.

34. Enter the **Country of Issuance**.

35. Select the **State/Province of Issuance**.

36. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Secondary Proof of Identity task will not be available or present on the Sponsor’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the
Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

37. Give the primary proof of identity document back to the Sponsor.

38. Click Next.
   - Result: The Add Family wizard advances to the Category and Details task.

39. Select the Category from the available category folders in the Category area.

40. Enter the Date of Accession.

41. Enter the Date of Termination.
   - Result: The number of days for which the category is valid automatically adjusts.

42. Enter the Sponsor’s Work E-mail address.

43. Select the Sponsor’s appropriate Service Branch or Sponsoring Agency and Sub-Agency using the appropriate drop-down menu.
   - Result: Available pay categories adjust according to branch selection.

44. Select the appropriate DoD Sponsoring Agency from the DoD Sponsoring Agency drop-down menu if applicable.

45. Click Next.
   - Result: The Add Family wizard advances to the Features Information task.

46. Select the Sponsor’s Gender in the Gender area.

47. Select the Sponsor’s Marital Status in the Marital Status area.

48. Enter the Sponsor’s Date of Birth in the Date of Birth field.

49. Enter the Sponsor’s Eye Color in the Eye Color field.

50. Enter the Sponsor’s Height in the Height field.

51. Enter the Sponsor’s Hair Color in the Hair Color field.

52. Enter the Sponsor’s Weight in the Weight field.

53. Select the Sponsor’s Organ Donor Status from the Organ Donor drop-down menu.

54. Select the Sponsor’s Blood Type from the Blood Type drop-down menu.

55. Click Next.
   - Result: The Add Family wizard advances to the Home Address task.
56. Enter the Sponsor’s **Home Address** in the Home Address area.

57. Enter the Sponsor’s **Mailing Address** in the Mailing Address area.

58. Click **Next**.
   - Result: The *Add Family* wizard advances to the Contact Information task.

59. Enter the Sponsor’s **E-mail Addresses** in the E-mail area.

60. Enter the Sponsor’s **Phone Numbers** in the Telephone area.

61. Click **Next**.
   - Result: The *Add Family* wizard advances to the Creating Family task.
   - Result: The *Add Family* wizard advances to the Summary task.

62. Review the information in the Summary Task screen for accuracy.

63. Click **Finish**.
   - Result: The *Add Family* wizard closes.

64. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.9.14 Add a Foreign Military Affiliate to DEERS

1. Complete the steps necessary to log on to RAPIDS.
   - Result: RAPIDS opens to the default state of the Overview screen.

2. Open the *Add Family* wizard.

   **Option 1 (Toolbar):**
   a. Click the **New Family** icon.
      - Result: The *Add Family* wizard opens.

   **Option 2 (Menu Bar):**
   a. Click **File > New Family**.
      - Result: The *Add Family* wizard opens.

3. Enter the **Sponsor’s Name** in the Name area of the *Add Family* wizard.

4. Select the provided **Primary ID Number** from the Primary drop-down menu.
   - Result: The field to the right adjusts according to the type of ID number selected.

5. Enter the **Primary ID Number** unless automatically generated.
6. **Click Next.**
   - Result: The *Add Family* wizard advances to the Looking for Person task.
   - Result: The *Add Family* wizard advances to the Primary Proof of Identity task.

7. Ask the Sponsor for his or her primary proof of identity and complete the steps necessary to verify the document’s authenticity.

8. Select a **Primary Proof of Identity** document type in the Identity Document Selection area.
   - Result: Fields in the Document Details area adjust according to the document type.

9. Place the Sponsor’s primary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

10. **Click** **Scan** in the *Add Family* wizard.
    - Result: The *RAPIDS - Scan Document* window opens.

11. **Click** **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
    - Result: RAPIDS scans the primary proof of identity document.

12. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

13. **Click** **OK.**
    - Result: The *RAPIDS - Scan Document* window closes.

14. Remove the primary proof of identity document from the scanner.

In the Document Details area of the Select Primary Proof of Identity task of the *Add Family* wizard—

15. Enter the **Document Serial/Identity Number.**

16. Enter the **Document Issue Date.**

17. Enter the **Document Expiration Date.**

18. Enter the **Country of Issuance.**

19. Select the **State/Province of Issuance.**

20. Enter the **County/City of Issuance.**

**Note:** In some cases, the information required to complete the Document Details area of the Select Primary Proof of Identity task will not be available or present on the Sponsor’s proof of
identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

21. Give the primary proof of identity document back to the Sponsor.

22. Click Next.
   ▪ Result: The Add Family wizard advances to the Secondary Proof of Identity task.

23. Ask the Sponsor for his or her secondary proof of identity and complete the steps necessary to verify the document’s authenticity.

   ▪ Result: Fields in the Document Details area adjust accessibility according to the document type.

25. Place the Sponsor’s secondary proof of identity document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

26. Click Scan in the Add Family wizard.
   ▪ Result: The RAPIDS - Scan Document window opens.

27. Click Preview Scanned Document in the RAPIDS - Scan Document window.
   ▪ Result: RAPIDS scans the secondary proof of identity document.

28. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

29. Click OK.
   ▪ Result: The RAPIDS - Scan Document window closes.

30. Remove the secondary proof of identity document from the scanner.

In the Document Details area of the Select Secondary Proof of Identity task of the Add Family wizard—

31. Enter the Document Serial/Identity Number.

32. Enter the Document Issue Date.

33. Enter the Document Expiration Date.

34. Enter the Country of Issuance.
35. Select the **State/Province of Issuance**.

36. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Secondary Proof of Identity task will not be available or present on the Sponsor’s proof of identity. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

37. Give the primary proof of identity document back to the Sponsor.

38. Click **Next**.
   - Result: The *Add Family* wizard advances to the Category and Details task.

39. Select **Foreign Affiliate** from the available category folders in the Category area.

40. Enter the Sponsor’s **Work E-mail** address.

41. Select the **Foreign Affiliate Type** from the Foreign Affiliate Type drop-down menu.
   - Result: The Select Personnel Status Pay Category Details and Add Additional Details areas adjust according to the foreign affiliate type selected.
42. Select the Sponsor’s appropriate Service Branch or Sponsoring Agency and Sub-Agency using the appropriate drop-down menu.
   - Result: Available pay categories adjust according to branch selection.

43. Select the appropriate DoD Sponsoring Agency from the DoD Sponsoring Agency drop-down menu if applicable.

44. Click Next.
   - Result: The Add Family wizard advances to the Features Information task.

45. Select the Sponsor’s Gender in the Gender area.

46. Select the Sponsor’s Marital Status in the Marital Status area.

47. Enter the Sponsor’s Date of Birth in the Date of Birth field.

48. Enter the Sponsor’s Eye Color in the Eye Color field.

49. Enter the Sponsor’s Height in the Height field.

50. Enter the Sponsor’s Hair Color in the Hair Color field.

51. Enter the Sponsor’s Weight in the Weight field.

52. Select the Sponsor’s Organ Donor Status from the Organ Donor drop-down menu.

53. Select the Sponsor’s Blood Type from the Blood Type drop-down menu.

54. Click Next.
   - Result: The Add Family wizard advances to the Home Address task.

55. Enter the Sponsor’s Home Address in the Home Address area.

56. Enter the Sponsor’s Mailing Address in the Mailing Address area.

57. Click Next.
   - Result: The Add Family wizard advances to the Contact Information task.

58. Enter the Sponsor’s E-mail Addresses in the E-mail area.

59. Enter the Sponsor’s Phone Numbers in the Telephone area.

60. Click Next.
   - Result: The Add Family wizard advances to the Creating Family task.
   - Result: The Add Family wizard advances to the Summary task.
61. Review the information in the Summary Task screen for accuracy.

62. Click **Finish**.
   - Result: The *Add Family* wizard closes.

63. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

**8.9.15 Retire a DoD Civil Service member**

A DoD Civilian Retiree is someone that was formerly a DoD Civil Service Member but has retired and now falls under the personnel category of DoD Civilian Retiree. As a VO, you have the ability to add this personnel category to individuals that already exist in DEERS.

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the **Remove Personnel Status** wizard.

   **Option 1 (File Menu):**
   a. Click `Sponsor > Personnel Record > End Personnel Status > [Civil Service (DoD and Uniformed Service)]`.
      - Result: The *Remove Personnel Status* wizard opens.

   **Option 2 (Family Tree):**
   a. Right-click the `[Civil Service (DoD and Uniformed Service)] folder > Personnel Status Details > End Personnel Status`.
      - Result: The *Remove Personnel Status* wizard opens.

   **Option 3 (Person Viewer):**
   a. Click the `[Civil Service (DoD and Uniformed Service)] status in the Current Personnel(s) area of the Person Viewer.
      - Result: The [Civil Service (DoD and Uniformed Service)] tab is active in the Personnel Status screen in the Person Viewer.
   b. Click **End Personnel Status Due To** drop-down menu.
   c. Select **Retirement**.
      - Result: The *Remove Personnel Status* wizard opens.

3. Select **Retirement** from the Due To drop-down menu in the *Remove Personnel Status* wizard.

4. Enter the **Retirement Date** in the Retirement Date field.

5. Select the appropriate **Retirement Type** in the Retirement Type area.
6. Click Next.
   - Result: The Remove Personnel Status wizard advances to the Send to Server task.
   - Result: The Remove Personnel Status wizard advances to the Summary task.

7. Review the information in the Summary task in the Remove Personnel Status wizard for accuracy.

8. Click Finish.
   - Result: The Remove Personnel Status wizard closes.

9. Click the Save Family to DEERS icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

Note: Terminated relationships, personnel categories, and ID cards are shown in red text.

**Note:** DoD Civilian Retirees may be eligible for the DoD Civilian Retiree card if their personnel category has been verified by the civilian personnel pay system. A personnel category that has been verified by the civilian personnel pay service will show on the RAPIDS Sponsor Confirmation tab as Verified. This ID card uses chipless cardstock and you must remember to place chipless cardstock in the printer before issuing the Civilian Retiree card. DoD Civilian Retirees do not receive ID cards that contain a chip.

### 8.9.16 Update Active Duty Sponsor to Temporary Disabled Retirement List (TDRL)

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Remove Personnel Status wizard.

   Option 1 (File Menu):
   a. Click Sponsor > Personnel Record > End Personnel Status > [Active Duty].
- Result: The Remove Personnel Status wizard opens.

Option 2 (Family Tree):
  - Result: The Remove Personnel Status wizard opens.

Option 3 (Person Viewer):
- a. Click the [Active Duty] status in the Current Personnel(s) area of the Person Viewer.
- b. Click End Personnel Status Due To drop-down menu.
- c. Select Retirement.
  - Result: The Remove Personnel Status wizard opens.

3. Select Retirement from the Due To drop-down menu in the Remove Personnel Status wizard.
   - The Remove Personnel Status wizard opens to the Remove Personnel Status task.

4. Enter a Retirement Date in the Retirement Date field.

5. Click Temp. Disabled List in the Retirement Type area.

6. Click Next.
   - Result: The Remove Personnel Status wizard advances to the Send to Server task.
   - Result: The Remove Personnel Status wizard advances to the Summary task.

7. Review the information in the Summary task in the Remove Personnel Status wizard for accuracy.

8. Click Finish.
   - Result: The Remove Personnel Status wizard closes.

9. Click the Save Family to DEERS icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

**8.9.17 Update TDRL Sponsor to Permanently Disabled Retired List (PDRL)**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the [Retired] tab of the Sponsor’s personnel status in the Person Viewer.
Option 1 (File Menu):
  a. Click Sponsor > Personnel Record > [Retired].
     ▪ Result: The [Retired] tab of the Sponsor’s personnel status opens in the Person Viewer.

Option 2 (Family Tree):
  a. Click the [Folder] folder.
     b. Click Personnel Status.
        ▪ Result: The [Retired] tab of the Sponsor’s personnel status opens in the Person Viewer.

Option 3 (Person Viewer):
  a. Click the [Retired] status in the Current Personnel(s) area of the Person Viewer.
     ▪ Result: The [Retired] tab is active in the Personnel Status screen in the Person Viewer.

3. Click Perm. Disable List in the Update Additional Details area of the Person Viewer.

4. Enter the Date of Permanent Disability.

5. Click the Save Family to DEERS icon in the Toolbar.
   ▪ Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

8.9.18 Terminate Sponsor for End of Contract

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   ▪ Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Remove Personnel Status wizard.

Option 1 (File Menu):
  a. Click Sponsor > Personnel Record > End Personnel Status > [Active Duty].
     ▪ Result: The Remove Personnel Status wizard opens.

Option 2 (Family Tree):
     ▪ Result: The Remove Personnel Status wizard opens.

Option 3 (Person Viewer):
  a. Click the [Active Duty] status in the Current Personnel(s) area of the Person Viewer.
  b. Click **End Personnel Status Due To** drop-down menu.
  c. Select **Retirement**.
    - Result: The *Remove Personnel Status* wizard opens.

3. Select **Separation** from the Due To drop-down menu in the *Remove Personnel Status* wizard.

4. Enter a **Separation Date** in the Retirement Date field.

5. Enter the **Separation Program Designator Code** (found on DD Form 214).

6. Enter the **Re-Enlistment Eligibility Code** (found on DD Form 214).

7. Select a **Character of Service** in the Character of Service field.

8. Select **Yes** or **No** in the Stop Loss drop-down menu.

9. Select **Yes** or **No** in the Contingency drop-down menu.

10. Click **Next**.
    - Result: The *Remove Personnel Status* wizard advances to the Send to Server task.
    - Result: The *Remove Personnel Status* wizard advances to the Summary task.

11. Review the information in the Summary task for accuracy.

12. Click **Finish**.
    - Result: The *Remove Personnel Status* wizard closes.

13. Click the **Save Family to DEERS** icon in the Toolbar.
    - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

**8.9.19 Update a Military Sponsor’s Marriage Status to Reflect a Joint Service Marriage**

A Joint Service Marriage (JSM) indicates that a Sponsor is married to another Sponsor. As new populations, such as DoD civilians and contractors, are added to DEERS, the JSM rules can be expanded to include these populations. Sites should regularly refer to regulation updates. Current regulations do not support enrolling family members under more than one Sponsor in a JSM for the same benefits.

**Exception:** The Family Member Service Members’ Group Life Insurance (FMSGLI) Program, effective October 1, 2001, requires military spouses to be enrolled under each other’s DEERS record to establish the relationship condition before electing to receive, reduce, or decline the FMSGLI benefit.
8.10 ID CARD OPERATIONS—FAMILY MEMBER

8.10.1 Create a DD Form 1172

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   ▪ Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the *Forms* wizard.
   
   Option 1 (Menu Bar):
   a. Click View > *Forms* > *Create DD Forms*.
      ▪ Result: The *Forms* wizard opens.

   Option 2 (Menu Bar):
   a. Click Sponsor > *Create DD Forms*.
      ▪ Result: The *Forms* wizard opens.

   Option 3 (Menu Bar):
   a. Click Family > *Create DD Forms*.
      ▪ Result: The *Forms* wizard opens.

   Option 4 (Toolbar):
   a. Click the *Create DD Form* icon.
      ▪ Result: The *Forms* wizard opens.

3. Click the *DD Form 1172* in the Select a Form area.

4. Ensure that the *Fields Populated From Existing Data Within DEERS* radio button is selected in the Form Options area.

5. Click the *I Would Also Like to Choose an IO Other Than: (Your Last Name, First Name)* checkbox.

   **Note:** Ignore this step if the VO is also issuing the card.

6. Click *Next*.
   ▪ Result: The *Forms* wizard advances to the Select Personnel Status task.

7. Click the Personnel Status radio button of the personnel status you would like to use for the DD Form 1172.

8. Click *Next*.
   ▪ Result: The *Forms* wizard advances to the Include Family Members task.
9. Click the **Family Member** checkbox(s) of the family member(s) you would like to include on the DD Form 1172.

10. Click **Next**.
    - Result: The *Forms* wizard advances to the Adjust expiration dates of ID cards of family members task.

**Note:** The VO may adjust expiration dates on this screen. However, the VO must select a valid reason in the Reason drop-down list.

11. Click **Next**.
    - Result: The *Forms* wizard advances to the Select Remarks task.

12. Click a **Remark** in the Remarks area.
    - Result: The remark is be highlighted in blue.

**Note:** If you hold down CTRL while selecting remarks, you can select multiple remarks at one time.

13. Click the **Insert Remark(s) Below** button to add remark(s) to the form.
    - Result: The remarks that you have inserted appear in the Selected Remarks field.

14. Click **Next**.
    - Result: The *Forms* wizard advances to the Select IO task.

15. Uncheck the **Display the Issuing Official’s Information on This Form** checkbox to remove IO information on the DD Form 1172.

**Note:** Perform this action when the VO does not know who the IO is.

16. Click **Next**.
    - Result: The *Forms* wizard advances to the Verify IO task.

**Note:** The VO only verifies the IO’s credentials when the IO is present at the time of DD Form 1172 issuance.

17. Click **Next**.
    - Result: The *Forms* wizard advances to the View/Edit PDF task.

18. Verify information on the DD Form 1172.

19. Click **Print** when ready to print.
    - Result: The Printer dialog box displays.

20. Select **Laser Printer** and click **OK**.
    - Result: The DD Form 1172 should print from the laser printer.
21. Click **Summary**.
   - Result: The *Forms* wizard advances to the Summary Page task.

22. Click **Finish**.
   - Result: The *Forms* wizard closes.

### 8.10.2 Add a family member (newborn) with a Temporary Identification Number (TIN) to a Sponsor’s record in RAPIDS

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the *Add Family Member* wizard.

   **Option 1 (Person Viewer):**
   - a. Click **Add Family Member** on the Beneficiary Record bar.
      - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

   **Option 2 (Menu Bar):**
   - a. Click **Family > Add Family Member**.
      - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

   **Option 3 (Toolbar):**
   - a. Click the **Add Family Members** icon.
      - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

3. Enter the **Date of Birth** in the Date of Birth field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

4. Select **Child** in the Type field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

5. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the ID Information task.

6. Enter the **Child’s Name** in the Name area of the *Add Family Member* wizard.

7. Select **Temporary ID Number (GENERATED)** from the Primary drop-down menu.
   - Result: The Temporary ID Number auto populates.

8. Click **Next**.
- Result: The *Add Family Member* wizard advances to the Primary Proof of Relationship task.

9. Ask the Sponsor for child’s primary proof of relationship document and complete the steps necessary to verify the document’s authenticity.

10. Select a **Primary Proof of Relationship** document type in the Primary Document(s) area.
    - Result: Fields in the Document Details area adjust according to the document type.

11. Place the child’s primary proof of relationship document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

12. Click **Scan** in the *Add Family Member* wizard.
    - Result: The *RAPIDS - Scan Document* window opens.

13. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
    - Result: RAPIDS scans the primary proof of relationship document.

14. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

15. Click **OK**.
    - Result: The *RAPIDS - Scan Document* window closes.

16. Remove the primary proof of relationship document from the scanner.

In the Document Details area of the Primary Proof of Relationship task of the *Add Family wizard*—

17. Enter the **Document Serial/Identity Number**.

18. Enter the **Document Issue Date**.

19. Enter the **Document Expiration Date**.

20. Enter the **Country of Issuance**.

21. Select the **State/Province of Issuance**.

22. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Primary Proof of Relationship task will not be available or present on the child’s proof of relationship document. When this information is unavailable, leave the fields blank.
23. Give the primary proof of relationship back to the Sponsor.

24. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Features Information task.

25. Select the child’s **Gender** in the Gender area.

26. Enter the child’s **Date of Birth** in the Date of Birth field.

27. Enter the child’s **Eye Color** in the Eye Color field.

28. Enter the child’s **Height** in the Height field.

29. Enter the child’s **Hair Color** in the Hair Color field.

30. Enter the child’s **Weight** in the Weight field.

**Complete the Options for Addresses area:**

31. Click the **Home Address is Same as Sponsor** checkbox.

32. Click the **Mailing Address is Same as Sponsor** checkbox.

33. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Contact Information task.

34. The child lives with the Sponsor and has the same contact information as the Sponsor. Enter the Sponsor’s **Phone Numbers** in the Telephone area.

35. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Adding a Family Member task.
   - Result: The *Add Family Member* wizard advances to the Summary task.

36. Review the information in the Summary Task screen for accuracy.

37. Click **Finish**.
   - Result: The *Add Family Member* wizard closes.

38. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

**8.10.3 Update a newborn child’s record (e.g., TIN to SSN)**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
• Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Click the child’s Folder in the Family Tree.
   • Result: The child’s record shows in the Person Viewer.

3. Click the Characteristics icon in the Icon Bar.
   • Result: The Identity tab in the Characteristics view of the Person Viewer becomes active.

4. Click Edit in the Personal Identifier area of the Identity tab.
   • Result: The Change Identifier wizard opens with the TIN showing as the primary personal identifier.

5. Click the Primary radio button.

6. Click the Primary drop-down menu.

7. Click Social Security Number.

8. Ask the Sponsor for the child’s Social Security Card and complete the steps necessary to verify the document’s authenticity.

9. Enter the child’s Social Security Number as it appears on the child’s Social Security Card.

10. Click Next.
    • Result: The Change Identifier wizard advances to the Change Identifier Documentation task.

11. Ask the Sponsor for the child’s identifier documentation and complete the steps necessary to verify the document’s authenticity.

12. Select an Identifier Documentation type in the Change Identifier Document(s) area.
    • Result: Fields in the Document Details area adjust according to the document type.

13. Place the child’s identifier documentation face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

14. Click Scan in the Change Identifier wizard.
    • Result: The RAPIDS - Scan Document window opens.

15. Click Preview Scanned Document in the RAPIDS - Scan Document window.
    • Result: RAPIDS scans the identifier documentation document.
16. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

17. Click OK.
   - Result: The RAPIDS - Scan Document window closes.

18. Remove the identifier documentation document from the scanner and give it back to the Sponsor.

In the Document Details area of the Change Identifier Documentation task of the Change Identifier wizard—

19. Enter the Document Serial/Identity Number. This number should be the child’s SSN.

   Note: The SSN that is entered in the Change Identifier wizard as the new primary personal identification number should also be used as the document serial/identity number in the Document Details area of the Change Identifier wizard. Do not include punctuation or hyphens when entering the SSN in the Document Serial/Identity Number field. This number should match the number on the child’s Social Security Card.

20. Select the State/Province of Issuance.

21. Click Next.
   - Result: The Change Identifier wizard advances to the Send to Server task.
   - Result: The Change Identifier wizard advances to the Summary task.

22. Review the information in the Summary Task screen for accuracy.

23. Click Finish.
   - Result: The Change Identifier wizard closes.

24. Click the Save Family to DEERS icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

8.10.4 Add a foreign national family member without A Social Security Number (SSN)

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the Add Family Member wizard.

   Option 1 (Person Viewer):
   a. Click Add Family Member on the Beneficiary Record bar.
- Result: The *Add Family Member* wizard opens to the Relationship and Details task.

Option 2 (Menu Bar):
- a. Click **Family > Add Family Member**.
  - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

Option 3 (Toolbar):
- a. Click the **Add Family Members** icon.
  - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

3. Enter the **Date of Birth** in the Date of Birth field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

4. Select **Spouse** in the Type field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

5. Enter the **Date of Marriage** in the Date of Marriage field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

6. Click **Next**.
  - Result: The *Add Family Member* wizard advances to the ID Information task.

7. Enter the **Family Member’s Name** in the Name area of the *Add Family Member* wizard.

8. Select **Foreign Identification Number (GENERATED)** from the Primary drop-down menu.
  - Result: The Foreign Identification Number auto-populates.

9. Click **Next**.
  - Result: The *Add Family Member* wizard advances to the Primary Proof of Relationship task.

10. Ask the Sponsor for spouse’s primary proof of relationship document and complete the steps necessary to verify the document’s authenticity.

11. Select a **Primary Proof of Relationship** document type in the Identity Document Selection area.
  - Result: Fields in the Document Details area adjust according to the document type.

12. Place the spouse’s primary proof of relationship document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner.
of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

13. Click **Scan** in the *Add Family Member* wizard.
   ▪ Result: The *RAPIDS - Scan Document* window opens.

14. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
   ▪ Result: RAPIDS scans the primary proof of relationship document.

15. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

16. Click **OK**.
   ▪ Result: The *RAPIDS - Scan Document* window closes.

17. Remove the primary proof of relationship document from the scanner.

In the Document Details area of the Primary Proof of Relationship task of the *Add Family* wizard—

18. Enter the **Document Serial/Identity Number**.

19. Enter the **Document Issue Date**.

20. Enter the **Document Expiration Date**.

21. Enter the **Country of Issuance**.

22. Select the **State/Province of Issuance**.

23. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Primary Proof of Relationship task will not be available or present on the spouse’s proof of relationship document. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

24. Give the primary proof of relationship document back to the Sponsor.

25. Click **Next**.
   ▪ Result: The *Add Family Member* wizard advances to the Secondary Proof of Relationship task.

26. Ask the Sponsor for the spouse’s secondary proof of relationship document and complete the steps necessary to verify the document’s authenticity.
27. Select a **Secondary Proof of Relationship** document type in the Identity Document Selection area.
   - Result: Fields in the Document Details area adjust according to the document type.

28. Place the spouse’s secondary proof of relationship document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

29. Click Scan in the Add Family Member wizard.
   - Result: The RAPIDS - Scan Document window opens.

30. Click Preview Scanned Document in the RAPIDS - Scan Document window.
   - Result: RAPIDS scans the secondary proof of relationship document.

31. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

32. Click OK.
   - Result: The RAPIDS - Scan Document window closes.

33. Remove the secondary proof of relationship document from the scanner.

In the Document Details area of the Secondary Proof of Relationship task of the Add Family wizard—

34. Enter the **Document Serial/Identity Number**.

35. Enter the **Document Issue Date**.

36. Enter the **Document Expiration Date**.

37. Enter the **Country of Issuance**.

38. Select the **State/Province of Issuance**.

39. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Secondary Proof of Relationship task will not be available or present on the spouse’s proof of relationship document. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

40. Give the secondary proof of relationship document back to the Sponsor.

41. Click Next.
- Result: The *Add Family Member* wizard advances to the Features Information task.

42. Select the Spouse’s **Gender** in the Gender area.

43. Enter the Spouse’s **Date of Birth** in the Date of Birth field.

44. Enter the Spouse’s **Eye Color** in the Eye Color field.

45. Enter the Spouse’s **Height** in the Height field.

46. Enter the Spouse’s **Hair Color** in the Hair Color field.

47. Enter the Spouse’s **Weight** in the Weight field.

Complete the Options for Addresses area:

48. Click the **Home Address is Same as Sponsor** checkbox.

49. Click the **Mailing Address is Same as Sponsor** checkbox.

50. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Contact Information task.

51. The spouse lives with the Sponsor and has the same contact information as the Sponsor. Enter the Sponsor’s **Phone Numbers** in the Telephone area.

52. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Adding a Family Member task.
   - Result: The *Add Family Member* wizard advances to the Summary task.

53. Review the information in the Summary Task screen for accuracy.

54. Click **Finish**.
   - Result: The *Add Family Member* wizard closes.

55. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

**8.10.5 Change the status of a family member to a full-time student**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.
2. Click the **Child’s Folder** in the Family Tree.
   - Result: The child’s record shows in the Person Viewer.

3. Click the **Characteristics** icon in the Icon Bar.
   - Result: The Identity tab in the Characteristics view of the Person Viewer becomes active.

4. Click the **Extended Eligibility** tab.

5. Click the **Add Condition of** drop-down menu.

6. Select **Full-Time Student**.
   - Result: The *Add Extended Eligibility* wizard opens.

Complete the *Add Extended Eligibility* wizard as follows:

7. Enter the **Date of Enrollment**.

8. Enter the **Number of Days**.

9. Enter the **Date of Graduation (estimated)**.

10. Click **OK**.
    - Result: The *Add Extended Eligibility* progress wizard opens.
    - Result: The *Add Extended Eligibility* progress wizard closes.

11. Click the **Save Family to DEERS** icon in the Toolbar.
    - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.10.6 Update a child’s record to reflect permanent incapacitation

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Click the **Child’s Folder** in the Family Tree.
   - Result: The child’s record shows in the Person Viewer.

3. Click the **Characteristics** icon in the icon bar.
   - Result: The Identity tab in the Characteristics view of the Person Viewer becomes active.

4. Click the **Extended Eligibility** tab.

5. Click the **Add Condition of** drop-down menu.
6. Select **Permanent Incap.**
   - Result: The *Add Extended Eligibility* wizard opens.

Complete the *Add Extended Eligibility* wizard as follows:

7. Enter the **Date of Incapacitation**.

8. Click **OK**.
   - Result: The *Add Extended Eligibility* progress window opens.
   - Result: The *Add Extended Eligibility* progress window closes.

9. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

8.10.7 **Update a Sponsor’s record for a child’s relationship after the parents are divorced**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the *Add Relationship: (Condition)* wizard.

   Option 1 (Menu Bar):
   a. Click the **child’s Folder** in the Family Tree.
      - Result: The child’s information shows in the Person Viewer.
   b. Click the **Family > Child’s Name > Relationships > Child > Add Condition**.
      - Result: The *Add Relationship: (Condition)* wizard opens.

   Option 2 (Person Viewer):
   a. Click the **child’s Folder** in the Family Tree.
      - Result: The child’s information shows in the Person Viewer.
   b. Click **Add** in the Relationship Status bar.
      - Result: The *Add Relationship: (Condition)* wizard opens.

3. Select **Sponsor Provides Over 50% Support** in the Condition area.

4. Enter the date the child moved out of Sponsor’s household in the Date Moved Out of Sponsor’s Household field.

5. Click **Next**.
   - Result: The *Add Relationship: (Condition)* wizard advances to the Send to Server task.
6. Review the information in the Summary task for accuracy.

7. Click Finish.
   - Result: The Add Relationship: (Condition) wizard closes.

Note: A new tab appears in the Relationship Status screen with the updated relationship.

8. Click the Save Family to DEERS icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

8.10.8 End a Sponsor’s relationship to a spouse due to divorce

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Click the spouse’s Folder in the Family Tree.
   - Result: The spouse’s record shows in the Person Viewer.

3. Open the Remove Relationship wizard.

Option 1 (Family Tree):
   a. Right-click the spouse’s Folder.
      - Result: The right-click menu opens.
   b. Select Relationship(s) > End Relationship Status.
      - Result: The Remove Relationship wizard opens.

Option 2 (Icon Bar):
   a. Click the Relationship Status icon.
      - Result: The spouse’s Relationship Status tab shows in the Person Viewer.
   b. Select the Spouse radio button in the Current Relationship Status area.
   c. Select End Relationship Due To: > Divorce.
      - Result: The Remove Relationship wizard opens.

Option 3 (Person Viewer):
   a. Click Current Relationship(s) in the Person Viewer.
      - Result: The spouse’s Relationship Status tab shows in the Person Viewer.
   b. Select the Spouse radio button in the Current Relationship Status area.
   c. Select End Relationship Due To: > Divorce.
      - Result: The Remove Relationship wizard opens.

Option 4 (Person Viewer):
   a. Click End Relationship in the Beneficiary Record For bar.
- Result: The Remove Relationship wizard opens.

Option 5 (Menu Bar):
- Click **Family** > **Relationships** > **End Relationship Status**.
  - Result: The Remove Relationship wizard opens.

4. Select **Divorce** from the Due To drop-down menu.
5. Enter the date when the removal of relationship will take place.
6. Click **Next**.
   - Result: The Remove Relationship wizard advances to the Primary Relationship Termination Documentation task.
7. Ask the Sponsor for the divorce decree document and complete the steps necessary to verify the document’s authenticity.
8. Select the **Divorce Decree** radio button in the Relationship Termination Supporting Document(s) area.
   - Result: Fields in the Relationship Termination Supporting Document(s) area adjust according to the document type.
9. Place the divorce decree document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.
10. Click **Scan** in the Remove Relationship wizard.
    - Result: The RAPIDS - Scan Document window opens.
11. Click **Preview Scanned Document** in the RAPIDS - Scan Document window.
    - Result: RAPIDS scans the divorce decree document.
12. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.
13. Click **OK**.
    - Result: The RAPIDS - Scan Document window closes.
14. Remove the divorce decree document from the scanner.

In the Document Details area of the Remove Relationship wizard—

15. Enter the **Document Serial/Identity Number**.
16. Enter the **Document Issue Date**.
17. Enter the Document Expiration Date.

18. Enter the Country of Issuance.

19. Select the State/Province of Issuance.

20. Enter the County/City of Issuance.

**Note:** In some cases, the information required to complete the Document Details area of the Primary Relationship Termination Documentation task will not be available or present on the Sponsor’s divorce decree document. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

21. Give the primary relationship termination document back to the Sponsor.

22. Click Next.
   - Result: The Remove Relationship wizard advances to the Beneficiary Determination task.

Complete the DoD Beneficiary Determination area:

23. Click the Actual Years Married drop-down menu to select the actual years married.

24. Click the Actual Years Sponsor Was in Service drop-down menu to select the actual years the Sponsor was in service.

25. Click the Actual Years of Overlap drop-down menu to select the actual years of overlap.

**Note:** The Overlap Code field auto-populates.

26. Click Next.
   - Result: The Remove Relationship wizard advances to the DoD Beneficiary Documentation task.

27. Ask the Sponsor for the supporting document and complete the steps necessary to verify the document’s authenticity.

28. Select the provided DoD Beneficiary Supporting Document(s).
   - Result: Fields in the DoD Beneficiary Supporting Document(s) area adjust according to the document type.

29. Place the supporting document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.
30. Click **Scan** in the *Remove Relationship* wizard.  
   - Result: The *RAPIDS - Scan Document* window opens.

31. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.  
   - Result: RAPIDS scans the supporting document.

32. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

33. Click **OK**.  
   - Result: The *RAPIDS - Scan Document* window closes.

34. Remove the supporting document from the scanner.

In the Document Details area of the *Remove Relationship* wizard—

35. Enter the **Document Serial/Identity Number**.

36. Enter the **Document Issue Date**.

37. Enter the **Document Expiration Date**.

38. Enter the **Country of Issuance**.

39. Select the **State/Province of Issuance**.

40. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the DoD Beneficiary Supporting Document(s) task will not be available or present on the Sponsor’s supporting document. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

41. Give the DoD beneficiary supporting document back to the Sponsor.

42. Click **Next**.  
   - Result: The *Remove Relationship* wizard advances to the Add Other Health Insurance task.

43. Complete the Add Other Health Insurance area if applicable.

44. Click **Next**.  
   - Result: The *Remove Relationship* wizard advances to the Send to Server task.  
   - Result: The *Remove Relationship* wizard advances to the Summary task.
45. Review the information in the Summary task in the Remove Relationship wizard for accuracy.

46. Click Finish.
   - Result: The Remove Relationship wizard closes.

47. Click the Save Family to DEERS icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

8.10.9 Change a Family Member (Child) from one Sponsor’s record to a Family Member (Spouse) in another Sponsor’s record

1. Complete the steps necessary to open the current Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the current Sponsor’s information in the Person Viewer.

2. Click the child’s Folder in the Family Tree.
   - Result: The child’s record shows in the Person Viewer.

3. Open the Remove Relationship wizard.

   Option 1 (Family Tree):
   a. Right-click the child’s Folder.
      - Result: The right-click menu opens.
   b. Select Relationship(s) > End Relationship Status.
      - Result: The Remove Relationship wizard opens.

   Option 2 (Icon Bar):
   a. Click the Relationship Status icon.
      - Result: The child’s Relationship Status tab shows in the Person Viewer.
   b. Select the Child radio button in the Current Relationship Status area.
   c. Select End Relationship Due To: > Dependent Marriage.
      - Result: The Remove Relationship wizard opens.

   Option 3 (Person Viewer):
   a. Click Current Relationship(s) in the Person Viewer.
      - Result: The child’s Relationship Status tab shows in the Person Viewer.
   b. Select the Child radio button in the Current Relationship Status area.
   c. Select End Relationship Due To: > Dependent Marriage.
      - Result: The Remove Relationship wizard opens.

   Option 4 (Person Viewer):
   a. Click End Relationship in the Beneficiary Record For bar.
      - Result: The Remove Relationship wizard opens.
Option 5 (Menu Bar):
   a. Click Family > Relationships > End Relationship Status.
      ▪ Result: The Remove Relationship wizard opens.

4. Select Dependent Marriage from the Due To drop-down menu.

5. Enter the date when the removal of relationship will take place.

6. Click Next.
   ▪ Result: The Remove Relationship wizard advances to the Send to Server task.
   ▪ Result: The Remove Relationship wizard advances to the Summary task.

7. Review the information on the Summary screen for accuracy.

8. Click Finish.
   ▪ Result: The Remove Relationship wizard closes.

**Note:** Terminated relationships, personnel categories, and ID cards are shown in red text.
9. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The current Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

10. Complete the steps necessary to close the current Sponsor’s record.
    - Result: The default state of the Overview screen displays with no information in the Person Viewer.

**Note:** At this point, you have separated the family member (child over 18) from the Sponsor’s (parent’s) record. Now, complete the steps necessary to add the family member (child over 18) to the new Sponsor’s (husband’s or wife’s) record as a family member spouse.

11. Complete the steps necessary to open the target Spouse’s record
    - Result: The default state of the Overview screen displays with the target Spouse’s information in the Person Viewer.

12. Open the *Add Family Member* wizard.

    Option 1 (Person Viewer):
    a. Click **Add Family Member** on the Beneficiary Record bar.
       - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

    Option 2 (Menu Bar):
    a. Click **Family > Add Family Member**.
       - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

    Option 3 (Toolbar):
    a. Click the **Add Family Members** icon.
       - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

13. Enter the **Family Member’s Date of Birth** in the Date of Birth field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

14. Select **Spouse** in the Type field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

15. Enter the **Date of Marriage** in the Date of Marriage field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

16. Click **Next**.
    - Result: The *Add Family Member* wizard advances to the ID Information task.
17. Enter the **Family Member’s Name** in the Name area of the *Add Family Member* wizard.

18. Select **Social Security Number** from the Primary drop-down menu.

19. Enter the family member’s **Social Security Number** as shown on his or her Social Security Card.

20. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Looking for Person task.
   - Result: The *Add Family Member* wizard advances to the Existing Person task.

**Note:** You have previously separated the family member from his or her former Sponsor and will add him or her to the new Sponsor’s record because of marriage. Therefore, the family member’s information already exists in DEERS.

21. Verify that the information in the Existing Person task matches the family member you are adding to the target Sponsor’s record.

22. Select the **Add Existing Person to the Family** radio button.

23. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Primary Proof of Relationship task.

24. Ask the Sponsor for spouse’s primary proof of relationship document and complete the steps necessary to verify the document’s authenticity.
   - Result: Fields in the Document Details area adjust according to the document type.

26. Place the spouse’s primary proof of relationship document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

27. Click Scan in the Add Family Member wizard.
   - Result: The RAPIDS - Scan Document window opens.

28. Click Preview Scanned Document in the RAPIDS - Scan Document window.
   - Result: RAPIDS scans the primary proof of relationship document.

29. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

30. Click OK.
   - Result: The RAPIDS - Scan Document window closes.

31. Remove the primary proof of relationship document from the scanner.

In the Document Details area of the Primary Proof of Relationship task of the Add Family Member wizard—

   32. Enter the Document Serial/Identity Number.
   33. Enter the Document Issue Date.
   34. Enter the Document Expiration Date.
   35. Enter the Country of Issuance.
   36. Select the State/Province of Issuance.
   37. Enter the County/City of Issuance.

Note: In some cases, the information required to complete the Document Details area of the Primary Proof of Relationship task will not be available or present on the spouse’s proof of relationship document. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

   38. Give the primary proof of relationship document back to the Sponsor.
   39. Click Next.
• Result: The Add Family Member wizard advances to the Secondary Proof of Relationship task.

40. Ask the Sponsor for the spouse’s secondary proof of relationship document and complete the steps necessary to verify the document’s authenticity.

   • Result: Fields in the Document Details area adjust according to the document type.

42. Place the spouse’s secondary proof of relationship document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

43. Click Scan in the Add Family Member wizard.
   • Result: The RAPIDS - Scan Document window opens.

44. Click Preview Scanned Document in the RAPIDS - Scan Document window.
   • Result: RAPIDS scans the secondary proof of relationship document.

45. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

46. Click OK.
   • Result: The RAPIDS - Scan Document window closes.

47. Remove the secondary proof of relationship document from the scanner.

In the Document Details area of the Secondary Proof of Relationship task of the Add Family wizard—

48. Enter the Document Serial/Identity Number.

49. Enter the Document Issue Date.

50. Enter the Document Expiration Date.

51. Enter the Country of Issuance.

52. Select the State/Province of Issuance.

53. Enter the County/City of Issuance.

Note: In some cases, the information required to complete the Document Details area of the Secondary Proof of Relationship task will not be available or present on the spouse’s proof of relationship document. When this information is unavailable, leave the fields blank. Certain
fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

54. Give the secondary proof of relationship document back to the Sponsor.

55. Click Next.
   - Result: The Add Family Member wizard advances to the Features Information task.

Note: Because the family member already exists in DEERS, his or her information is automatically populated in the Features Information task. If the information in the Features Information task is incorrect, enter the updated information as needed.

56. Select the spouse’s Gender in the Gender area.

57. Enter the spouse’s Date of Birth in the Date of Birth field.

58. Enter the spouse’s Eye Color in the Eye Color field.

59. Enter the spouse’s Height in the Height field.

60. Enter the spouse’s Hair Color in the Hair Color field.

61. Enter the spouse’s Weight in the Weight field.

62. Click Next.
   - Result: The Add Family Member wizard advances to the Address Options task.

63. Click the Home Address is Same as Sponsor checkbox.

64. Click the Mailing Address is Same as Sponsor checkbox.

65. Click Next.
   - Result: The Add Family Member wizard advances to the Contact Information task.

66. The spouse lives with the Sponsor and has the same contact information as the Sponsor. Enter the Sponsor’s Phone Numbers in the Telephone area.

67. Click Next.
   - Result: The Add Family Member wizard advances to the Adding a Family Member task.
   - Result: The Add Family Member wizard advances to the Summary task.

68. Review the information in the Summary Task screen for accuracy.

69. Click Finish.
   - Result: The Add Family Member wizard closes.
70. Click the **Save Family to DEERS** icon in the Toolbar.
- Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

**8.10.10  Change entitlements/benefits eligibility from one Sponsor to another in a JSM**

1. Complete the steps necessary to open the primary Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the primary Sponsor’s information showing in the Person Viewer.

2. Click the **child’s Name** in the Family Tree.

3. Complete the steps necessary to open the child’s relationship status.

4. Click the **Child** tab.

5. Click the **Add Condition of** drop-down menu.
   - Result: The **Add Relationship: (Condition)** wizard opens.

6. Click **Receiving Entitlements Under Another Sponsor** in the Condition field in the Relationship Status area in the **Add Relationship: (Condition)** wizard.

7. Enter the **Date the Dependency Ended** in the Date Ended Dependency field.

8. Click **Next**.
   - Result: The **Add Relationship: (Condition)** wizard advances to the Send to Server task.
   - Result: The **Add Relationship: (Condition)** wizard advances to the Summary task.

9. Review the information in the Summary task in the **Add Relationship: (Condition)** wizard for accuracy.

10. Click **Finish**.

11. Click the **Save Family to DEERS** icon in the Toolbar.
    - Result: Changes to the primary Sponsor’s record save to DEERS, and RAPIDS reloads to a read-only state.

12. Complete the steps necessary to close the primary Sponsor’s record.

13. Complete the steps necessary to open the secondary Sponsor’s record and verify his or her identity.
    - Result: The default state of the Overview screen displays with the secondary Sponsor’s information showing in the Person Viewer.
14. Click the child’s Folder in the Family Tree.

15. Click Relationship Status in the Icon bar.
   - Result: The child’s relationship status is active in the Person Viewer.

16. Select the Receiving Entitlements Under Another Sponsor radio button in the Current Relationship Status area.

17. Select Separation From the End Relationship Status Due To drop-down menu in the Current Relationship Status area.
   - Result: The Remove Relationship wizard opens.

18. Enter the Date when the removal of the relationship will take effect in the Date field.

19. Click Next.
   - Result: The Remove Relationship wizard advances to the Send to Server task.
   - Result: The Remove Relationship wizard advances to the Summary task.

20. Review the information in the Summary task in the Remove Relationship wizard for accuracy.

21. Click Finish.
   - Result: The Remove Relationship wizard closes.

22. Click the Save Family to DEERS icon in the Toolbar.
   - Result: Changes to the secondary Sponsor’s record save to DEERS, and RAPIDS reverts to a read-only state.

**8.10.11 Update a JSM Sponsor to Become a Family Member Spouse Under the Other Sponsor’s Record**

This scenario can be used for any military JSM family or family member who becomes a family member entitled under the other benefit-entitled Sponsor. Situations include the following scenarios:

- **Both Active Duty**—When each Sponsor shows his or her Active Duty spouse in RAPIDS, the spouses of service members can be automatically enrolled in the spousal version of the Service Members’ Group Life Insurance (SGLI) benefit.
- **Retirement of an Active Duty Sponsor**—One member retires and becomes a family member under the other Active Duty record. (You might find that one Active Duty Sponsor is entered under another Active Duty Sponsor in JSMs.)
- **Guard/Reserve on Active Duty and Guard/Reserve Spouse**—The Guard/Reserve spouse is authorized a family member ID card under the spouse on Active Duty.
- **JSM**—One spouse separates or is terminated from the military and is entitled to family member benefits under the other spouse.
1. Complete the steps necessary to open the first Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Complete the steps necessary to open the spouse’s relationship status.
   - Result: The Spouse’s Relationship Status tab shows in the Person Viewer.

Note: If the spouse has not been added, add the spouse to the Sponsor’s record. The system automatically sets the benefits start date as the date of marriage or the Sponsor’s service start date. This date should be the day after the spouse retired, separated, or was terminated in the spouse’s DEERS record. It may be necessary to change the benefits start date.

3. Click the Add Condition of drop-down menu.

4. Select Receiving Entitlements Under Another Sponsor in the Add Condition of the drop-down menu.
   - Result: The Add Relationship: (Condition) wizard opens.

5. Enter the Date Ended Dependency in the Date Ended Dependency field. This date should be the marriage date or the active Sponsor’s start date in the military (whichever is later).

6. Deselect the Unknown checkbox.

7. Enter the Date of Termination, Separation, or Retirement in the End Date field.

8. Click Next.
   - Result: The Add Relationship: (Condition) wizard advances to the Send to Server task.
   - Result: The Add Relationship: (Condition) wizard advances to the Summary task.

9. Review the information in the Summary task for accuracy.

Note: Adding this personnel condition ensures the spouse (who is also an Active Duty Sponsor) does not show benefits as a spouse.

10. Click Finish.
    - Result: The Add Relationship: (Condition) wizard closes.

11. Open the second Sponsor’s record and repeat steps 2–7 to add the first Sponsor as a spouse.

Note: Steps 5–7 erase all benefits associated with the spouse’s record before the actual start date of the spouse dependency.

12. Click the Save Family to DEERS icon in the Toolbar.
- Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

**8.10.12 Add an illegitimate child to a Sponsor’s record in RAPIDS**

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the *Add Family Member* wizard.

   **Option 1 (Person Viewer):**
   - Click *Add Family Member* on the Beneficiary Record bar.
   - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

   **Option 2 (Menu Bar):**
   - Click *Family > Add Family Member*.
   - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

   **Option 3 (Toolbar):**
   - Click the *Add Family Members* icon.
   - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

3. Enter the *Date of Birth* in the Date of Birth field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

4. Select *Child* in the Type field in the Relationship Status: (Type) area of the *Add Family Member* wizard.
   - Result: The Add Additional Events area expands in the *Add Family Member* wizard.

5. Click Next.
   - Result: The *Add Family Member* wizard advances to the ID Information task.

6. Enter the *Child’s Name* in the Name area of the *Add Family Member* wizard.

7. Select the provided *Primary ID Number* from the Primary drop-down menu.
   - Result: The field to the right adjusts according to the type of ID number selected.

8. Enter the *Primary ID Number* unless automatically generated.

9. Click Next.
   - Result: The *Add Family Member* wizard advances to the Looking for Person task.
- Result: The *Add Family Member* wizard advances to the Primary Proof of Relationship task.

10. Ask the Sponsor for the child’s primary proof of relationship document and complete the steps necessary to verify the document’s authenticity.

11. Select a **Primary Proof of Relationship** document type in the Primary Document(s) area.
- Result: Fields in the Document Details area adjust according to the document type.

12. Place the child’s primary proof of relationship document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

13. Click **Scan** in the *Add Family Member* wizard.
- Result: The *RAPIDS - Scan Document* window opens.

14. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
- Result: RAPIDS scans the primary proof of relationship document.

15. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

16. Click **OK**.
- Result: The *RAPIDS - Scan Document* window closes.

17. Remove the primary proof of relationship document from the scanner.

In the Document Details area of the Select Primary Proof of Relationship task of the *Add Family Member* wizard—

18. Enter the **Document Serial/Identity Number**.

19. Enter the **Document Issue Date**.

20. Enter the **Document Expiration Date**.

21. Enter the **Country of Issuance**.

22. Select the **State/Province of Issuance**.

23. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Select Primary Proof of Relationship task will not be available or present on the Sponsor’s proof
of relationship document. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

24. Give the primary proof of relationship document back to the Sponsor.

25. Click Next.
   - Result: The Add Family Member wizard advances to the Features Information task.

26. Select the child’s Gender in the Gender area.

27. Enter the child’s Date of Birth in the Date of Birth field.

28. Enter the child’s Eye Color in the Eye Color field.

29. Enter the child’s Height in the Height field.

30. Enter the child’s Hair Color in the Hair Color field.

31. Enter the child’s Weight in the Weight field.

Complete the Options for Addresses area:

32. Click the Home Address is Same as Sponsor checkbox.

33. Click the Mailing Address is Same as Sponsor checkbox.

34. Click Next.
   - Result: The Add Family Member wizard advances to the Contact Information task.

35. The child lives with the Sponsor and has the same contact information as the Sponsor. Enter the Sponsor’s Phone Numbers in the Telephone area.

36. Click Next.
   - Result: The Add Family Member wizard advances to the Adding a Family Member task.
   - Result: The Add Family Member wizard advances to the Summary task.

37. Review the information in the Summary Task screen for accuracy.

38. Click Finish.
   - Result: The Add Family Member wizard closes.

39. Click the Save Family to DEERS icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.
8.10.13 Terminate a Family Member Under a Sponsor

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Click the child’s folder in the Family Tree.
   - Result: The spouse’s record shows in the Person Viewer.

3. Open the Remove Relationship wizard.

   Option 1 (Family Tree):
   a. Right-click the child’s folder.
      - Result: The right-click menu opens.
   b. Select Relationship(s) > End Relationship Status.
      - Result: The Remove Relationship wizard opens.

   Option 2 (Icon Bar):
   a. Click the Relationship Status icon.
      - Result: The child’s Relationship Status tab shows in the Person Viewer.
   b. Select the Child radio button in the Current Relationship Status area.
   c. Select End Relationship Due To: > Reason.
      - Result: The Remove Relationship wizard opens.

   Option 3 (Person Viewer):
   a. Click Current Relationship(s) in the Person Viewer.
      - Result: The child’s Relationship Status tab shows in the Person Viewer.
   b. Select the child radio button in the Current Relationship Status area.
   c. Select End Relationship Due To: > Reason.
      - Result: The Remove Relationship wizard opens.

   Option 4 (Person Viewer):
   a. Click End Relationships in the Beneficiary Record For bar.
      - Result: The Remove Relationship wizard opens.

   Option 5 (Menu Bar):
   a. Click Family > Relationships > End Relationship Status.
      - Result: The Remove Relationship wizard opens.

4. Select the Reason for Relationship Removal from the Due To drop-down menu.

5. Enter the Date when the removal of relationship will take place.

6. Click Next.
   - Result: The Remove Relationship wizard advances to the Send to Server task.
   - Result: The Remove Relationship wizard advances to the Summary task.
7. Review the information in the Summary task for accuracy.

8. Click **Finish**.
   - **Result:** The *Remove Relationship* wizard closes.

9. Click the **Save Family to DEERS** icon in the Toolbar.
   - **Result:** The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.10.14 Update a Child Who Is Living with an Ex-Spouse

**Situation 1:** Benefits Changes for a Child With Relationship Condition “Sponsor Provides Over 50% Support”—

- See the Demonstrate How to Update a Sponsor’s Record For a Child’s Relationship After the Parents Are Divorced section.

**Situation 2:** Benefits Changes for a Child With Relationship Condition “Lives with Entitled Former Spouse”—

1. Complete the steps necessary to open the Sponsor’s record and verify his or her identity.
   - **Result:** The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the **Add Relationship: (Condition)** wizard.

   **Option 1 (Menu Bar):**
   - a. Click the **child’s folder** in the Family Tree.
      - **Result:** The child’s information shows in the Person Viewer.
   - b. Click **Family > Child’s Name > Relationships > Child > Add Condition**.
      - **Result:** The *Add Relationship: (Condition)* wizard opens.

   **Option 2 (Person Viewer):**
   - a. Click the **child’s folder** in the Family Tree.
      - **Result:** The child’s information shows in the Person Viewer.
   - b. Click **Add** in the Relationship Status bar.
      - **Result:** The *Add Relationship: (Condition)* wizard opens.

3. Select **Lives With Entitled Former Spouse** in the Condition area.

4. Enter the **Date the Child Moved** to former spouse household.

5. Enter the Former Spouse’s **Personal Identifier**.
6. Click Next.
   - Result: The *Add Relationship: (Condition)* wizard advances to the Warning task.

7. Click Next.
   - Result: The *Add Relationship: (Condition)* wizard advances to the Send to Server task.
   - Result: The *Add Relationship: (Condition)* wizard advances to the Summary task.

8. Review the information in the Summary task for accuracy.

9. Click Finish.
   - Result: The *Add Relationship: (Condition)* wizard closes.

10. Click the *Save Family to DEERS* icon in the Toolbar.
    - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

8.10.15 Reestablish Dependency

1. Complete the steps necessary to open the Sponsor’s record.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open the *Add Family Member* wizard.

   Option 1 (Person Viewer):
   a. Click *Add Family Member* on the Beneficiary Record bar.
      - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

   Option 2 (Menu Bar):
   a. Click *Family > Add Family Member*.
      - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

   Option 3 (Toolbar):
   a. Click the *Add Family Members* icon.
      - Result: The *Add Family Member* wizard opens to the Relationship and Details task.

3. Enter the Family Member’s Date of Birth in the Date of Birth field in the Relationship Status: (Type) area of the *Add Family Member* wizard.

4. Select the family member’s Relationship Type in the Type field in the Relationship Status: (Type) area of the *Add Family Member* wizard.
5. Enter **Date the Relationship Began** in the Relationship Status: (Type) area of the *Add Family Member* wizard.

6. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the ID Information task.

7. Enter the family member’s **Name** in the Name area of the *Add Family Member* wizard.

8. Select **Social Security Number** from the Primary drop-down menu.

9. Enter the family member’s **Social Security Number** as shown on his or her Social Security Card.

10. Click **Next**.
    - Result: The *Add Family Member* wizard advances to the Looking for Person task.
    - Result: The *Add Family Member* wizard advances to the Existing Person task.

**Note:** You have previously separated the family member from his or her former Sponsor and will add him or her to the new Sponsor’s record. Therefore, the family member’s information already exists in DEERS.

11. Verify that the information in the Existing Person task matches the family member you are adding to the target Sponsor’s record.

12. Select the **Add Existing Person to the Family** radio button.

13. Click **Next**.
    - Result: The *Add Family Member* wizard advances to the Primary Proof of Relationship task.

14. Ask the Sponsor for family member’s primary proof of relationship document and complete the steps necessary to verify the document’s authenticity.

15. Select a **Primary Proof of Relationship** document type in the Identity Document Selection area.
    - Result: Fields in the Document Details area adjust according to the document type.

16. Place the family member’s primary proof of relationship document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.

17. Click **Scan** in the *Add Family Member* wizard.
    - Result: The *RAPIDS - Scan Document* window opens.

18. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
    - Result: RAPIDS scans the primary proof of relationship document.
19. Use the horizontal and vertical scroll bars in the RAPIDS - Scan Document window to verify that the document image contains the document’s identity numbers.

20. Click OK.
   - Result: The RAPIDS - Scan Document window closes.

21. Remove the primary proof of relationship document from the scanner.

In the Document Details area of the Primary Proof of Relationship task of the Add Family Member wizard—

22. Enter the Document Serial/Identity Number.

23. Enter the Document Issue Date.

24. Enter the Document Expiration Date.

25. Enter the Country of Issuance.

26. Select the State/Province of Issuance.

27. Enter the County/City of Issuance.

**Note:** In some cases, the information required to complete the Document Details area of the Primary Proof of Relationship task will not be available or present on the family member’s proof of relationship document. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

28. Give the primary proof of relationship document back to the Sponsor.

29. Click Next.
   - Result: The Add Family Member wizard advances to the Secondary Proof of Relationship task.

30. Ask the Sponsor for the family member’s secondary proof of relationship document and complete the steps necessary to verify the document’s authenticity.

   - Result: Fields in the Document Details area adjust according to the document type.

32. Place the family member’s secondary proof of relationship document face down on the document scanner glass with the top-left corner of the document placed in the front-right corner of the scanning bed. Gently close the scanner lid after the document is correctly positioned.
33. Click **Scan** in the *Add Family Member* wizard.
   - Result: The *RAPIDS - Scan Document* window opens.

34. Click **Preview Scanned Document** in the *RAPIDS - Scan Document* window.
   - Result: RAPIDS scans the secondary proof of relationship document.

35. Use the horizontal and vertical scroll bars in the *RAPIDS - Scan Document* window to verify that the document image contains the document’s identity numbers.

36. Click **OK**.
   - Result: The *RAPIDS - Scan Document* window closes.

37. Remove the secondary proof of relationship document from the scanner.

In the Document Details area of the Secondary Proof of Relationship task of the *Add Family Member* wizard—

38. Enter the **Document Serial/Identity Number**.

39. Enter the **Document Issue Date**.

40. Enter the **Document Expiration Date**.

41. Enter the **Country of Issuance**.

42. Select the **State/Province of Issuance**.

43. Enter the **County/City of Issuance**.

**Note:** In some cases, the information required to complete the Document Details area of the Secondary Proof of Relationship task will not be available or present on the family member’s proof of relationship document. When this information is unavailable, leave the fields blank. Certain fields in the Document Details area will not be available for data entry. These fields are dependent on the type of ID selected in the Identity Document Selection area.

44. Give the secondary proof of relationship document back to the Sponsor.

45. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Features Information task.

**Note:** Because the family member already exists in DEERS, his or her information is automatically populated in the Features Information task. If the information in the Features Information task is incorrect, enter the updated information as needed.

46. Select the family member’s **Gender** in the Gender area.
47. Enter the family member’s **Date of Birth** in the Date of Birth field.

48. Enter the family member’s **Eye Color** in the Eye Color field.

49. Enter the family member’s **Height** in the Height field.

50. Enter the family member’s **Hair Color** in the Hair Color field.

51. Enter the family member’s **Weight** in the Weight field.

52. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Address Options task.

53. Click the **Home Address is Same as Sponsor** checkbox.

54. Click the **Mailing Address is Same as Sponsor** checkbox.

55. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Contact Information task.

56. The family member lives with the Sponsor and has the same contact information as the Sponsor. Enter the Sponsor’s **Phone Numbers** in the Telephone area.

57. Click **Next**.
   - Result: The *Add Family Member* wizard advances to the Adding a Family Member task.
   - Result: The *Add Family Member* wizard advances to the Summary task.

58. Review the information in the Summary Task screen for accuracy.

59. Click **Finish**.
   - Result: The *Add Family Member* wizard closes.

60. Click the **Save Family to DEERS** icon in the Toolbar.
   - Result: The Sponsor record saves to DEERS, and RAPIDS reloads the record to a read-only state.

### 8.11 OCONUS Scenarios

#### 8.11.1 Issue an ID Card to a Foreign Military Personnel Member

If the VO is adding a Sponsor into DEERS for the first time, they should reference Table A5.1 Rule 13 in the AFI 36-3026 to determine documentation necessary to verify eligibility of Foreign Personnel.

**Note:** If the Sponsoring agency is not listed in DEERS when creating the family, the VO will have to contact the respective Service Project Office to have the agency input into DEERS.
There are additional considerations when verifying documentation provided by Foreign personnel such as English translations of foreign documentation.

When creating a new Sponsor record for Foreign Military personnel, the VO must assign a Foreign Identification Number (FIN) unless the Sponsor possesses a SSN or Individual Tax Payer Identification Number (ITIN). They should also select the Foreign Affiliate category and Foreign Military sub-category when prompted by the Add Family wizard.

- See the Add a Foreign Affiliate section for instructions on how to Add Foreign Military personnel.
- See the Add a foreign national dependent without A Social Security Number (SSN) section for instructions on how to assign an automatically generated FIN.
- See the Issue a new CAC to an Active Duty Service Member section for instructions on how to issue a CAC.

*Relevant sections in the AFI 36-3026 (1.6 Table 1.13, 1.25, 2.4.4, 18.1 Table 18.1, Attachment 2.6 (Entitlements), Attachment 5.1 Rule 13)

8.11.2 Issue an ID Card to a DoD Civilian Hired Locally on Guam Not Residing on a Military Base

If the VO is adding the Sponsor into DEERS for the first time, they should reference Table A5.1 Rule 11 in the AFI 36-3026 to determine documentation necessary to verify eligibility of a DOD Civilian employee.

Note: If the Sponsoring agency is not listed in DEERS when creating the family, the VO will have to contact the respective Service Project Office to have the agency input into DEERS.

These Sponsors will be eligible for a CAC (DoD Civilian). Please refer to the below scenario to view detailed instructions.

- See the Issue a new CAC to an Active Duty Service Member section for instructions on how to issue a CAC.

*Relevant sections in the AFI 36-3026 (1.6 Table 1.13, 18.1 Table 18.1, Attachment 2.7.3, Table A2.19 (Entitlements))

8.11.3 Issue an ID Card to a Civil Service MSC Living on Guam not Assigned to a Ship

VOs can no longer add DOD Civil Service records to DEERS. They are added by the Defense Civilian Personnel Data System (DCPDS) because some Sponsors were incorrectly added as Civil Service in the past. If the VO encounters a Sponsor that has not been entered into DEERS, refer them to their respective agencies personnel department. These Sponsors may be eligible for a CAC (DoD Civilian). Please refer to the below scenario to view detailed instructions.

- See the Issue a new CAC to an Active Duty Service Member section for instructions on how to issue a CAC.
 Issue an ID Card to a Civil Service MSC Living on Guam not Assigned to a Ship but on OCONUS Order

VOs can no longer add DOD Civil Service records to DEERS. They are added by the Defense Civilian Personnel Data System (DCPDS). If the VO encounters a Sponsor that has not been entered into DEERS, refer them to their respective civilian personnel office. DoD Civil Servants may be eligible for a CAC. Benefits and entitlements may be given to the Sponsor at the site’s discretion. However, they are not required to reside on a military installation to be eligible for the card. If hired locally, DoD Civil Servants do not receive commissary privileges. When adding the condition, the VO should select the Non-CONUS assignment. Please refer to the below scenarios to view detailed instructions.

- See the Add an overseas condition to a civilian who goes overseas for more than 1 year to accompany forces section for instructions on how to add a condition.
- See the Issue a new CAC to an Active Duty Service Member section for instructions on how to issue a CAC.

 Issue an ID Card to an MSC with Normal Residence in CONUS on an MSC Ship Serving the U.S. Only

These Sponsors may be eligible for a CAC (DOD Civilian or Contractor). Please refer to the below scenario to view detailed instructions.

- See the Issue a new CAC to an Active Duty Service Member section for instructions on how to issue a CAC.

 Issue an ID Card to an MSC with Normal Residence in CONUS on an MSC Ship Overseas

If the Sponsor is deployed overseas on an MSC-owned ship, they may be eligible for a CAC (DOD Civilian or Contractor). Please refer to the below scenarios to view detailed instructions.

- See the Issue a new CAC to an Active Duty Service Member section for instructions on how to issue a CAC.
8.11.7 Issue an ID Card to an OCONUS Family Member Spouse Who is a Local Hire DoD Employee and a Member of the Reserves, Whose Sponsor is AD

If the VO is adding the Sponsor into DEERS for the first time, they should reference Table A5.1 Rule 11 in the AFI 36-3026 to determine documentation necessary to verify eligibility for the DoD Civilian employee category.

Note: If the Sponsoring agency is not listed in DEERS when creating the family, the VO will have to contact the respective Service Project Office to have the agency input into DEERS.

In this scenario, the Spouse may be eligible for an Identification CAC (DoD Local Hire), Geneva Conventions CAC (Reserve), and a DD Form 1173 (Active Duty family member).

• See the Issue a new CAC to an Active Duty service member section for instructions on how to issue a CAC.
• See the Issue a Teslin card to a retired Sponsor section for instructions on how to issue a Teslin card.

*Relevant sections in the AFI 36-3026 (1.6 Table 1.8, Attachment 2.1 Table A2.1 (Entitlements), 1.6 Table 1.13, 18.1 Table 18.1, Attachment 2.7.2, Table A2.17 (Entitlements), 1.6 Table 1.6)

8.11.8 Issue an ID Card to a Spouse of a DoD Civilian Sponsor in an OCONUS Position Who is also Employed by DoD in an OCONUS Position

In this scenario, the Spouse may be eligible for an Identification and Privilege CAC (OCONUS DoD Civilian), and a DD Form 1173 (OCONUS DoD Civilian Family Member).

• See the Issue a new CAC to an Active Duty service member section for instructions on how to issue a CAC.
• See the Issue a Teslin card to a retired Sponsor section for instructions on how to issue a Teslin card.

*Relevant sections in the AFI 36-3026 (1.6 Table 1.8, 1.6 Table 1.13, Attachment 2.7.2, Table A2.17 (Entitlements))

8.11.9 Issue an ID Card to a Family Member of a DoD AD, DoD Civilian, or Contractor in an OCONUS Position Who is Employed in a Part Time DoD Civilian Position

In this scenario, the family member may be eligible for an Identification CAC (DoD Civilian) and a DD Form 1173 (OCONUS DoD Civilian Family Member).

• See the Issue a new CAC to an Active Duty service member section for instructions on how to issue a CAC.
• See the Issue a Teslin card to a retired Sponsor section for instructions on how to issue a Teslin card.
8.11.10  **Issue an ID Card to a Sponsor Who Has No or One Form of Identity Proof**

The first time a Sponsor is issued an ID card, they must have two forms of identification. A Sponsor can be reissued an ID card without basic documentation. In this situation, the VO could verify identity from the Sponsor’s photo and fingerprints stored in DEERS. **This should only be used in extreme circumstances when all of the customer’s ID has been lost or stolen—not as a convenience if the customer did not bring appropriate documentation. Skipping a document capture requires an SSM and will be audited.**

8.11.11  **Issue an ID Card to a Contractor With an OCONUS Condition With a Previous Active OCONUS Condition and Terminated Category**

The Sponsor would need to have their category reinstated through the Contractor Verification System (CVS). Once the category was reinstated, the VO could add the OCONUS condition and issue an ID and Privilege CAC in RAPIDS. When adding the condition, the VO should select the Non-CONUS assignment.

- See the [Add an overseas condition to a civilian who goes overseas for more than 1 year to accompany forces](#) section for instructions on how to add a condition.
- See the [Issue a new CAC to an Active Duty Service Member](#) section for instructions on how to issue a CAC.

8.11.12  **Issue an ID Card to a Foreign Affiliate Contractor**

The VO should reference Table A5.1 Rule 13 in the AFI 36-3026 to determine documentation necessary to verify eligibility of Foreign Personnel. There are additional considerations when verifying documentation provided by Foreign personnel such as English translations of foreign documentation.

Before being enrolled into DEERS, Foreign Affiliate Contractors must obtain a foreign identification number from a RAPIDS site. The VO should select the Foreign Affiliate category and Foreign Contractor sub-category when prompted by the *Add Family* wizard.

- See the [Add a Foreign Affiliate](#) section for instructions on how to add a Foreign Affiliate Contractor.
- See the [Add a foreign national dependent without A Social Security Number (SSN)](#) section for instructions on how to assign an automatically generated FIN.
- See the [Issue a new CAC to an Active Duty service member](#) section for instructions on how to issue a CAC.
8.11.13 Issue an ID Card to a Contracted MSC Not Assigned to a Ship

These Sponsors do not receive an ID card, they have to be deployed to a country on an MSC owned and operated ship.

8.11.14 Adding Non-CONUS Condition for DoD Civilian or Contractor Accompanying Forces

DoD Contractors or Civilians accompanying forces overseas for more than 1 year are entitled to a Geneva Conventions CAC. If the Sponsor is accompanying forces overseas for less than 1 year (happens only during war time), they must use their orders to verify benefits eligibility. Contractors must be entered into DEERS through CVS. Once the Sponsor is in DEERS, the VO (Trusted Agent (TA) can do this in CVS for contractors as well) must add the Accompanying Forces condition.

- See the Add an overseas condition to a civilian who goes overseas for more than 1 year to accompany forces section for instructions on how to add a condition.

8.11.15 Adding of the Non-CONUS Condition for DoD Civilians or Contractors in Order to Give Privileges Overseas

DoD Civilians or Contractors are eligible for an Identification and Privilege CAC when going on assignment overseas. The Sponsor should be issued the OCONUS CAC when they arrive at their destination country. For Sponsors going to Germany and Italy, they have to be entered into the DoD Contractor Personnel (DOCPER) system before card issuance. When adding the Non-CONUS condition, the VO should select the Non-CONUS assignment. Please refer to the below scenarios to view detailed instructions.

- See the Add an overseas condition to a civilian who goes overseas for more than 1 year to accompany forces section for instructions on how to add a condition.

Note: Civilians or Contractors on Emergency Essential orders going overseas will receive their Identification and Privilege CAC prior to arriving at their destination. Identification and Privilege CACs will not be issued in Theatre.

*Relevant sections in the AFI 36-3026 (1.6 Table 1.10)
8.11.16 Issue an ID Card to a DoD OCONUS Local Hire Who is a Foreign National, Married to a Service Member, and Has Already Been Entered into DEERS as a Family Member Spouse with His or Her Own TAX ID

The VO must obtain the existing Tax ID from DEERS by looking it up in their spouse’s record. The VO must then add a family to DEERS using the existing Tax ID and selecting the DoD OCONUS Local Hire category. Once the Sponsor was added to DEERS, the VO could issue an Identification CAC to the Sponsor.

- See the Issue a new CAC to an Active Duty Service Member section for instructions on how to issue a CAC.

*Relevant sections in the AFI 36-3026 (1.6 Table 1.13, Attachment 2.7.2, Table A2.17 (Entitlements))

8.12 Using RAPIDS in CACCIRS Mode

At a Common Access Card Central Issuance Requesting Station (CACCIRS) workstation, VOs retrieve the Sponsor's record from DEERS, verify/change the data, capture the ID photo and fingerprint, and save the record to DEERS. The printing and encoding of ID cards are done at the Central Issuance Facility (CIF); personal identification numbers (PINs) are created at another location. The CACs and PINs are then mailed to the site. Once the CACs and PINs are received by the site, the SSM/Card Receiving Manager must receive the cards in the ILP and the PIN Letter Receiving Manager must receive the PINs in the ILP. Once both items are received in the ILP, the SSM/Card Receiving Manager must accept the cards in the ILP. Failure to receive the CACs and/or PINs, as well as failure to accept the CACs in the ILP will prevent CAC recipients from accessing a DoD network. SSMs should refer to ILP User Guide located on the VOIS (https://www.dmdc.osd.mil/vois/owa/vois) for the most up to date information on CACCIRS sites.

For CACCIRS workstations configured with the High Volume setting selected in the RAPIDS Configuration Tool:

- Scanning identity documents is not required.
- No 2842 is displayed or digitally signed during ID card issuance.
- No CACs or Civilian Retiree cards can be printed.
- Active Duty, Guard, Reserve, and Academy student personnel are the only personnel types currently supported by Central Issuance and the CACCIRS workstation.
- Records are opened in the High Volume Navigator as opposed to the Person Viewer.
- The VO does not authenticate to the Issuance Portal.
- Changes made in the High Volume Navigator are saved to DEERS before the CAC request is sent to DEERS.
- A new family cannot be created.
- A PIC must be selected before a CAC can be requested.
8.12.1 CACCIRS Configuration

Use the RAPIDS Configuration Tool to set a CACCIRS site to **High Volume**.

1. Double-click the **RAPIDS Configuration** icon from the desktop of the RAPIDS workstation.
   - Result: The RAPIDS Device Configuration tool opens.

2. Click the **Restrictions** tab.
   - Result: The Restrictions Tab displays.

3. Select **High Volume** from the Card Issuance Mode drop-down menu.
   - Result: High Volume displays in the Card Issuance Mode drop-down menu.

4. Click **Save Workstation** at the bottom of the RAPIDS Device Configuration Tool.
   - Result: The information is saved to the RAPIDS server.

5. Click the red **X** in the upper right-hand corner of the RAPIDS Device Configuration Tool.
   - Result: The RAPIDS Device Configuration Tool closes.

8.12.2 Adding A Person-In-Charge (PIC)

Prior to creating a Central Issuance Facility (CIF) request on a CACCIRS workstation, the SSM must establish a PIC who will be responsible for CAC distribution. Once the PIC has been identified, the SSM must add the PIC to the Site PIC list in RAPIDS. The SSM must use the following steps to add a PIC in RAPIDS 7.3:

1. Complete the steps necessary to log into RAPIDS.

2. Click **Tools > Administer PIC for Central Issuance**.

   - Result: The Site PIC list opens.
3. Click **New PIC**.

- **Result**: The *Person In Charge PIN* window opens.

4. Ask the PIC to insert their CAC into the customer/recipient card reader. After the PIC inserts their CAC, they must enter their 6-8 digit PIN using the PIN pad.

5. Click **OK** after the PIC has entered their PIN.

6. Enter a Group/Unit/Class/Flight description to help distinguish between the different batches of requests.

- **Result**: The *RAPIDS – Administer Person-In-Charge (PIC)* window opens.
7. Click OK.
   ▪ Result: The PIC has been saved to the Site PIC list and the RAPIDS – Administer Person-In-Charge (PIC) window closes.

8.12.3 Creating a Central Issuance Facility (CIF) Request

In CACCIRS card issuance mode, the VO is automatically prompted to open a record upon logging into RAPIDS.

1. Complete the steps necessary to verify the customer’s identity.

2. Enter the customer’s personal identifier into the Open Sponsor dialog box.
   ▪ Result: The High Volume Navigator appears.

Note: CACs can only be requested for recruits/trainees of the Active Duty, Guard, Reserve components and Academy students. If an attempt is made to open a Sponsor record that is not a recruit/trainee of the Active Duty, Guard, Reserve, components or Academy student, a message will be displayed stating that this action cannot be taken on this workstation, and the record will be closed.

3. Verify or update the Sponsors information.
4. Click **Change** in the CIF Request Information area to select a PIC.
   - Result: The *RAPIDS - Select Person-in-Charge (PIC)* window opens.

5. Select the **PIC**.

6. Click **OK**.
   - Result: The *RAPIDS - Select Person-in-Charge (PIC)* window closes.

**Note:** The PIC only has to be selected for the first Sponsor of a batch and will have to be changed at the beginning of a new batch. The *High Volume Navigator* will not advance without a PIC selected on this screen.

**Note:** The Include Certificates check box is checked by default. If the checkbox is unchecked, certificates will not be encoded on the CAC.
7. Click Next.
   - Result: The *High Volume Navigator* advances to the Additional Sponsor Information task.

8. Verify or update the Sponsors information.

   **Note:** ID Cards can be issued with the frocked rank and the Sponsor’s actual pay grade. However, VOs should not change the Sponsor’s pay grade in DEERS. This will be done by the personnel pay system when the Sponsor is actually advanced or promoted. Please reference the AFI 36-3026(I) posted on the VOIS (https://www.dmdc.osd.mil/vois/owa/vois) for additional instruction on frocking.

9. Click Next.
   - Result: The *High Volume Navigator* advances to the Save Sponsor to DEERS task.
   - Result: The *High Volume Navigator* advances to the Generate ID Card task.
   - Result: The *High Volume Navigator* advances to the Get List of ID Cards to Terminate task.
   - Result: The *High Volume Navigator* advances to the Terminate Previous task.

10. Select a reason for termination in the Why Is This Previous ID Card Being Terminated? area.
Note: A CAC will only be terminated if the Sponsor has previously been issued a CAC.

11. Click Next.
   - Result: The High Volume Navigator advances to the View Terminated task.

Note: If the Sponsor has never been issued a CAC or the CAC has already been terminated, the View Terminated task is skipped.

12. Locate the return code in the View Terminated task in the High Volume Navigator and write it on the terminated CAC with a permanent black marker. The terminated CAC must be locked in a secure drawer or safe until it can be returned to the DSC.

13. Click Next.
14. Use the arrows to select the ID card date range.

**Note:** Unless the VO has justification to modify the expiration date of an ID card, they should click next on the Adjust Card Dates task. A VO might need to adjust the dates if they are issuing a temporary ID card.

15. Click **Next**.
   - Result: The *High Volume Navigator* advances to the Capture Biometrics task.
   - Result: The *RAPIDS - Capture Photo* window opens.

16. In the *RAPIDS - Capture Photo* window, use the Movement and Zoom controls to frame the picture.

17. Click **Capture Picture**.
   - Result: The picture of the customer appears in *RAPIDS - Capture Photo* window.

18. Verify quality of picture. In the *RAPIDS - Capture Photo* window, use the Brightness and Contrast controls to improve the quality of the picture.

19. Click **OK**.
   - Result: The *RAPIDS - Capture Photo* window closes.

20. When the *RAPIDS - Match Primary Fingerprint* window opens, ask customer to identify his or her primary hand and place his or her primary finger on the fingerprint scanner to match the fingerprint.
   - Result: Fingerprints match.
- Result: The *RAPIDS - Match Primary Fingerprint* window closes.
- Result: The *High Volume Navigator* advances to the Capture Biometrics view.
- Result: The *High Volume Navigator* advances to the Creating a Fingerprint and Picture for the ID Card task.

21. Verify the results in the *Creating a Fingerprint and Picture for the ID Card* window.
   a. Photograph matches the customer.
   b. Fingerprints are on file.

22. Click **Next**.
   - Result: The *High Volume Navigator* advances to the Print Preview/CIF Request task.

23. Carefully review the front view and back view of this card to ensure all information on the card is accurate, including—
   a. Issue date
b. Expiration date
c. Spelling of the name.

24. Click Next.  
   ▪ Result: The *High Volume Navigator* advances to the Save ID Card Request task.  
   ▪ Result: The *High Volume Navigator* advances to the Summary task.

25. Review the Summary results.

![Image of High Volume Navigator with Summary task highlighted.]

26. Click Finish.  
   ▪ Result: The *High Volume Navigator* closes and the VO is prompted to process the next Sponsor or modify the existing Sponsor’s record.

8.13 TROUBLESHOOTING

8.13.1 RAPIDS

Occasionally, the VO may encounter error messages or issues while using RAPIDS. In this situation, the VO should first consult RAPIDS 7 Information under the Tools/Training Resources section of the VOIS (https://www.dmde.osd.mil/vois/owa/vois). Under RAPIDS 7 Information, the VO can find documents that provide guidance and workarounds for known issues with the RAPIDS 7 software. If the VO cannot find a resolution using these documents, the VO should take a screenshot of any error messages or visible problems with the application. The VO uses this screenshot to accurately describe error messages or issues to the DSC that can significantly reduce issue resolution times. To take a RAPIDS screenshot, follow the instruction below:

1. Press the **Print Screen** key on the top row of the keyboard.

2. Click the **Windows Start** button in the lower left corner of your screen.  
   ▪ Result: The Windows Launch Bar opens.

3. Click **Programs > Accessories > WordPad**.
• Result: The WordPad application opens.

4. Click **Edit > Paste** from the Menu Bar of WordPad.
   • Result: The desired screen appears in the WordPad program.

5. Click **File > Page Setup** from the Menu Bar of WordPad.
   • Result: The Page Setup dialog box opens in WordPad.

6. Click the **Landscape** radio button in the Orientation area of the Page Setup dialog box.

7. Click **OK**.
   • Result: The Page Setup dialog box closes.

8. Click **File > Print** from the Menu Bar of WordPad.
   • Result: The Print dialog box opens.

**Note:** The laser printer should be selected by default. If it is not, select the laser printer before printing.

9. Click the **Print** button in the Print dialog box.
   • Result: The screenshot prints from the laser printer and the Print dialog box closes.

10. Click **File > Exit** from the Menu Bar to close WordPad.

### 8.13.2 CAC Encoding Errors

Typically, encoding errors are the result of a loss of communication in the DEERS/RAPIDS infrastructure. In previous versions of RAPIDS, the VO made the determination of whether the CAC would be terminated. In RAPIDS 7, the application makes the initial determination, as well as the response of the VO in some instances. A green checkmark on the **Encoding** window indicates that the encoding step has been completed successfully. A red X may indicate an encoding failure or a step that has not been completed. If there is an encoding problem for which RAPIDS requires your input, the **RAPIDS—Encoding Did Not Complete** window displays and the VO can either terminate the CAC or retry the encoding step. If the encoding process cannot successfully complete the ID certificate step, the CAC should be terminated. At a minimum, the encoding process needs to complete the ID certificate step for a CAC to be valid. The other certificates can be encoded at a later time by updating the CAC. If the VO is unable to determine an error code from RAPIDS, he or she can reference the ID Card Error Codes document in Appendix D. If the VO consistently runs into encoding failures, he or she should contact the DSC User Help Desk.

**ITEMS TO REMEMBER**

- Encoding errors usually result from a loss of communication in the DEERS/RAPIDS infrastructure.
- If the ID certificate has not been completed, the CAC cannot be issued to the recipient.
• If you are unable to save cards to DEERS, this means the ILP has not been properly incremented. This problem may cause on-hand card counts to be overstated. Return these cards immediately.

8.13.3 Assistance for a Customer Who Returns a Nonfunctioning CAC

When a customer insists that his or her CAC is not functioning properly, do not assume the chip is damaged and discard the CAC. Use the following procedure to determine whether the problem is related to the customer’s CAC. Figure 9.1 shows the actions you need to take when your customer reports the two most common CAC certificate encoding problems.

![Figure 9.1. Process Flow for Troubleshooting a CAC](image)

8.13.4 Verifying Certificates in RAPIDS

1. Open the Sponsor’s record and verify his or her identity.
   - Result: The default state of the Overview screen displays with the Sponsor’s information in the Person Viewer.

2. Open View Certificates on Card window.
   - Option 1 (Family Tree):
     a. Click **ID Card(s)**.
        - Result: The ID Card view opens in the Person Viewer.
     b. Click **View Certs** in the ID Card view in the Person Viewer.
Result: View *Certificates on Card* window opens.

Option 2 (Icon Bar):
- a. Click the **ID Card** icon.
  - Result: The ID Card view opens in the Person Viewer.
- b. Click **View Certs** in the ID Card view in the Person Viewer.
  - Result: View *Certificates on Card* window opens.

3. Use the drop-down menu to select a **Certificate Type**.

4. Click **Read Data From Card** in the *Certificates on Card* window.
   - Result: The *View Certificates on Card* window shows the issuer, serial number, expiration date, issue date, and e-mail address.

### ITEMS TO REMEMBER

- When a customer reports that his or her CAC is not functioning properly, do not assume that the chip is damaged or that the certificates on the card are not valid.
- Verify the certificates before referring the customer to his or her service-specific PKI Help Desk.
- If you cannot verify the certificates on the CAC, the only alternative is to issue a new CAC.

8.13.5 **Verifying Certificates in ActivClient**

6. Double-click the **ActivClient** icon in the lower right-hand corner of the RAPIDS desktop.
   - Result: The ActivClient utility loads.

7. Click **File > Use Reader > SCM Microsystems Inc. SDI010** from the drop-down menu to read the data from the customer’s smart card.

8. Double-click the **My Certificates** folder.
   - Result: The ActivClient Login dialog box appears.

9. Customer enters **PIN** and presses **Enter** on the PIN pad.
   - Result: The customer’s certificates load.

10. Double-click the **Identity Certificate** icon to view the contents.
    - Result: The certificate properties load.

11. Verify the certificate is valid and click **OK**.
    - Result: The My Certificates folder loads.

12. Double-click the **Signature Certificate** icon to view the contents.
    - Result: The certificate properties load.
13. Verify the certificate is valid and click **OK**.
   - Result: The My Certificates folder loads.

14. Double-click the **Encryption Certificate** icon to view the contents.
   - Result: The certificate properties load.

15. Verify the certificate is valid and click **OK**.
   - Result: The My Certificates folder loads.

16. Click the **Red X** in the upper right-hand corner of the ActivClient utility to close the application.
   - Result: ActivClient closes.
9 REPORTS

RAPIDS reporting is only available to users with the SVO or the SSM role. If the RAPIDS user does not have either the SVO or SSM role, the RAPIDS Reports option in the Reports dropdown menu will be grayed out. See the SSM Responsibilities section of this user guide for instructions on how to assign the SVO role.

Reports should be generated and reviewed by the SVO or SSM regularly to help identify security, technical, or training issues at the RAPIDS site. Report data will be available for 30 days only; therefore, the site’s SVO or SSM should set an appropriate schedule for pulling and printing reports. Even though report data is maintained for 30 days, the DMDC recommends generating reports for a date range of 2 weeks or less. RAPIDS may freeze up for date ranges greater than 2 weeks depending on the amount of data it is retrieving. This is a temporary known issue that will be fixed in later software versions.

There are four reports an SVO or SSM can produce: (1) Transaction, (2) Error, (3) ID Card, and (4) Periodic Summary. The Transaction report lists all transactions performed using a RAPIDS workstation, sorted by user. The Error report lists error codes determined by the DEERS server. DEERS personnel monitor this report electronically and resubmit records with offline errors. The ID Card report lists only ID cards produced, sorted by user. The Periodic Summary report summarizes transactions and is subtotaled by days or months. Currently, the only selection criteria available for all reports are the date range and the site ID for which the report is being printed. The DMDC will release more advanced selection criteria as necessary.

9.1 ACCESS REPORTS

To access reports in RAPIDS, the SVO or SSM selects Reports from the Menu Bar. The SVO or SSM then selects the RAPIDS Reports option from the drop-down list. Once RAPIDS Reports is selected, a new RAPIDS Audit Reports window opens, as shown in Figure 10.1.
If the reporting functionality stops working from within RAPIDS, the SVO or SSM can access reporting through the following alternative Website using IE:

- https://rws-alt.dmdc.osd.mil/R3apid/reporting/home.jsp

9.2 CREATE REPORTS

9.2.1 CREATE A TRANSACTION AUDIT TRAIL REPORT

1. Complete the steps necessary to log on to RAPIDS.
   - Result: RAPIDS opens to the default state of the Overview screen.

2. Click Reports > RAPIDS Reports in the Menu Bar.
   - Result: The Choose a digital certificate window opens.

3. Select your certificate from the list.

4. Click OK.
   - Result: The RAPIDS Audit Reports Website opens to the Reports-Home tab.

5. Click Transaction Summary.
   - Result: The Selection Criteria tab opens.
6. Enter the **Report Range**.
   Option 1: Enter the **Start Date** and **End Date** in RAPIDS date format: YYYYMDD.
   Option 2: Click the **Calendar** icon to enter dates in the Start Date and End Date fields.

7. Select the **Reportable Site** from the Reportable Site field.

8. Click the **Print/Preview** tab or the **Print Report** button at the bottom of the page.
   - Result: The system loads.
   - Result: The Transaction Audit Trail Report appears.

### 9.2.2 Create a Transaction Error Report

1. Complete the steps necessary to log on to RAPIDS.
   - Result: RAPIDS opens to the default state of the Overview screen.

2. Click **Reports** > **RAPIDS Reports** in the Menu Bar.
   - Result: The **Choose a digital certificate** window opens.

3. Select your certificate from the list.

4. Click **OK**.
   - Result: The RAPIDS Audit Reports Website opens to the Reports-Home tab.

5. Click **Error Report**.
   - Result: The Selection Criteria tab opens.

6. Enter the **Report Range**.
   Option 1: Enter the **Start Date** and **End Date** in RAPIDS date format: YYYYMDD.
   Option 2: Click the **Calendar** icon to enter dates in the Start Date and End Date fields.

7. Select the **Reportable Site** from the Reportable Site field.

8. Click the **Print/Preview** tab or the **Print Report** button at the bottom of the page.
   - Result: The system loads.
   - Result: The Transaction Error Report appears.

### 9.2.3 Create an ID Card Report

1. Complete the steps necessary to log on to RAPIDS.
   - Result: RAPIDS opens to the default state of the Overview screen.
2. Click Reports > RAPIDS Reports in the Menu Bar.
   - Result: The Choose a digital certificate window opens.

3. Select your certificate from the list.

4. Click OK.
   - Result: The RAPIDS Audit Reports Website opens to the Reports-Home tab.

5. Click ID Card Report.
   - Result: The Selection Criteria tab opens.

6. Enter the Report Range.
   Option 1: Enter the Start Date and End Date in RAPIDS date format: YYYYMMDD.
   Option 2: Click the Calendar icon to enter dates in the Start Date and End Date fields.

7. Select the Reportable Site from the Reportable Site field.

8. Click the Print/Preview tab or the Print Report button at the bottom of the page.
   - Result: The system loads.
   - Result: The ID Card Report appears.

9.2.4 Create a Summary Report of ID Cards by Card Type

1. Complete the steps necessary to log on to RAPIDS.
   - Result: RAPIDS opens to the default state of the Overview screen.

2. Click Reports > RAPIDS Reports in the Menu Bar.
   - Result: The Choose a digital certificate window opens.

3. Select your certificate from the list.

4. Click OK.
   - Result: The RAPIDS Audit Reports Website opens to the Reports-Home tab.

5. Click Periodic Summary.
   - Result: The Selection Criteria tab opens.

6. Enter the Report Range.
   Option 1: Enter the Start Date and End Date in RAPIDS date format: YYYYMMDD.
   Option 2: Click the Calendar icon to enter dates in the Start Date and End Date fields.

7. Select the Reportable Site from the Reportable Site field.
8. Click the **Print/Preview** tab or the **Print Report** button at the bottom of the page.
   - Result: The system loads.
   - Result: The Summary Report appears.

9.3 **PRINT REPORTS**

1. Complete the steps necessary to create a report.

2. Right-click inside the *Report* window.
   - Result: The right-click menu opens.

3. Click **Print**.
   - Result: The *Print* window opens.

4. Click **Preferences**.
   - Result: The *Printing Preferences* window opens.

5. Click the **Basics** tab.

6. Click the **Landscape** radio button.

7. Click **OK**.
   - Result: The *Printing Preferences* window closes.
   - Result: The *Print* window opens.

8. Click **Print**.
   - Result: The report prints.

**Note:** Do not leave reports unattended on the printer. Information contained in the DEERS database is protected under the Privacy Act of 1974. DEERS data is for official use only.

9.4 **ANALYZE REPORTS**

Reports should be generated and reviewed regularly. Analyzing report data can give valuable insight into the condition of site operations. Specifically, report data can divulge information on whether VOs are following the proper RAPIDS procedures, violating RAPIDS security policy, or experiencing any technical problems with the RAPIDS workstation. Important items to look for in the ID Card and Transaction Audit Trail reports are family members receiving more than one ID card or a CAC that is issued with no certificates. If the SVO or SSM notices a family receiving two ID cards, there should be evidence of a failed ID card (i.e., CAC with a return code on it). Similarly, for a CAC with no certificates, the SVO or SSM should verify that there is a CAC with a return code on it. The objective is to ensure invalid cards were not issued to the customer.

**Exporting, Deleting, and Archiving Reports**
Currently there are no export, delete and archive features within RAPIDS reports. These features are currently managed through centralized servers at DMDC. If there is a need to archive a particular type report, please contact the DMDC Support Center (DSC) User Help Desk at 1-800-372-7437.
9.4.1 RAPIDS Transaction Audit Trail Report

Features of the RAPIDS Transaction Audit Trail Report

- **Event Date/Time**
The date and time of the transaction as date stamped from the time displayed on the workstation.

- **Sponsor ID**
The Sponsor’s personal identifier (Social Security Number, Foreign Identification Number, etc).

- **Family Member ID**
The Family Member’s personal identifier (Social Security Number, Foreign Identification Number, etc).

- **Relationship**
The customer’s relationship to the Sponsor.

- **Full Name**
The Full Name is the full name of the Sponsor displayed as Last name, First name.

- **Transaction**
The type of actions that occurred on the RAPIDS workstation.

- **Business Area**
The Business Area distinguishes transactions unique to specific tasks such as updating records, issuing ID cards, and logging in and out of RAPIDS.

- **Status**
  
  The state of error codes or system notifications. These can be used to assist with locating the source of errors within RAPIDS.

A RAPIDS Transaction Audit Trail report will display the type of transactions occurring chronologically, from each VO. You should take note of VOs who are producing the most transactions and what type of transaction and business area the transactions occur under. High total amounts for some type of transactions are normal. For example, adding mailing addresses for customers is a very common type of transaction. However, high frequency of transactions such as Cancel with a business area of Card may indicate unusual activities occurring within your site.

**Actions To Take With the RAPIDS Transaction Audit Trail Report**

Analyze the report. If you see a high number of discrepancies after analyzing it, monitor the situation closely. There may be several explanations as to why the unusual transactions are occurring. Some of the more common problems that result in abnormal activities on RAPIDS workstations include local communications problems, poorly performing hardware, and VO error.

As an SSM or SVO, you should talk to the VOs at your site on a daily basis to listen to any problems or concerns they may be experiencing during ID card production.

If you suspect someone has committed fraud on the RAPIDS workstation after analyzing a report, contact your Service Project Officer immediately.

For a complete list of RAPIDS transaction audit trail events and descriptions, please see Appendix F of this User Guide.
9.4.2 RAPIDS Transaction Error Report

Features of the RAPIDS Transaction Error Report

- **Event Date/Time**
  The date and time of the transaction as date stamped from the time displayed on the workstation.

- **Sponsor ID**
  The Sponsor’s personal identifier (Social Security Number, Foreign Identification Number, etc).

- **Family Member ID**
  The Family Member’s personal identifier (Social Security Number, Foreign Identification Number, etc).

- **Relationship**
  The customer’s relationship to the Sponsor.

- **Full Name**
  The Full Name is the full name of the cardholder displayed as Last name, First name.

- **Business Area**
The Business Area distinguishes transactions unique to specific tasks such as updating records, issuing ID cards, and logging in and out of RAPIDS.

- **Transaction**
  The type of actions that occurred on the RAPIDS workstation.

- **Status**
  The state of error codes or system notifications. These can be used to assist with locating the source of errors within RAPIDS. Each transaction on the RAPIDS Transaction Error Report will show a status of ‘failed.’

RAPIDS Transaction Error reports are grouped and totaled by the VO performing the transactions. Take note of any VO that has a high amount of errors generated under his or her ID. The error report will show the specific date and time the error occurred along with the VO who encountered the problem. As an SSM or SVO, you should talk to the VOs at your site on a daily basis to listen to any problems or concerns they may be experiencing during ID card production.

**Actions To Take With the RAPIDS Transaction Error Report**

Analyze the report. If you see a high number of errors after analyzing it, monitor the situation closely. There may be several explanations as to why the error transactions are occurring. Some of the more common problems that result in abnormal activities on RAPIDS workstations include local communications problems, poorly performing hardware, and VO error.

Regardless of what the problem may be, the Primary SSM should be informed and manage errors occurring at the site.

**Exporting, Deleting, and Archiving Reports**

Currently there are no export, delete and archive features within RAPIDS reports. These features are currently managed through centralized servers at DMDC. If there is a need to archive a particular type report, please contact the DMDC Support Center (DSC) User Help Desk at 1-800-372-7437.
9.4.3 RAPIDS ID Card Report

Features of the RAPIDS ID Card Report

- **Event Date/Time**
  The date and time of the transaction as date stamped from the time displayed on the workstation.

- **Sponsor ID**
  The Sponsor’s personal identifier (Social Security Number, Foreign Identification Number, etc).

- **Cardholder ID**
  The Family Member’s personal identifier (Social Security Number, Foreign Identification Number, etc).

- **Relationship**
  The cardholder’s relationship to the Sponsor.

- **Cardholder Full Name**
  The Full Name is the full name of the cardholder displayed as Last name, First name.

- **Card Type**
  Type of card issued: CAC, DoD Civilian Retiree, 1173.

- **Certificates**
  The Certificates column reflects which certificates were placed on the CAC’s
integrated circuit chip:

- I = Identity
- S = E-mail Signing
- E = E-mail Encryption
- PIV Authentication

At a minimum, a CAC needs to have an identity certificate for it to be a valid CAC.

- **Last Action**
  The last function performed by a VO during the ID card issuance process.

- **Personnel Status**
  Shows the current condition of the cardholder’s personnel category.

A RAPIDS ID Card report will display the ID card transactions occurring chronologically from each VO. You should take note of VOs who are producing the most ID cards. High total amounts for some types of transactions are normal. However, a high frequency of last transactions such as ‘cancel’ may indicate unusual activities occurring within your site.

**Actions To Take With the RAPIDS ID Card Report**

Analyze the report. If you see a high number of discrepancies after analyzing the report, monitor the situation closely. There may be several explanations as to why the unusual transactions are occurring. Some of the more common problems that result in abnormal activities on RAPIDS workstations include local communications problems, poorly performing hardware, and VO error.

As an SSM or SVO, you should talk to the VOs at your site on a daily basis to listen to any problems or concerns they may be experiencing during ID card production.

After analyzing a report, if you suspect someone has committed fraud on the RAPIDS workstation, contact your Service Project Officer immediately.

For a complete list of ID card error codes, see Appendix E of this User Guide.

**Exporting, Deleting, and Archiving Reports**

Currently there are no export, delete and archive features within RAPIDS reports. These features are currently managed through centralized servers at DMDC. If there is a need to archive a particular type report, please contact the DMDC Support Center (DSC) User Help Desk at 1-800-372-7437.
9.4.4 RAPIDS Summary Report of ID Cards by Card Type

Features of the RAPIDS Summary Report of ID Cards by Card Type

- **Last Action**
  The last function performed by a VO during the ID card issuance process.

- **Card Type**
  Type of card issued: CAC, DoD Civilian Retiree, 1173.

- **Total**
  Total number of ID cards of each type.

A RAPIDS Summary Report of ID Cards by Card type shows you the total number of each type of card that is being produced at your site. This report should be run daily to closely monitor your site’s cardstock levels and ID card issuance frequency.

Take note of the ID cards that are most commonly produced at your site. The demographics of each RAPIDS site are different. You should be thoroughly familiar with demographics particular to your site. Some sites may have more Uniformed Service Members as customers. These types of sites should expect to see high numbers of Armed Forces CACs being produced. Other sites may primarily serve Department of Defense Contractors. For sites that have high numbers of Contractors being served, a high number of Identification CACs is expected.

**Actions To Take With the RAPIDS Summary Report of ID Cards by Card Type**
Identification CACs and their associated records can be created exclusively from a RAPIDS workstation. This creates a potential vulnerability for fraudulent ID cards to be produced. To combat this problem we rely on you (the SSM and SVO) to vigilantly monitor potentially fraudulent activities. Specifically monitor any Card Type whose associated record can be created through RAPIDS. If the number of cards produced falls outside a normal range, the situation should be monitored closely.

There may be several explanations as to why a high number of particular cards are being produced. Some of the more common explanations are troop or contractor mobilization and demobilization.

As an SSM or SVO, you should talk to the VOs at your site on a daily basis to listen to any problems or concerns they may be experiencing during ID card production.

After analyzing a report, if you suspect someone has committed fraud on the RAPIDS workstation contact your Service Project Officer immediately.

However, there are also adverse reasons why this may be occurring. For example VO error and fraud may also be a reason why your site is producing at abnormally high or low levels. Regardless of what the problem may be, it should be investigated by an SSM. SSMs should talk to their VOs on a daily basis and listen to any problems or concerns they may be experiencing during ID card production.

**Exporting, Deleting, and Archiving Reports**

Currently there are no export, delete and archive features within RAPIDS reports. These features are currently managed through centralized servers at DMDC. If there is a need to archive a particular type report, please contact the DMDC Support Center (DSC) User Help Desk at 1-800-372-7437.
10 SITE SECURITY MANAGER RESPONSIBILITIES

The SSM is responsible for fulfilling all VO responsibilities, as well as managing site administrative information, RAPIDS users, cardstock, consumables, and DD forms. To perform these responsibilities, the SSM uses the DMDC Security Online application, the CAC ILP, and the VOIS Information System.

This section provides details regarding the responsibilities of the SSM and how the SSM can use the applications mentioned to complete daily operations. It does not go into detail regarding the role of the SSM at the ID Card Center. For more information regarding the role of the SSM, please see Section 4 of the RAPIDS 7-3 User Guide.

10.1 Site Administration

The SSM administrative responsibilities include updating the contact information for the RAPIDS site. Updated contact information is important to a functional RAPIDS site because DEERS shares site information with other systems that are critical to the installation, maintenance, and support of RAPIDS. The site contact information includes both the location address and the mailing address, as well as the primary point of contact for the site. This information can be updated using the DMDC Security Online Application. The screenshot in Figure 11.1 provides RAPIDS users with an example of some of the fields they will be required to populate when they log on to DMDC Security Online to update site information.

![Screenshot of Site Administration Form in DMDC Security Online]

Figure 11.1. Screenshot of Site Administration Form in DMDC Security Online
10.1.1 Primary Point of Contact
The SSM is required to input his or her contact information into Security Online to ensure DMDC can contact the site. This information includes a commercial telephone number, a Defense Switched Number (DSN) telephone number if applicable, and a fax number.

10.1.2 Mailing Address
The mailing address of the site should be the site’s physical street address and should not contain P.O. boxes or mail stops. It is important that an SSM keep this information current because the RAPIDS equipment is shipped to the mailing address.

10.1.3 Location Address
The Location Address field should be the address that the site wants shipping vendors to use. This is the address sites would use to receive their cardstock and consumables. It is also the address that prints as the Unit/Command address on the DD Form 1172. In addition, if the unit is mobilized, the SSM is responsible for updating the location address to reflect the new location of the RAPIDS workstation.

10.1.4 Address Updates/Location of Site Summary Information
Instructions on how to update the address information and review the Site Summary Information can be found in the DMDC Security Online User Guide.

10.2 User Administration
SSMs perform all user administration functions through DMDC Security Online. The user administration functions include adding a user to a site, assigning roles to a new user, updating user information, deactivating a user, terminating a user, and reviewing the site roster. Figure 11.2 provides RAPIDS users with an example of some of the fields they will be required to populate when they log on to DMDC Security Online to update user information.
When the SSM has identified a new user who will be working with the RAPIDS workstation, the SSM must add that user to the site using DMDC Security Online. Before adding the user to the site, the SSM must ensure the user is properly vetted in accordance with DoDD 5200.2-R, DoD Personnel Security Program, which requires that persons seeking access to Privacy Act information or sensitive information be properly vetted.

10.2.2 Assign Roles to a New User

After the user is added to the site, the SSM is responsible for assigning roles to each user that provide that user with access or privileges to fulfill his or her daily responsibilities. The SSM can only assign another user the roles of a SVO or a VO. The SSM cannot assign another user the roles of an SSM. That task must be performed by a PO. The SSM must assign the new user the following roles if he or she is becoming a VO. These roles are also necessary for the new user to issue CACs:

- IO
- VO
- LRA.

Note: If the user will be performing SVO functions in RAPIDS, such as working with RAPIDS reports, the SSM must assign the user the role of SVO.
10.2.3 View/Update Site User Information
SSMs can update the user’s position and e-mail address. If the SSM updates the user’s e-mail address in this field, it will not automatically update that user’s CAC. If the user’s work e-mail changes, please update the e-mail certificate in RAPIDS as well.

10.2.4 Deactivate a Site User
If a user will no longer be working with the RAPIDS workstation, the SSM must deactivate the user from the site. This revokes that user’s privileges or access to the RAPIDS workstation. Please ensure the user does not need access to other DMDC Web-based applications before deactivating them in Security Online.

10.2.5 Use the Site Roster
The DMDC Security Online application also provides the SSM with the capability of reviewing the contact information and roles assigned to all RAPIDS users associated with the site. In addition, the DMDC Security Online application will allow the SSM to monitor the training courses of all RAPIDS users.

Note: Please see the DMDC Security Online User Guide on the VOIS to find detailed instructions on how to perform operations in DMDC’s Security Online application. These operations include—

- How to log on to DMDC Security Online
- How to add or update site information
- How to add or update user information.

10.3 CAC CARDSTOCK

10.3.1 Order
The ILP is a tool designed to track cardstock and automate the CAC reorder process. The ILP automatically reorders cardstock based on the reorder threshold and reorder quantity specified for each site. This portal is available from within RAPIDS.

The ILP has three main functions:

1. Monitors and orders CAC cardstock based on the site’s inventory levels, card issuance rates, and assigned reorder threshold
2. Continuously updates the individual card status; options include Available, Issued, and Terminated
3. Tracks cardstock and consumables shipments.

Detailed guidance for ordering CACs is located on the VOIS. To access the VOIS, please type the following link into any IE Web browser: https://www.dmdc.osd.mil/vois/owa/vois.

Note: There are cases when a site may need additional cardstock, such as a large-scale mobilization. In these situations, the SSM needs to submit a request for additional cardstock
through the ILP to DMDC and the IO’s SPO. The PO will review the transaction reports to identify the needs for extra cardstock and respond to the site that issued the request.

**Manually Ordering Cardstock**
If there is a need for an out-of-cycle ordering of cardstock, fill out the CAC Stock and Consumable Order Form and send the request to your site’s SPO explaining why you need an additional shipment.

If there is a need to order consumables, fill out the CAC Stock and Consumables Order Form and fax or e-mail it to the address listed on the bottom of that form.

If you are manually ordering cardstock because of a discrepancy with the count of cardstock on hand versus the count in the ILP, identify the discrepancy in Section II of the CAC Stock and Consumables Order Form, along with the 90-day audit trail report.

Sites that have multiple workstations may, on occasion, need additional supplies to keep all workstations operational. The CAC Order Form is available on the VOIS Website at https://www.dmdc.osd.mil/vois/owa/vois. Supplies are ordered through the manual order process as follows:

1. Select **Customer Forms**
2. Select **CAC Consumables Order Form**
3. Select the **CAC Ordering Form** (in blue) to access the form.

**10.3.2 Register**
The SSM must register the cardstock before using the media to create CACs for uniformed service members. To Register the cardstock, the SSM must “Receive,” “Check,” “Accept,” and “Open” the cardstock. If the SSM does not perform these operations on each new shipment of cardstock, the chip on the medium will not be encoded with the user’s personal information. For detailed procedures and guidance on how to Receive, Check, Accept, and Open the cardstock, please reference the CAC ILP User Guide. You can locate the ILP User Guide at the following link: https://www.dmdc.osd.mil/vois/owa/vois. Use your CAC to log on to the VOIS.

**10.3.3 Handle**
Properly storing, caring for, and securing cardstock and related consumables is necessary to ensure the best quality printing of CACs and Teslin Cards. Consumables have a shelf life of 12–18 months. Cardstock has a shelf life of 3 years, but supplies are routinely depleted by card production demands at a RAPIDS site.

If supplies are not properly cared for, you risk—

1. Wasted time trying to issue damaged CACs
2. Increased costs
3. Frustrated customers
4. Jeopardized security.
To reduce damage and ensure the best quality printing and lamination for all ID cards, the following pages give detailed procedures for caring, storing, and securing cardstock and consumables.

When caring for cardstock—

- Minimize the handling of cardstock. Natural oils on the hands can be transferred to the card and cause photograph degradation and smearing of printing colors.
- If cardstock is dropped on the floor, minimize handling and review for debris. Wipe any debris from the card with a clean lint-free white cloth. If there is damage to the surface of the card, return it to DMDC with the reason code for return written on the card with a permanent marker.
- When loading the printer with cardstock, handle the cardstock by the edges and only add a single stack of cards to the printer tray at a time.
- Once the CAC cardstock is loaded into the plastic card printer tray, it should not be removed, even when it is not in use.
- Rubber bands should not touch the surface of the cardstock. Rubber bands are typically petroleum based and can transfer a substance onto the card, causing part of the card not to print.

When storing cardstock—

- Store at room temperature. Heat and humidity degrade these products.
- Store cardstock in the original shipping trays or boxes to ensure that the cards are free of dust and dirt.
- Although cardstock is not a controlled substance, it should be kept in a locked office or in a desk drawer inside a locked facility.
- If the RAPIDS site is in an open area with uncontrolled access, cardstock must be locked in a secure place.
- Returned or misprinted Teslin or chipless cards should be destroyed following the local procedures for destroying sensitive data according to the Privacy Act.
- CACs that failed during issuance and rejected CACs must be returned to the DSC. DMDC has a 100-percent accountability requirement, and all cards should be forwarded for final destruction.

10.3.4 Return/Dispose

Returning CACs via FedEx

All CACs that are deemed invalid (damaged, data on CAC no longer valid, expired, misprinted, etc.) must be returned to the DSC by FedEx using the DEERS/RAPIDS FedEx account number. When you use this number, 2283-7326-5, your site will not incur shipping costs.

When returning cardstock via FedEx, you may use a box from your local site as long as it is big enough and strong enough to hold the volume of that cardstock. Inspect the box to ensure that it is in good condition and can be properly sealed. You must ensure that the box you choose for shipping can withstand the weight of the cardstock and will not break when in transit. If a box
breaks or opens in transit, you risk exposing Privacy Act data contained on the returned ID cards to everyone that can see the box.

ID cards contain Privacy Act data and it is your responsibility to ensure that a Privacy Act data cover sheet is included in the package. There is a Privacy Act Data cover sheet in Appendix C of this user guide. Remember, the Privacy Act Data cover sheet should always be printed in color.

Use the instructions below to fill out the FedEx shipping slip. You will affix this shipping slip on the properly sealed box of cardstock for return to DMDC.

Figure 11.3. FedEx Airbill Form for Returning Used/Damaged Cardstock to DMDC

1. Complete Section 1, including a commercial telephone number.
2. Complete Section 3:
   DMDC Support Center
   1600 North Beauregard Street, Suite 100
   Alexandria, VA 22311
3. Under Section 4a, check the FedEx Express Saver checkbox.
4. Under Section 7, Payment, check the Third Party checkbox and enter the following FedEx Account number: 2283-7326-5.
5. Include a coversheet specifying the number of CACs being returned, your site ID, and the contact information for your site.
6. Place returned CACs and the coversheet into a FedEx envelope or package.
7. Affix the FedEx U.S. Airbill to the package and arrange for pickup or drop off.
8. Remove and retain the back copy of the FedEx U.S. Airbill (labeled Recipient’s Copy) for your records.

**Note:** This account is continually monitored and should be used only for the return of cardstock. All other uses are prohibited. If you have further questions, please contact the DSC User Help Desk.

For more information on returning cardstock and CACs, refer to the ILP SSM/Shipment Manager Guide on the VOIS Website at https://www.dmdc.osd.mil/vois/owa/vois. If you are unable to access the VOIS through this link, contact the DSC.

**ITEMS TO REMEMBER**

- This account is continually monitored and should only be used for the return of CAC cardstock. This account should not be used to forward forms or any other activities.

10.4  **TESLIN CARDSTOCK MEDIA**

#### 10.4.1 Order

Log into the VOIS and click **Consumables > Teslin Cardstock and Laser Printer Consumables > Teslin Cardstock Ordering** for instructions on ordering Teslin cardstock.

The cardstock and associated laminate are available through Service forms distribution channels for production of the various Uniformed Services Identification and Privilege cards. Field activities should procure the cardstock through normal forms distribution channels.

Agencies that do not have a support agreement with the Army, Navy, or Air Forces will need to procure supplies directly from the Government Printing Office (GPO) via the Uniformed Services Identification Card (USID) contract vehicle. Please contact the Defense Manpower Data Center (DEERS/RAPIDS Operations) for further information.

#### 10.4.2 Store

As a RAPIDS operator, you are responsible for safeguarding your site’s cardstock. Whenever new blank cardstock is received, it should be kept in the factory shrink-wrapped package, locked in a secure drawer, cabinet, or safe at your site until it is loaded into the ID card printer. Once loaded into the printer, cardstock should not be removed. Cardstock may remain in the printer when not in use for short periods of time (e.g., overnight) if the printer is properly safeguarded from unauthorized access.

#### 10.4.3 Dispose
Issuing activities for machine-readable (Teslin) cards are not required to maintain logs to account for blank cards or ID cards that are destroyed, surrendered, or confiscated. Security is maintained through the DEERS and RAPIDS system by linking the SSN of the Sponsor to the type of card issued. For additional security, the DEERS database maintains a 4-digit alpha-numeric security code which is not visible to the user. Teslin cardstock media should be shredded if the card is misprinted or returned because it was lost or has expired.

10.5 CHIPLESS CARDSTOCK MEDIA

10.5.1 Order

Chipless cardstock media is ordered two ways.

- **Automatically**: A Web-based tracking system, called the Inventory Logistics Portal (ILP), automatically reorders cardstock when it reaches a preset reorder threshold.
- **Manually**: Sites are provided cardstock and consumables to support the cardstock quantities forwarded based upon average monthly production over a 12 month period. Additional cardstock and consumables can be requested by filling out the CAC Stock and Consumables Order Form which is located on the VOIS. You will need to provide information on why additional supplies are needed in the Remarks section of the form.

10.5.2 Store

As a RAPIDS operator, you are responsible for safeguarding your site’s cardstock. Whenever new blank cardstock is received, it should be kept in the factory shrink-wrapped package, locked in a secure drawer, cabinet, or safe at your site until it is loaded into the ID card printer. Once loaded into the printer, cardstock should not be removed. Cardstock may remain in the printer when not in use for short periods of time (e.g., overnight) if the printer is properly safeguarded from unauthorized access.

10.5.3 Dispose

Teslin cardstock media should be shredded if the card is misprinted or returned because it was lost or has expired.

10.6 SAFEGUARDING CONSUMABLES

Used printer consumables contain information regarded as Privacy Act and personally identifiable information. All information printed on the CAC or chipless ID card produced in the smartcard printer will be displayed on the printer ribbon and retransfer film. Therefore it is imperative that the printer ribbon and reverse transfer ribbon are destroyed or disposed of properly. Information on the printer consumable material content is available on the VOIS to provide to your local security office to receive further guidance for disposition or destruction of...
the used printer consumables. As a RAPIDS Site Security Manager and operator, it is your responsibility to contact your local security office for guidance/policy/procedures for the disposition of the used printer consumables. By not destroying or disposing of this ribbon properly, your site’s security may be compromised.

10.7 SAFEGUARDING CONSUMABLES - PRINTER MAINTENANCE

It is important to keep all printers in good working order by performing routine maintenance as required by the DMDC. At times it will be necessary for the printer to be removed from your facility so it can be repaired. You are responsible for removing any printer color ribbons, transfer film, laminate rolls, cardstock or toner cartridges from the DMDC provided printers prior to sending the printers in for repair, maintenance, or long term storage. During any time between sending a printer for repair and awaiting destruction instructions, all printer consumables must remain locked in a secure drawer, cabinet, or safe at your site. It is OK to leave cardstock and consumables in the printer when not in use for short periods of time (e.g. overnight) if the printer is properly safeguarded from unauthorized access.

10.8 FORMS MANAGEMENT

One of the most important parts of an LRA’s job is to know what documents are required to properly update or add records to DEERS. Below is a snapshot of the following DD Forms, their purpose, and when to use them:

- DD Form 1172
- DD Form 1172-2
- DD Form 2841, DoD Public Key Infrastructure (PKI) Registration Official Certificate Acceptance and Acknowledgement of Responsibilities
- DD Form 2842.

10.8.1 DD Form 1172

DD Form 1172 is used to add and update family members.

<table>
<thead>
<tr>
<th>Form</th>
<th>Purpose</th>
<th>When to Use It</th>
<th>Where to Find It</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>DD 1172</td>
<td>Used by the VO/SVO/SSM to verify family member eligibility when issuing ID cards and completing DEERS enrollment.</td>
<td>Every time you enroll/upgrade a family member in DEERS and/or issue a Family Member ID Card.</td>
<td>Located on the RAPIDS workstation and the VOIS (blank forms only on the VOIS).</td>
<td>DD Forms 1172 MUST be packaged SEPARATELY from DD Forms 1172-2.</td>
</tr>
</tbody>
</table>
HELPFUL HINT

Mail completed DD Form 1172s to—
DMDC Support Office, ATTN: 1172 Scan, 400 Gigling Road, Seaside, CA 93955-6771

DD Form 1172 packages should be bundled separately from DD Form 1172-2 packages.

10.8.2 DD Form 1172-2

The DD Form 1172-2, “Application for Department of Defense Common Access Card DEERS Enrollment” is very similar to DD Form 1172 but is used to add and update Contractors and Foreign Personnel.

<table>
<thead>
<tr>
<th>Form</th>
<th>Purpose</th>
<th>When to Use it</th>
<th>Where to Find it</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>DD 1172-2</td>
<td>The DD 1172-2 is only for “Unverified” or “Not Verifiable” contractors. It is used by the VO/SVO/SSM to verify the eligibility of personnel who have not been locked down in DEERS. This form designates permissions to access DoD facilities, DoD systems, and DoD benefits and privileges.</td>
<td>Every time an ID card is issued to a DoD contractor, foreign military member, or a foreign national.</td>
<td>Located on the RAPIDS workstation and the VOIS (blank forms only on the VOIS).</td>
<td>DD Form 1172-2 must be packaged separately from DD Form 1172.</td>
</tr>
</tbody>
</table>

HELPFUL HINT

Mail completed DD Form 1172-2s to—
DMDC Support Office, ATTN: DEERS Access/1172-2 Scan, 400 Gigling Road, Seaside, CA 93955-6771

10.8.3 DD Form 2841

DD Form 2841 is used when issuing a CAC to RAPIDS VOs/SVOs/SSMs. A blank form is available for printing from the VOIS and the RAPIDS Forms Menu.

<table>
<thead>
<tr>
<th>Form</th>
<th>Purpose</th>
<th>When to Use it</th>
<th>Where to Find it</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>DD 2841</td>
<td>DD Form 2841 is used when issuing a CAC to RAPIDS VOs/SVOs/SSMs. A blank form is available for printing from the VOIS and the RAPIDS Forms Menu.</td>
<td>Every time an ID card is issued to a DoD contractor, foreign military member, or a foreign national.</td>
<td>Located on the RAPIDS workstation and the VOIS (blank forms only on the VOIS).</td>
<td>DD Form 1172-2 must be packaged separately from DD Form 1172.</td>
</tr>
</tbody>
</table>
### DD 2841

<table>
<thead>
<tr>
<th>SUBSCRIBER</th>
<th>DEPARTMENT OF DEFENSE (DOD) PUBLIC KEY INFRASTRUCTURE (PKI) CERTIFICATE OF ACCEPTANCE AND ACKNOWLEDGEMENT OF RESPONSIBILITIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. CERTIFICATE ACCEPTED BY</td>
<td></td>
</tr>
<tr>
<td>a. NAME (Typed or printed) (Last, First, Middle Initial)</td>
<td>b. SSN</td>
</tr>
<tr>
<td>d. ORGANIZATION</td>
<td>e. PHONE NUMBER</td>
</tr>
</tbody>
</table>

The Registration Official/VO/SVO/SSM uses this form to collect and verify identifier information of the recipient and to ensure the recipient understands his or her responsibilities with respect to the CAC and information stored on the CAC. The recipient signs this form to acknowledge his or her responsibilities in being given certificate issuance authority.

Every time a CAC is issued to a VO/SVO/SSM. Located on the RAPIDS workstation and the VOIS (blank forms only on the VOIS). Refer to the site SOP for guidance on where to send this form.

**Note:** DD Form 2841 is pre-populated after the encoding process in RAPIDS 7. VO/SSMs will digitally sign the form with their new CAC. VO signs with his or her CAC.

### 10.8.4 DD Form 2842

DD Form 2842 is used when issuing a CAC. This form is now auto populated during CAC issuance. A blank form, if necessary is available from the RAPIDS Forms menu.

<table>
<thead>
<tr>
<th>Form</th>
<th>Purpose</th>
<th>When to Use it</th>
<th>Where to Find it</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>DD 2842</td>
<td>The Registration Official/VO/SVO/SSM uses this form to collect and verify identifier information of the CAC recipient and to ensure the recipient understands his or her responsibilities with respect to the CAC and information stored on the CAC. The CAC recipient signs this form to acknowledge receipt of DoD certificates and responsible use thereof.</td>
<td>Every time a CAC is issued to anyone other than a VO.</td>
<td>Located on the RAPIDS workstation and the VOIS (blank forms only on the VOIS).</td>
<td>Refer to the site SOP for guidance on where to send this form.</td>
</tr>
</tbody>
</table>

**Note:** DD Form 2842 is pre-populated after the encoding process in RAPIDS 7. Customers will digitally sign the form with their new CAC. VO signs with his or her CAC.

### ITEMS TO REMEMBER

- Become familiar with the various forms that are used daily at RAPIDS sites:
- Never compromise security by not requiring the correct form for adding or updating DEERS records.
- Make sure all customers who are issued a CAC understand their responsibilities for carrying the card.
- Display the Privacy Act at your workstation and require the customer to review it during the card issuance process (located on the VOIS).
- Make sure your site mails the forms to the proper location.
10.9 RAPIDS CONFIGURATION

RAPIDS SSMs and administrators are the only users authorized to access the RAPIDS Configuration Tool. RAPIDS configuration allows the SSM to change the workstation’s operating mode, configure and test peripherals, and change CAC encoding options. It is very important that the RAPIDS workstation be properly configured to ensure usability and functionality as intended.

10.9.1 RAPIDS Configuration: Launch of the RAPIDS Configuration Tool

1. Double-click the RAPIDS Configuration icon from the workstation desktop.
2. Enter your PIN when prompted.
   • Result: RAPIDS Configuration will open.

10.9.2 RAPIDS Configuration: General Tab

The General tab allows the SSM to view the current configuration of the identified workstation. In the General tab, the SSM can change Active status, PIV Compliant status, and In the Theater status of the workstation (see Figure 11.4). The SSM should always contact the DSC User Help Desk for approval and instructions before changing any settings in the General tab.

![Figure 11.4. Screenshot of General Tab in the RAPIDS Configuration Tool](image)

10.9.2.1 CHANGING THE RAPIDS WORKSTATION TO THEATER MODE

1. Click the In the Theater checkbox in the General tab.
2. Click the Save Workstation button.
10.9.3 RAPIDS Configuration: Restrictions Tab

The SSM should not change the settings under the Restrictions tab. The Restrictions tab settings are preconfigured in the initial setup of the workstation. If there is a requirement to change the settings, the DMDC will inform the SSM and indicate the necessary changes with instructions.

10.9.4 RAPIDS Configuration: Devices Tab

The Devices tab contains eight sub-tabs (see Figure 11.5). There is one sub-tab for every RAPIDS device connected to the RAPIDS workstation. SSMs can reconfigure only the fingerprint reader and document scanner without prior permission from the DMDC. If the configuration settings are changed for other devices, the associated devices may no longer operate.

Figure 11.5. Screenshot of Devices Tab in the RAPIDS Configuration Tool

The SSM should also be aware of the following areas for each Devices sub-tab:

- Device Make and Model menu
- Configuration Parameters field
- Run Test Program button.

Whenever a workstation has been relocated or new devices have been added or changed, the SSM should always test all peripheral devices to ensure they are fully functional before working with customers. This can be done by clicking the sub-tab of the required peripheral device and then clicking the Run Test Program button. If a device is not connected or malfunctions, the SSM will receive an error message.

When an error message appears, the SSM should ensure the device is connected to the workstation and plugged into the surge suppressor with the Power button in the on position. If
the SSM has additional issues with the device(s), he or she should contact the DSC User Help Desk.

DMDC may periodically request that an SSM update device configuration settings located under the Devices tab. The ability to make changes in the configuration tool is limited to the SSM, and even then, DSC closely regulates it.

10.9.4.1 CONFIGURE THE FINGERPRINT SCANNER

The SSM selects the Fingerprint Reader Sub-Tab in the Devices tab of RAPIDS Configuration. The SSM then selects the correct Device Make and Model from the drop-down menu. In the Configuration Parameters fields, SSMs can adjust the following:

- Brightness can be increased or decreased. Decreasing the brightness will decrease the shading and create a lighter fingerprint.
- The gain settings can be changed to values from 0 to 5. Increasing the gain settings increases the contrast of the fingerprint requiring less pressure on the fingerprint reader when capturing a fingerprint.
- RAPIDS workstations that have the Identix 2080 fingerprint reader must be reconfigured when upgrading to RAPIDS 7.2 + for the first time. The SSM must insert the number 6 between the words Identix and Processor of the processor value field.

IMPORTANT: Once you change a setting in the Value field, you must click into another field to ensure that the new value is successfully stored.

10.9.4.2 CONFIGURE THE DOCUMENT SCANNER

The SSM may change the warming interval setting on the document scanner to values from 0 to 5. Increasing the warming settings increases the number of times the document scanner warms itself per minute, allowing for quicker scans.

IMPORTANT: Once you change a setting in the Value field, you must click into another field to ensure that the new value is successfully stored.

10.9.5 RAPIDS Configuration: CAC Encoding and CAC Encoding Verification Tabs

The CAC Encoding and CAC Encoding Verification tabs allow the SSM to add or remove data elements to be encoded on a CAC (see Figure 11.6). SSMs should not change any of the settings under the CAC Encoding and CAC Encoding Verification tabs without specific direction from DMDC.
10.9.5.1 CONFIGURE RAPIDS TO ADD THE END STATE APPLET

1. Click the **Install PIV AUTH Cert/End State Applets** checkbox in the CAC Encoding tab.
2. Click outside of the checkbox then click the **Save Workstation** button. If you do not click outside of the checkbox first, your changes may not save.

10.9.6 RAPIDS Configuration: Exit

After testing peripheral devices or making required changes as recommended by DMDC, SSMs should click the **Save Workstation** button to ensure all required changes are saved.

In the event changes were accidentally made in the Device Configuration Tool, SSMs should click the **Discard Unsaved Changes** button. This will close the Device Configuration Tool and retain previous settings.

**Figure 11.6. Screenshot of CAC Encoding Tab in the RAPIDS Configuration Tool**
11 RAPIDS HELP RESOURCES

11.1 RAPIDS HELP

11.1.1 RAPIDS Online Help

RAPIDS Online Help is designed to provide the user with a basic overview of how to use RAPIDS. It does not answer every question you have about RAPIDS, but it should be used as a reference to provide guidance on how to complete most RAPIDS procedures.

1. Click Help > RAPIDS Help.

   • Result: the RAPIDS Help Navigator window opens (see Figure 12.1).

   ![Figure 12.1. Screenshot of RAPIDS Online Help](image)

   The Help Navigator pops up with a minimized view of the screen shown above. To view all data, the user should maximize the Help Navigator by selecting the Maximize Window button on the
top-right side of the screen to the left of the red X. In addition, the user can use the scroll bars to scroll left, right, up, and down to view all data in the Help Navigator window panes.

The Help Navigator has two separate windowpanes:

1. On the left-hand side are three tabs to select to begin searching the RAPIDS Help. These tabs are “Contents,” “Index,” and “Search.”
   a. **Contents**—This tab provides a high-level overview of topics discussed in RAPIDS 7.3 Help feature.
   b. **Index**—Similar to a glossary, the Index feature of the Help Navigator allows the user to type keywords into the text field. RAPIDS tries to match the word to topics discussed in RAPIDS Help.
   c. **Search**—The Search feature allows the user to search RAPIDS help for topics or keywords. These searches can be customized to search for “all of these words,” “any of these words,” or “this Boolean expression.”

2. On the right-hand side of the Help Navigator, data populate based on the hyperlink the user selects in the left-hand windowpane.

### 11.1.2 MOTD

The MOTD is presented to users as they log on to RAPIDS. Once a user’s identity is with his or her fingerprint, the MOTD pops up on the user’s monitor.

The MOTD allows the DMDC to communicate updates regarding—

- RAPIDS training
- RAPIDS policy
- RAPIDS software versions 6.5 and 7.3
- RAPIDS system maintenance and outages
- RAPIDS security/Information Assurance Vulnerability Alert (IAVA) patches
- RAPIDS Web-based training
- RAPIDS announcements.

**MOTD Interface**

The first time that a RAPIDS user views the RAPIDS MOTD, the text appears in red. If it is a previously viewed MOTD, the text in the message is black, as shown in Figure 12.2.
Elements of the MOTD include—

- **MOTD Date**—Is at the top center of the page.
- **Security Level**—Positioned to the left of the date at the top of the page.
- **Print**—Located at the top-right side of the page in red text. To print the MOTD, left-click the **Print** button, and select the option to print the message.
- **MOTD Title**—Located at the top of the **Message** window.
- **MOTD Calendar**—Located at the top right side of the **Message** window and includes the following features—
  - MOTDs from the previous month can be accessed by left-clicking the two arrows to the left of the month.
  - Calendar dates in white text represent the date of the active MOTD displayed in the **Message** window.
  - Calendar dates in blue text represent dates that previous MOTDs were posted to the RAPIDS community.
If RAPIDS users are interested in reviewing archived MOTDs, they can visit https://www.dmdc.osd.mil/vois/owa/vois, log in with their CAC by selecting the version of RAPIDS used at their site, and select the MOTD link on the left-hand side of the page.

11.2 Web Resources

11.2.1 VOIS

The VOIS provides real-time systems information, updated program information, and many other resources, such as archived MOTDs, points of contact (POC), RAPIDS documentation, and links to other Websites.

RAPIDS users can access the VOIS from either a CAC-enabled or non-CAC-enabled workstation:

- To access the site from a CAC-enabled workstation:
  - Log on to RAPIDS.
  - Select the Help Menu on the menu bar.
  - Select Web Resources.
  - Select VO Information System.
  - Click the Click Here to Continue link at the bottom of the Warning Notice (see Figure 12.3)

![Figure 12.3. Screenshot of VOIS Warning Notice](image_url)
Select the **RAPIDS 7** button (see Figure 12.4).

![Figure 12.4. Screenshot of VOIS Login](image)

- To access the site from a non-CAC-enabled workstation. Open an *Internet Explorer* window by clicking the following link: https://www.dmde.osd.mil/vois/owa/vois.
- Click the **Click Here to Continue** link at the bottom of the Warning Notice (see Figure 12.5).
The front page of the VOIS is automatically displayed. The user should select the **RAPIDS 7** button (see Figure 12.6).

![Figure 12.5. Screenshot of Click Here to Continue Link](image)

When you see an image on your monitor like the one shown below, you have been authorized to access and view the resources located on the VOIS. You will notice that there are multiple links located on the left navigation pane. Each link is discussed in the next section, and the significant documents are highlighted for you.

![Figure 12.6. Screenshot of VOIS Login](image)
Note: Please review each link to familiarize yourself with all the resources available to you on the VOIS (see Figure 12.7).

Figure 12.7 displays the first page RAPIDS users see after they log on to the VOIS. The following buttons are located on the left-hand side of the page:

- System Status
- MOTD
- Policy/Instruction Guidance
- Tools/Training Resources
- IAVA
- Printer Maintenance
- RAPIDS Upgrades Fielding Initiatives
- Frequently Asked Questions
- Customer Forms
- Consumables
- DMDC Customer Relations
- Site Map.

Below is a list of the significant documents in each section:

- **System Status**
  - Provides an updated status diagram of the DMDC Network
  - Lists projected/scheduled outages
  - Allows the user to access archives of past outages/maintenance
- **Message of the Day**
  - Presents the user with the current MOTD
  - Allows the user to view an archive of old MOTDs
- **Policy/Instruction Guidance**—Separated into three sections:
– Instruction Documents—AFI 36-3026(I)
– CAC Policy—I9
– RAPIDS Policy—Standard Security Operating Procedures (SSOP) (included in the SSOP is a security checklist that details how to secure the RAPIDS workstation)
  • Tools/Training Resources—Broken down into various the following sections:
    – RAPIDS Web-Based Training—Web-Based Training Matrix and RAPIDS Web-Based Training User Guides
    – Security—Top 10 Do’s and Don’ts
    – CVS—CVS Introduction, Guidance Associated with RAPIDS
    – CAC Information—CHUID Manual Input Guide
    – RAPIDS Hardware—RAPIDS Desktop and Deployable Footprints.
    • IAVA—Only required for RAPIDS 6 sites because software updates are automatically pushed to all RAPIDS 7 workstations. Workstations must be on and connected to the VPN to receive the update.
    • Printer Maintenance—FARGO HDP600—Links in this section of the VOIS provide the user with documentation on how to clean the FARGO printer, the consumables loading procedures, and the FARGO Quick Reference Guide.
    • RAPIDS Upgrades Fielding Initiatives—RAPIDS 7 CONUS Implementation Schedule, Site Notification and Coordination Materials, and Firewall configurations.
    • Frequently Asked Questions—Allows the user to log on to the DMDC Website to get answers to their frequently asked questions.
    • Customer Forms—Gives the user access to all the documentation and instructions regarding CAC Issuance, and ordering CAC consumables, including DD Form 1172, DD Form 1172-2, DD Form 2841, DD Form 2842, the Database Access Form, and the Consumables Ordering Form.
    • Consumables—RAPIDS users will find Teslin Consumables Order Form, Procedures for handling cardstock, Printer Cleaning Supplies, RAPIDS CAC Error Codes, CAC Stock and Consumables Order Form, and CAC Return Instructions.
    • DMDC Customer Relations—RAPIDS site locator to help RAPIDS users inform clients of the nearest ID card center in case their RAPIDS equipment is not functional.
    • Site Map—If the RAPIDS user requires a more detailed explanation of the topics highlighted in each section, he or she can select the Site Map, which provides a link to every topic under all major headings.

11.2.2 AFI 36-3026I

The AFI describes policy and procedures for issuing personal ID cards for members of the uniformed services, their eligible family members, and other eligible personnel.

RAPIDS users can navigate to the AFI by—
• Typing the following link into an IE Web browser: https://www.dmdc.osd.mil/vois/owa/vois.
• Selecting Policy/Instruction Guidance
• Clicking on the link titled Interservice (Joint) Instruction AFI 36-3026(I)—ID Cards for Members of the Uniformed Services, Their Eligible Family Members, and Other Eligible Personnel (20 Dec 02).

11.2.3 HSPD-12
HSPD-12 is an overview of Policy for a Common ID Standard for Federal Employees and Contractors. You can read more about the HSPD-12 at http://www.whitehouse.gov/news/releases/2004/08/20040827-8.html

11.2.4 FIPS-201
FIPS-201 is a U.S. government standard that specifies PIV requirements for federal employees and contractors. This document details the architecture and technical requirements necessary to meet the common ID standard defined in HSPD-12. RAPIDS users can read more about the FIPS-201 document at http://csrc.nist.gov/publications/fips/fips201-1/FIPS-201-1-chng1.pdf

11.2.5 PIPS
PIPS provides useful information about the CAC and CAC-related resources. RAPIDS users can access it at http://www.dmdc.osd.mil/smart card

11.3 DSC USER HELP DESK

11.3.1 DSC User Help Desk
Contact the DSC User Help Desk if you need assistance beyond what is available in RAPIDS Web resources and Online Help.

<table>
<thead>
<tr>
<th>If you are experiencing any of the following problems, contact the DSC:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Questions about RAPIDS</td>
</tr>
<tr>
<td>• Hardware failure</td>
</tr>
<tr>
<td>• Error messages</td>
</tr>
<tr>
<td>• Communications issues related to CACs (e.g., the CA server is unavailable)</td>
</tr>
<tr>
<td>• CA access errors</td>
</tr>
<tr>
<td>• ID card problems</td>
</tr>
<tr>
<td>• Training issues</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Contact information for each DSC location:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-800-372-7437 (CONUS)</td>
</tr>
<tr>
<td>DSN: 698-5000 (CONUS)</td>
</tr>
<tr>
<td>DSN: 312-698-5000 (OCONUS)</td>
</tr>
<tr>
<td>Hours: 24x7x365</td>
</tr>
</tbody>
</table>

11.3.2 DEERS Security Office (DSO)
Before calling the DSO, ensure you have all the documents needed to validate changes. If a record is not in DEERS, or if you have a policy question, call the appropriate SPO for assistance.
Contact the DSO if you are experiencing record problems or data discrepancies, such as:

- Multiple overlapping service records that do not allow the VO to save to DEERS
- Stepchildren who have been incorrectly added as a child

Contact information for the DSO:

1-800-361-2508
DSN 878-3522/3523
Fax 831-655-8317

11.4 Service Project Office (SPO)

Each uniformed service, its National Guard and Reserve components, and some DoD agencies have an assigned SPO. Please see Section 4 to learn more about the SPO’s roles, responsibilities, and resources.
12 APPENDICES
12.1 APPENDIX A: QUICK REFERENCE GUIDE

SITE ID: ________________________________

Primary Site Security Manager: ________________________________

Secondary Site Security Manager: ________________________________

For Help, Call:

1-800-372-7437 (CONUS)
DSN: 698-5000 (CONUS)
DSN: 312-698-5000 (OCONUS)
Hours: 24x7x365

Important DEERS/RAPIDS Websites:

Inventory Logistics Portal:
- The ILP is the Website for managing CAC cardstock.
- To access it, click Help, click Web Resources, and then click CAC Inventory Logistics.

DMDC Security Online: https://www.dmdc.osd.mil/appj/audit/index.jsp
- Security Online is a site for user and site administration
- To add a new Verifying Official (VO), do the following:
  - Click the Add New User link on the left-hand side of the home page
  - Input the new VO’s Social Security Number (SSN)
  - Ensure the user is assigned the following roles (place a check next to them):
    - VO
    - Issuing Officer
    - Local Registration Authority (LRA)
  - Refer the student to http://learning.dmdc.osd.mil/, and have him or her take the assigned RPD courses
  - Remember to update the site address in Security Online if your site changes address!

VOIS: https://www.dmdc.osd.mil/vois/owa/vois
- The Verifying Official’s Information System (VOIS) is the most comprehensive resource for RAPIDS users
- You can find archived Messages of the Day (MOTD), user guides, and policy information
- You can find forms, including the DEERS/RAPIDS Security Online Form for adding/updating/removing Site Security Managers (SSM)
- You can find Service Project Officer (SPO) contact numbers (important for the DEERS/RAPIDS Security Online Form, which must be sent through the project office)

NOTES
12.2 APPENDIX B: PRIVACY ACT STATEMENT

The public reporting burden for this collection of information is estimated to average 10 minutes per response, including the time for reviewing instructions, searching existing data sources, gathering and maintaining the data needed, and completing and reviewing the collection of information. Send comments regarding this burden estimate or any other aspect of this collection of information, including suggestions for reducing this burden, to Department of Defense, Washington Headquarters Services, Directorate for Information Operations and Reports (0704-0020), 1215 Jefferson Davis Highway, Suite 1204, Arlington, VA 22202-4302. Respondents should be aware that notwithstanding any other provision of law, no person shall be subject to any penalty for failing to comply with a collection of information if it does not display a currently valid OMB control number.

PLEASE DO NOT RETURN YOUR COMPLETED FORM TO THIS ADDRESS.
RETURN COMPLETED FORM TO THE UNIFORMED SERVICE ID CARD ISSUING FACILITY.

SECTION VII - PRIVACY ACT STATEMENT

AUTHORITY: 10 U.S.C. sections 1061 - 1065, 1072, 1074, 1074a - 1074c, 1076, 1077, 1095A(2), EO 9397.
PRINCIPAL PURPOSE(S): To apply for the Uniformed Services Identification card and/or DEERS Enrollment.
ROUTINE USE(S): To appropriate business entities, individual providers of care, and others, on matters relating to claims adjudication, program abuse, utilization review, professional quality assurance, medical peer review, program integrity, third party liability, coordination of benefits, and civil and criminal litigation.

To the Department of Health and Human Services, the Department of Veterans Affairs, the Social Security Administration, and other Federal, state, and local government agencies to identify individuals having benefit eligibility in another plan or program. Applicant information is subject to computer matching within the Department of Defense or with any other Federal or non-Federal agencies. Matching programs are conducted to assure that an individual eligible under a Federal program is not improperly receiving duplicate benefits from another program. A beneficiary or former beneficiary who has applied for privileges of a Federal Benefit Program and has received government assistance under another plan will be subject to adjustment or recovery of any improper payments made or delinquent debts owed.

DISCLOSURE: Voluntary, however, failure to provide information may result in denial of a Uniformed Services Identification Card and/or non-enrollment in the Defense Enrollment Eligibility Reporting System. Failure to provide a beneficiary's Social Security Number renders that beneficiary ineligible for health care services in Military Treatment Facilities. However, emergency health care services will be provided to the extent authorized members of the general public.

SECTION VIII - CONDITIONS APPLICABLE TO SPONSOR OR APPLICANT

I understand the actions of the recipient(s) of "Uniformed Services Identification Card" issued as a result of this application are my responsibility insofar as proper use of the card for benefits and privileges authorized, i.e., medical and dental care, exchange, commissary, and morale, welfare, and recreation programs. I will cause the recipient to surrender the card immediately upon call to do so or when appropriate under applicable regulations, and will notify an agency designated to grant authorization for privileges and facilities in event of any change in status affecting a recipient's eligibility therefor.

I am aware that medical care furnished in uniformed services facilities is subject to availability of space, facilities, and the capabilities of the medical staff to provide such care. Determinations made by the medical officer or contract surgeon, or his/her designee, as to availability of space, facilities, and the capabilities of the medical staff shall be conclusive.

Reimbursement shall be required for any unauthorized medical care furnished at government expense. Copies of regulations concerning eligibility requirements are available in the Service Personnel Offices.

By signing this document, the sponsor or applicant certifies that he/she is aware that eligibility for benefits under the Civilian Health and Medical Program of the Uniformed Services (CHAMPUS) terminates for all beneficiaries, except spouses and children of active duty members, and certain disabled beneficiaries under 65, when the beneficiary becomes eligible for Medicare Part A, Hospital Insurance, through the Social Security Administration.

PENALTY FOR PRESENTING FALSE CLAIMS OR MAKING FALSE STATEMENTS IN CONNECTION WITH CLAIMS: FINE OF UP TO $10,000 OR IMPRISONMENT FOR UP TO FIVE YEARS OR BOTH.

(Act June 25, 1948, 18 U.S. Code 287, 1001)
Privacy Act Data Cover Sheet

To be used on all documents containing personal information.

DOCUMENTS ENCLOSED ARE SUBJECT TO THE PRIVACY ACT OF 1974

Contents shall not be disclosed, discussed, or shared with individuals unless they have a direct need-to-know in the performance of their official duties. Deliver this/these document(s) directly to the intended recipient. DO NOT drop off with a third-party.

The enclosed document(s) may contain personal or privileged information and should be treated as “For Official Use Only.” Unauthorized disclosure of this information may result in CIVIL and CRIMINAL penalties. If you are not the intended recipient or believe that you have received this document(s) in error, do not copy, disseminate or otherwise use the information and contact the owner/creator or your Privacy Act officer regarding the document(s). (DoD Directive 5400.11, “Department of Defense Privacy Program,” November 16, 2004.)

Privacy Act Data Cover Sheet

DD FORM 2923, DEC 2006
12.4 **APPENDIX D: ACCEPTABLE PROOF OF IDENTITY DOCUMENTATION**

Documents that properly establish identity fall into two groups: Primary proof of identity and secondary proof of identity. Primary documents include valid state or federal government-issued picture identification (ID). One primary document must be captured. After a primary proof of identity is chosen, a second document must be presented from either the primary or secondary group, as long as it is different from the one initially captured.

<table>
<thead>
<tr>
<th>Group A</th>
<th>Group B</th>
</tr>
</thead>
<tbody>
<tr>
<td>U.S. Military card</td>
<td>Certificate of U.S. Citizenship (INS Form N-560 or N-561)</td>
</tr>
<tr>
<td>Military Family Member’s ID card</td>
<td>Certificate of Naturalization (INS Form N-550 or N-570)</td>
</tr>
<tr>
<td>Driver’s license or ID card issued by a state or outlying possession of the United States,</td>
<td>Foreign Passport</td>
</tr>
<tr>
<td>provided it contains a photograph</td>
<td></td>
</tr>
<tr>
<td>ID card issued by federal, state, or local government agencies or entities, provided it</td>
<td>Unexpired Reentry Permits (INS Form I-327)</td>
</tr>
<tr>
<td>contains a photograph</td>
<td></td>
</tr>
<tr>
<td>U.S. Passport</td>
<td>Unexpired Refugee Travel Document (INS Form I-571)</td>
</tr>
<tr>
<td>USCG Merchant Mariner Card</td>
<td>School ID with a photograph</td>
</tr>
<tr>
<td>Permanent Resident Card or Alien Registration Receipt Card with photograph (INS Form I-151 or I-551)</td>
<td>Voter’s registration card</td>
</tr>
<tr>
<td>Unexpired Temporary Resident Card (INS Form I-688)</td>
<td>Native American tribal document</td>
</tr>
<tr>
<td>Unexpired Employment Authorization Card (INS Form I-688A)</td>
<td>Driver’s license issued by a Canadian government authority</td>
</tr>
<tr>
<td>Unexpired Employment Authorization Document issued by the INS that contains a photograph</td>
<td>U.S. Social Security identification card issued by the Social Security Administration</td>
</tr>
<tr>
<td>(INS Form I-688B)</td>
<td></td>
</tr>
<tr>
<td>Certification of Birth Abroad issued by the Department of State (Form FS-545 or Form DS-1350)</td>
<td></td>
</tr>
<tr>
<td>Original or certified copy of a birth certificate issued by a state, county, municipal</td>
<td>U.S. Citizen ID Card (INS Form I-197)</td>
</tr>
<tr>
<td>authority or outlying possession of the United States bearing an official seal</td>
<td></td>
</tr>
<tr>
<td>ID Card for use of Resident Citizen in the United States (INS Form I-179)</td>
<td></td>
</tr>
<tr>
<td>Unexpired employment authorization document issued by the Immigration and Naturalization</td>
<td></td>
</tr>
<tr>
<td>Service (INS)</td>
<td></td>
</tr>
<tr>
<td>For persons under the age of 18 who are unable to present a document listed above:</td>
<td></td>
</tr>
<tr>
<td>School record or report card</td>
<td></td>
</tr>
<tr>
<td>Clinic, doctor, or hospital record</td>
<td></td>
</tr>
<tr>
<td>Day-care or nursery school record</td>
<td></td>
</tr>
</tbody>
</table>
12.5 **APPENDIX E: ID CARD ERROR CODES**

**Category 1: Customer Returns**—Describes those CACs being returned for routine reasons and not because of a CAC defect or failure.

- **A1** Data has changed
- **A2a1** Data cannot be written to magnetic stripe
- **A2a2** Data cannot be read from the magnetic stripe
- **A2b** The PDF417 barcode cannot be read
- **A2c** The Code 39 barcode cannot be read
- **A2d1** Data cannot be written to the Integrated Circuit Chip (ICC)
- **A2d2** Data cannot be read from the ICC
- **A2e** Photograph is damaged
- **A2f** Printed data is no longer legible
- **A2g** Laminate is separating from card body
- **A3** Abuse
- **A4** Lost card turned in by third party
- **A5** Expired or about to expire
- **A6** Invalid issuance
- **A7** Requested replacement

**Category 2: Issuance Failure Discovered after Printing**—Relates to printer, cardstock quality, or SSM/VO actions.

- **B1** Discoloration
- **B2** Poor PDF417 barcode print quality
- **B3** Poor Code 39 barcode print quality
- **B4** Lamination did not adhere properly
- **B5** Lamination not centered on card surface
- **B6** Printer jammed
- **B10** System detected a printer error while initializing the print job
- **B11** System detected a printer error while printing front side of card
- **B12** System detected a printer error while printing back side of card
- **B13** System determined that the print quality of the card surface is inadequate

- **C1** Blotches, pitting, etc.
- **C2** Scratches
- **C3** Dirt, debris
- **C4** The ICC is visibly damaged

- **D1** Card fed into printer improperly
- **D2** Incorrect data used to create card
- **D3** Unacceptable photograph
- **D4** Card was not encoded with the requested data
- **D5** Incorrect data was requested for encoding on the card
- **D6** Encoding incomplete and does not meet issuance requirements

**Category 3: Issuance Failure Discovered When Reading Barcode**—Relates to production of an unreadable barcode.

- **E1** Unable to initialize PDF 417 barcode scanner
- **E2** Unable to initialize Code 39 barcode scanner
- **E3** Scanner failed to recognize PDF 417 barcode
- **E4** Scanner failed to recognize Code 39 barcode
- **E5** Unable to decipher PDF 417 barcode
- **E6** Unable to decipher Code 39 barcode
E7   PDF 417 barcode data does not match print request
E8   Code 39 barcode data does not match print request

**Category 4: Issuance Failure During Encoding**—Can occur during the encoding of the CAC.

G1    Unable to connect to ICC
G2    Unable to read chip ID from ICC
G3    Unable to get valid chip ID
G4    Unable to connect to User Portal
G5    Unable to possess card
G6    Unable to install DoD core applets
G7    Unable to install Joint Data Model (JDM) applet
G8    Failed to remove partially installed DoD core applets when retrying applet installation
G9    Failed to remove partially installed JDM applet when retrying applet installation
G10   Unable to set PIN. Random PIN could not be written to the card
G11   Unable to set PIN. Custom PIN could not be written to the card
G12   Unable to log on to the card with the recipient’s PIN
G13   Unable to populate person applet
G14   Unable to populate personnel applet
G15   Unable to populate benefits applet
G16   Unable to populate other benefits applet
G17   Unable to obtain ID certificate from Certificate Authority (CA)
G18   Unable to obtain e-mail signing certificate from CA
G19   Unable to obtain e-mail encryption certificate from CA
G20   Unable to read PKI certificates encoded on CAC
G21   ID certificate cannot be found on the encoded CAC
G22   E-mail signing certificate cannot be found on the encoded CAC
G23   E-mail encryption certificate cannot be found on the encoded CAC
G24   The distinguished name on the ID certificate does not match the requested distinguished name
G25   The distinguished name on the e-mail signing certificate does not match the requested distinguished name
G26   The distinguished name on the e-mail encryption certificate does not match the requested distinguished name
G27   The begin date on the ID certificate does not match the requested begin date
G28   The begin date on the e-mail signing certificate does not match the requested begin date
G29   The begin date on the e-mail encryption certificate does not match the requested begin date
G30   The e-mail address on the e-mail signing certificate does not match the recipient's address
G31   The e-mail address on the e-mail encryption certificate does not match the recipient's address
G32   Unable to get card profile from User Portal
G33   Card was removed during encoding

M1    Unable to submit request to the UP due to missing data
M2    Unable to submit request to the UP due to missing chip ID
M3    The CAC status in the ILP is not appropriate for the requested action
M4    Unable to delete pending requests on the UP
M5    Invalid wallet manager
M6    User not authorized to submit the request to the UP
M7    The session to the UP is invalid
M8    Unable to submit the actions to the UP
M9    The actions submitted to the UP were rejected
M10   The requested action is invalid
M11   No e-mail address given for the e-mail certificate request

**Category 5: Saving Card Issuance Data to DEERS and ILP**—This category relates to the inability to correlate the site ID or card status with the ILP.
H1 Unable to save card to DEERS or off-line storage
H2 Software malfunction
H3 Card saved to off-line storage
H4 Unable to audit card issuance
H5 Unable to save photograph captured during card issuance to DEERS or off-line storage
H6 Photograph captured during card issuance saved to off-line storage
H7 Unable to save fingerprint captured during card issuance to DEERS or off-line storage
H8 Fingerprint captured during card issuance saved to off-line storage
H9 Unable to get card status from ILP
H10 ILP reports that the card is terminated
H11 Unable to set card status on ILP
H12 Unable to save card to central server
H13 Unable to connect to ILP
H14 CAC cannot be found on the ILP
H15 CAC associated with specified site ID not found on ILP
H16 Specified site ID does not exist on the ILP
H17 This card is not available for encoding at your site. Ensure the site SSM has received, accepted, and opened the card order associated with this CAC in the ILP
H18 Site associated with card in ILP does not match card issuing site

Category 6: System Failure/Testing—This category is reserved for internal testing.

J1 Used by installer for testing purposes
J2 Used by technician for troubleshooting purposes

Category 7: Customer Returns—Describes those CACs being returned because of a damaged magnetic strip.

K1 The magnetic strip is visibly damaged

Category 8: CIF Issuance Failures—Relates to only Central Issuance Facility (CIF) sites.

L1 Error occurred at CIF
L2 CAC mailer package was lost
L3 PIN mailer package was lost

Category 9: PIV Specific

N1 Verification of CHUID on PIV CAC failed
N2 Verification of primary fingerprint on PIV CAC failed
N3 Verification of secondary fingerprint on PIV CAC failed
N4 Verification of photo on PIV CAC failed
N5 Verification of security object on PIV CAC failed
N6 PIV object construction failure
N7 Unable to encode a PIV-CAC on non-PIV compliant workstation or a non PIV-CAC on a PIV-compliant workstation

W Not applicable. Card not returned
### 12.6 APPENDIX F: RAPIDS TRANSACTION AUDIT TRAIL EVENTS AND DESCRIPTIONS

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Recorded when a user attempts to access the system</td>
<td></td>
</tr>
<tr>
<td>Logout</td>
<td>Captures information about user logging out of the system</td>
<td></td>
</tr>
<tr>
<td>Pull Family</td>
<td>Begins a new transaction package. This important event is recorded at all times, regardless of a system failure</td>
<td></td>
</tr>
<tr>
<td>Push Family</td>
<td>Is equivalent to saving a family to DEERS. Any changes to a family, such as adds, updates, terminations, are captured below events</td>
<td></td>
</tr>
</tbody>
</table>

Add/Update/Terminate/Decease/Lock/Override/Bypass Events capture the data changes in the area listed below. These events update the database when **Push Family** occurs.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Data</td>
<td>Captures information about person add, decease, lock, and update</td>
<td>Add, Update, Decease, Lock</td>
</tr>
<tr>
<td>Mailing Address Data</td>
<td>Captures person address information</td>
<td>Add, Update</td>
</tr>
<tr>
<td>Country Location Data</td>
<td>Captures person location information based on PN, PNL, PNLEC changes</td>
<td>Add, Update</td>
</tr>
<tr>
<td>Contact Information Data</td>
<td>Captures telephone number changes for both Sponsor and family members</td>
<td>Add, Update</td>
</tr>
<tr>
<td>Medicare Data</td>
<td>Captures Medicare data captures beneficiary Medicare information</td>
<td></td>
</tr>
<tr>
<td>Person Entitlement Condition Data</td>
<td>Captures information about PNEC changes for family members</td>
<td>Add, Update, Terminate</td>
</tr>
<tr>
<td>Personnel Entitlement Condition Data</td>
<td>Captures information about PNEC changes made to the Sponsor only</td>
<td>Add, Update, Terminate</td>
</tr>
<tr>
<td>Personnel Data</td>
<td>Captures Sponsor’s personnel category changes</td>
<td>Add, Update, Terminate</td>
</tr>
<tr>
<td>Personnel Status Data</td>
<td>Captures information about Sponsor’s personnel status updates</td>
<td>Add, Update</td>
</tr>
<tr>
<td>Personnel E-mail Address</td>
<td>Captures Sponsor’s e-mail address changes</td>
<td>Add, Update, Terminate</td>
</tr>
<tr>
<td>Pay Grade Data</td>
<td>Captures Sponsor's pay grade changes</td>
<td>Add, Update</td>
</tr>
<tr>
<td>Reserve Data</td>
<td>Captures information about Sponsor’s reserve component category (RCC)</td>
<td>Add, Update</td>
</tr>
<tr>
<td>Unit Identification Code (UIC) Data</td>
<td>Captures information about a Sponsor’s attached and assigned unit identifiers</td>
<td>Add, Update</td>
</tr>
<tr>
<td>Association Data</td>
<td>Captures information about Sponsor/family member relationships based on the type of association modified</td>
<td>Add, Update, Terminate</td>
</tr>
<tr>
<td>Person Association Entitlement Condition Data</td>
<td>Captures information updates on Sponsor’s association entitlement</td>
<td>Add, Update, Terminate</td>
</tr>
<tr>
<td></td>
<td>Conditions</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Other Health Insurance Data</td>
<td>Captures information updates on Sponsor’s other health insurance</td>
<td>Add, Update</td>
</tr>
<tr>
<td>Bio Print Data</td>
<td>Captures fingerprint updates for family</td>
<td>Add, Update, Override, Bypass</td>
</tr>
<tr>
<td>Bio Photo Data</td>
<td>Captures photo updates for family</td>
<td>Add, Update</td>
</tr>
</tbody>
</table>

**ID Card Events:** Please see “ID Card Event Details” worksheet for detailed data elements captured for ID card.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Create ID Card</td>
<td>Generates create ID card data when a user attempts to create an ID card</td>
</tr>
<tr>
<td>Start Print</td>
<td></td>
</tr>
<tr>
<td>Printed Correctly</td>
<td></td>
</tr>
<tr>
<td>Encode Request</td>
<td></td>
</tr>
<tr>
<td>Save ID Card</td>
<td></td>
</tr>
<tr>
<td>Update CAC</td>
<td></td>
</tr>
<tr>
<td>Unlock CAC</td>
<td></td>
</tr>
<tr>
<td>Reset PIN</td>
<td></td>
</tr>
<tr>
<td>Terminate Previously Issued ID Card</td>
<td>Captures information when previously issued cards are terminated during a family push</td>
</tr>
<tr>
<td>Cancel Card</td>
<td>Captures card cancel actions</td>
</tr>
</tbody>
</table>

**Certificate Events**

| Certificate (PKIC) | Captures information about issued certificates |

**Fingerprint Bypass Data**

| Skip Capture | Captures data on fingerprint skip capture |
| Skip Verification | Verifies data on fingerprint verification bypass |
### 12.7 Appendix G: RAPIDS User Guide Acronyms

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADF</td>
<td>Automatic Document Feeder</td>
</tr>
<tr>
<td>AFI</td>
<td>Air Force Initiative</td>
</tr>
<tr>
<td>CA</td>
<td>Certificate Authority</td>
</tr>
<tr>
<td>CAC</td>
<td>Common Access Card</td>
</tr>
<tr>
<td>CACCIRS</td>
<td>Common Access Card Central Issuance Requesting Station</td>
</tr>
<tr>
<td>CDC</td>
<td>Child Development Center</td>
</tr>
<tr>
<td>CGES</td>
<td>United States Coast Guard Exchange Services</td>
</tr>
<tr>
<td>CHAMPUS</td>
<td>Civilian Health and Medical Program of the Uniformed Services</td>
</tr>
<tr>
<td>CHUID</td>
<td>Cardholder Unique Identification</td>
</tr>
<tr>
<td>CIF</td>
<td>Central Issuance Facility</td>
</tr>
<tr>
<td>CIN</td>
<td>Civilian Identification Number</td>
</tr>
<tr>
<td>CONUS</td>
<td>Continental United States</td>
</tr>
<tr>
<td>CRL</td>
<td>Certification Revocation List</td>
</tr>
<tr>
<td>CVS</td>
<td>Contractor Verification System</td>
</tr>
<tr>
<td>DAV</td>
<td>Disabled American Veteran</td>
</tr>
<tr>
<td>DD Form</td>
<td>Department of Defense Form</td>
</tr>
<tr>
<td>DEERS</td>
<td>Defense Enrollment Eligibility Reporting System</td>
</tr>
<tr>
<td>DFAS</td>
<td>Defense Finance and Accounting Service</td>
</tr>
<tr>
<td>DHHS</td>
<td>Department of Health and Human Services</td>
</tr>
<tr>
<td>DHS</td>
<td>Department of Homeland Security</td>
</tr>
<tr>
<td>DII</td>
<td>Defense Information Infrastructure</td>
</tr>
<tr>
<td>DISN</td>
<td>Defense Information Systems Network</td>
</tr>
<tr>
<td>DMDC</td>
<td>Defense Manpower Data Center</td>
</tr>
<tr>
<td>DoC</td>
<td>Department of Commerce</td>
</tr>
<tr>
<td>DoD</td>
<td>Department of Defense</td>
</tr>
<tr>
<td>DoDD</td>
<td>Department of Defense Directive</td>
</tr>
<tr>
<td>DSC</td>
<td>Defense Manpower Data Center Support Center</td>
</tr>
<tr>
<td>DSN</td>
<td>Defense System Network</td>
</tr>
<tr>
<td>DSO</td>
<td>Defense Manpower Data Center Support Office</td>
</tr>
<tr>
<td>EDI</td>
<td>Electronic Data Interchange</td>
</tr>
<tr>
<td>EDIPI</td>
<td>Electronic Data Interchange Person Identifier</td>
</tr>
<tr>
<td>FASC-N</td>
<td>Federal Agency Smart Card Credential Number</td>
</tr>
<tr>
<td>FBI</td>
<td>Federal Bureau of Investigation</td>
</tr>
<tr>
<td>FIN</td>
<td>Foreign Identification Number</td>
</tr>
<tr>
<td>FIPS</td>
<td>Federal Information Processing Standard</td>
</tr>
<tr>
<td>FMSGLI</td>
<td>Family Member Service Members’ Group Life Insurance</td>
</tr>
<tr>
<td>FSR</td>
<td>Field Service Representative</td>
</tr>
<tr>
<td>ft</td>
<td>Foot</td>
</tr>
<tr>
<td>FY</td>
<td>Fiscal Year</td>
</tr>
<tr>
<td>GC</td>
<td>Geneva Conventions</td>
</tr>
<tr>
<td>HICN</td>
<td>Health Insurance Claim Number</td>
</tr>
<tr>
<td>HSPD</td>
<td>Homeland Security Presidential Directive</td>
</tr>
<tr>
<td>IAD</td>
<td>Initial Active Duty</td>
</tr>
<tr>
<td>IAVA</td>
<td>Information Assurance Vulnerability Alert</td>
</tr>
<tr>
<td>ICC</td>
<td>Integrated Circuit Chip</td>
</tr>
<tr>
<td>Acronym</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>IE</td>
<td>Internet Explorer</td>
</tr>
<tr>
<td>ILP</td>
<td>Inventory Logistics Portal</td>
</tr>
<tr>
<td>INDEF</td>
<td>Indefinite</td>
</tr>
<tr>
<td>INS</td>
<td>Immigration and Naturalization Service</td>
</tr>
<tr>
<td>IO</td>
<td>Issuing Official</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol/User Portal</td>
</tr>
<tr>
<td>IPA</td>
<td>Intergovernmental Personnel Act</td>
</tr>
<tr>
<td>IRR</td>
<td>Inactive Ready Reserve</td>
</tr>
<tr>
<td>IRS</td>
<td>Internal Revenue Service</td>
</tr>
<tr>
<td>ITIN</td>
<td>Individual Taxpayer Identification Number</td>
</tr>
<tr>
<td>JDM</td>
<td>Joint Data Model</td>
</tr>
<tr>
<td>JSM</td>
<td>Joint Service Marriage</td>
</tr>
<tr>
<td>JUSPAC</td>
<td>Joint Uniformed Services Personnel Advisory Committee</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LRA</td>
<td>Local Registration Authority</td>
</tr>
<tr>
<td>MIA</td>
<td>Missing in Action</td>
</tr>
<tr>
<td>MOA</td>
<td>Memorandum of Agreement</td>
</tr>
<tr>
<td>MOTD</td>
<td>Message of the Day</td>
</tr>
<tr>
<td>MOU</td>
<td>Memorandum of Understanding</td>
</tr>
<tr>
<td>MS</td>
<td>Microsoft</td>
</tr>
<tr>
<td>MSC</td>
<td>Military Sealift Command</td>
</tr>
<tr>
<td>MTF</td>
<td>Medical Treatment Facility</td>
</tr>
<tr>
<td>MWR</td>
<td>Morale, Welfare, and Recreation</td>
</tr>
<tr>
<td>NACI</td>
<td>National Agency Check With Written Inquiries</td>
</tr>
<tr>
<td>NAF</td>
<td>Non-Appropriated Fund</td>
</tr>
<tr>
<td>NATO</td>
<td>North Atlantic Treaty Organization</td>
</tr>
<tr>
<td>NG-CAC</td>
<td>Next-Generation Common Access Card</td>
</tr>
<tr>
<td>NII</td>
<td>National Information Infrastructure</td>
</tr>
<tr>
<td>NIPRNET</td>
<td>Non-Secure Internet Protocol Router Network</td>
</tr>
<tr>
<td>NIST</td>
<td>National Institute of Standards and Technology</td>
</tr>
<tr>
<td>NOAA</td>
<td>National Oceanic and Atmospheric Administration</td>
</tr>
<tr>
<td>NSA</td>
<td>National Security Agency</td>
</tr>
<tr>
<td>OCONUS</td>
<td>Outside the Continental United States</td>
</tr>
<tr>
<td>OMB</td>
<td>Office of Management and Budget</td>
</tr>
<tr>
<td>OPM</td>
<td>Office of Personnel Management</td>
</tr>
<tr>
<td>OSD</td>
<td>Office of the Secretary of Defense</td>
</tr>
<tr>
<td>OUSD/P&amp;R</td>
<td>Office of the Under Secretary of Defense for Personnel and Readiness</td>
</tr>
<tr>
<td>OUSD/RA</td>
<td>Office of the Under Secretary of Defense for Reserve Affairs</td>
</tr>
<tr>
<td>PDRL</td>
<td>Permanently Disabled Retired List</td>
</tr>
<tr>
<td>PIC</td>
<td>Person in Charge</td>
</tr>
<tr>
<td>PIN</td>
<td>Personal Identification Number</td>
</tr>
<tr>
<td>PIP</td>
<td>Personnel Identity Protection</td>
</tr>
<tr>
<td>PIPS</td>
<td>Personnel Identity Protection Solutions</td>
</tr>
<tr>
<td>PIV</td>
<td>Personal Identity Verification</td>
</tr>
<tr>
<td>PKI</td>
<td>Public Key Infrastructure</td>
</tr>
</tbody>
</table>
PO Project Officer
P.O. Post Office
POC Point of Contact
POW Prisoner of War
R&A Research and Analysis
RA Registration Authority
RAPIDS Real-Time Automated Personnel Identification System
RCC Reserve Component Category
RESRET Guard/Reserve Retired
ROTC Reserve Officer Training Corps
SES Senior Executive Service
SGLI Service Members’ Group Life Insurance
SIPRNET Secret Internet Protocol Router Network
SOP Standard Operating Procedure
SP Special Publication
SPD Separation Program Designator
SPO Service Project Officer
SSL Secure Sockets Layer
SSM Site Security Manager
SSN Social Security Number
SSOP Standard Security Operating Procedures
SVO Super Verifying Official
TA Transitional Assistance
TA-180 Selective Reserves Transitional Assistance
TAMP Transitional Assistance and Management Personnel
TDRL Temporary Disabled Retired List
TIN Temporary Identification Number
UIC Unit Identification Code
URFS Unremarried Former Spouse
URL Uniform Resource Locator
URW Unremarried Widow
U.S. United States
USA United States Army
USAF United States Air Force
USAFR United States Air Force Reserve
USANG United States Air National Guard
USAR United States Army Reserve
USARNG United States Army National Guard
USB Universal Serial Bus
USCG United States Coast Guard
USCGR United States Coast Guard Reserve
USMC United States Marine Corps
USMCR United States Marine Corps Reserve
USN United States Navy
USNR United States Navy Reserve
<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USPHS</td>
<td>United States Public Health Service</td>
</tr>
<tr>
<td>V</td>
<td>Volt</td>
</tr>
<tr>
<td>VO</td>
<td>Verifying Official</td>
</tr>
<tr>
<td>VOIS</td>
<td>Verifying Official’s Information System</td>
</tr>
<tr>
<td>VPN</td>
<td>Virtual Private Network</td>
</tr>
<tr>
<td>VSI</td>
<td>Voluntary Separation Incentive</td>
</tr>
<tr>
<td>WAN</td>
<td>Wide Area Network</td>
</tr>
<tr>
<td>www</td>
<td>World Wide Web</td>
</tr>
<tr>
<td>X.509</td>
<td>PKI Standard for Certificate Management</td>
</tr>
</tbody>
</table>
12.8  APPENDIX H: CARD CHARTS

Current CAC Card Chart

**GENEVA CONVENTIONS IDENTIFICATION CARD**

- **ID RECIPIENTS:** Active Duty Armed Forces, Selected Reserves, National Guard, National Oceanic and Atmospheric Administration (NOAA), U.S. Public Health Services, U.S. Coast Guard
- **ID STATUS:** Prior to Feb. 2005 (Active Duty, Reserve National Guard). After Feb. 2005, will display branch of Service (Army, Air Force, etc.)

**GENEVA CONVENTIONS ACCOMPANYING FORCES CARD**

- **ID RECIPIENTS:** Emerging essential civilian employees, contingency contractor employees, deployed overseas civilian non-combatant personnel
- **ID STATUS:** Civilians, contractors, non-DOD other government employees, civilian affiliates, Federal affiliates, Senior Executive Service (SES)

**IDENTIFICATION AND PRIVILEGE CARD**

- **ID RECIPIENTS:** DoD civilians and eligible contractors residing in OCONUS locations to include HI, AK, Puerto Rico or Guam for 365 days or more; Presidential Appointees, eligible foreign military personnel
- **ID STATUS:** Executives, civilians, contractors, civilian affiliates, Federal affiliates, Military affiliates
Next Generation CAC Card Chart

IDENTIFICATION CARD
ID RECIPENTS: DoD civilian employees, eligible contractor employees; non-DoD/other government employees and state employees of National Guard; requiring logical access, members of the Intergovernmental Personnel Act

ID: STATUS: Senior Executive Service (SES), civilians, civilian affiliates, Federal affiliates, Military affiliates

COLOR CODING
CURRENT
RED BAND: NON-U.S. CITIZENS
GREEN BAND: CONTRACTORS
WHITE: ALL REMAINING PERSONNEL

NEXT-GENERATION
BLUE BAND: NON-U.S. CITIZENS
GREEN BAND: CONTRACTORS
RED BAND: FIRST RESPONDERS
WHITE: ALL REMAINING PERSONNEL
Teslin Card Chart

DD FORM 2 (RESERVE RETIRED)
ARME_DSP FORCES OF THE UNITED STATES
GENEVA CONVENTIONS IDENTIFICATION CARD
RECIPIENTS: Retired members of the Reserve under the age of 60.

DD FORM 2 (INDIVIDUAL READY RESERVE)
ARME_DSP FORCES OF THE UNITED STATES
GENEVA CONVENTIONS IDENTIFICATION CARD
RECIPIENTS: Members of the Individual Ready Reserve and those on Brief inactive National Guard.

DD FORM 2 (RETIRED)
U.S. UNIFORMED SERVICES GENEVA CONVENTIONS IDENTIFICATION CARD
RECIPIENTS: Members entitled to retired pay; members on the Temporary Disability Retired List (TDRL); members on the Permanent Disability Retired List (PDR List).

DD FORM 1173
UNIFORMED SERVICES IDENTIFICATION AND PRIVILEGE CARD
RECIPIENTS: Active duty members, dependent spouses, children under 21, dependents of active duty service members, dependents of Reserve officers, dependents of retired officers, dependents of Reserve and National Guard members, and dependents of retired Reserve and National Guard members.

DD FORM 1173-1
DEPARTMENT OF DEFENSE GUARD AND RESERVE FAMILY MEMBER IDENTIFICATION AND PRIVILEGE CARD
RECIPIENTS: Dependents of military members including spouses, dependents, former spouses, other eligible dependents, non-DoD other government employees, dependents of Guard Reserve/RESERVE, dependents of former members, dependents of Reserve members, dependents of retired Reserve members, and dependents of retired Reserve members.

DD FORM 2765
DEPARTMENT OF DEFENSE UNIFORMED SERVICES IDENTIFICATION PRIVILEGE CARD
RECIPIENTS: DOD personnel, DoD military members, DoD dependents, Medal of Honor recipients, non-government personnel, civilian employee, National Oceanic and Atmospheric Administration (NOAA) civilian employees, officers, and government civilian personnel of the Federal government who are not government military personnel.